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A New Look

In Word 2010, there have been some features that are new or have been re-added and some features
that have been removed from past versions of Word. The biggest visual change has been the
replacement of the Office 2003 Command Line (File Edit View Insert...) for The Ribbon. The Office

Button in Office 2007 has gone away and replaced by the File Tab. These features will be described in
the following pages.
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The W Button

This button was removed in Office 2007 and makes its return in 2010. This button is convenient in that
you can Minimize, Maximize or Close Word without having to traverse your mouse across the entire
screen to the right corner to perform these same actions. With our monitors getting larger, this is a nice
feature.
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The Minimize Ribbon Button

While reading over a document, it may be convenient at times to minimize the Ribbon. To minimize, just

click on the ‘up arrow’ symbol. \
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To maximize the Ribbon, click on the ‘down arrow’ symbol.
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The File Tab

The File tab is basically the same look as the File command for Office 2003 users. You will still see the
same commands such as, Save, Save As, New, Print, etc. For Office 2007 users, the Office Button has
gone away and has been replaced by the File tab. Here, you will still find the basic file commands. The
screen below is the default with Info being highlighted in the left column and the right side giving you
more information about your document like file size, number of words and pages.
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The Quick Access Toolbar

The Quick Access Toolbar is located in the upper left corner and is intended to store the buttons you will
use most often.

(W90 &

By default, the Quick Access Toolbar shows the Save, Undo, and Redo buttons, however if you click on
the drop down arrow just to the right, you can customize it to fit your needs. In the example below, |
have added the Quick Print button. The Save icon (which appears as a floppy diskette symbol) is
convenient to click on when wanting to save your work instead of clicking on the Save icon from the File

tab.
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The Ribbon

The Ribbon is designed to replace the menus and toolbars of Office 2003. The goal of the Ribbon is to
keep commands visually up front so that they are easy to access as you work.
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The Ribbon is divided into what are called Groups (Clipboard, Font, Paragraph and Styles, etc.). Each
Group has a triangular icon in the lower right hand corner. Clicking this will bring up an additional menu
window. For example, clicking the triangle in the Font group brings up the classic Font options window.
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The Help Button
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There is so much that Word can do in the latest version that it’s hard to know everything. If you want
information on a topic, click on the ‘?’ symbol in the upper right hand corner and the Help window will
appear like below. You will see common topics to click on or you can type in a word or question in the
search field to find further information.
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Create a Document

Getting started with a basic document in Microsoft Word 2010 is as easy as opening Word and
beginning to type. Or, if you want to create an additional document besides the one you already have
opened, click on the File tab, click on New in the left column, then double click on Blank document and
a new document window will appear.
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You can also start a document from a template from the New view as well. There are many to download
and choose from if you are on the Internet from Office.com like Letters, Flyers and Forms. If there is no
Internet connection, you may choose from the Sample templates under Available Templates.



Spelling and Grammar Mistakes

As you type, Word will warn you if make spelling or grammar mistakes by inserting a wavy red, green, or
blue underline beneath the text that it thinks is an error. Red underline: This indicates either a possible
spelling error or that Word doesn’t recognize a word, such as a proper name or place. Green underline:
Word thinks that grammar should be revised. Blue underline: A word is spelled correctly but does not
seem to be the correct word for the sentence. For example, you type “too,” but the word should be
“to.”

You right click an underlined word to see the suggested revisions. Click a revision to replace the word in
the document and get rid of the underlines.
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We have launched a internacional advertising campaign and plan

to do seasonal promotions throughout them rest of the year.

A note of caution about green and blue underlines: Word is really good at spelling, which is pretty
straightforward most of the time. But grammar and correct word usage take some judgment.

If you think that you are right, and Word is wrong, then you can right-click the word and ignore the
suggested revisions and get rid of the underlines.
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Paragraph and Text Formatting

Word 2010 assumes some defaults when you start a new document. For instance, there is no
indentation on paragraphs and the line or sentence spacing is set by the default Style called Normal.
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Text alignment is also available on the Paragraph group. The default is Align Text Left which is
highlighted. The other options are Center, Align Text Right and Justify which is a clean look with text

aligned on both margins. / /
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Text can easily be color highlighted or colored. Highlight the text first with your cursor then click on the
Font Color button and the text will change to the default of red. To change the font color, click on the
down arrow for the color palette and choose your color. To color highlight your text, highlight the text
with your cursor, click on the Text Highlight Color button and it changes to the default of yellow. To
change the highlight color, click on the down arrow for the color palette and choose your color.
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Four score and seven years ago our fathers brought forth on this continent,

a new nation, conceived in Liberty...
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Open an Existing File

To open an existing file you’ve created, click on the File tab, click the Open button and the familiar Open
dialog box appears as seen in the next screen shot below.
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Click on the file you want, then click Open at the bottom right.
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Saving Files Part I

While editing an existing file, it's a good habit to often save your work. There are two different ways to
save files. Click the File tab, then just click the Save button. The faster option as described earlier, is to

click the Save button in the Quick Access Toolbar.

Related People
Author

Last Maodified By

Show All Properties
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Saving Files Part I1

When editing an existing document, you may want to save the file under a different name. Click on the
File tab, click the Save As button and the Save As dialog box opens as seen below. In the File name field,
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type in the new name without changing the .docx extension. Click the Save button.
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File Tab with Recent Option

The Recent option on the File tab allows you to quickly go to your other documents and open them. If
you accidently deleted a document or closed Word by mistake, you can recover your documents by
clicking on the Recover Unsaved Documents button at the bottom of the page.
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The File Tab with Print Option

The Print option will be one of the most common choices on the File tab. The example below shows
some nice features. Here you can choose Orientation for Potrait or Landscape jobs, Double sided
printing, Paper Size, etc. When choosing Print with previous Word versions, the Print dialog box would
open and you need to click on Properties to find these needs. With this default Print window, all these
choices are listed plus others! If you want to print a particular page, ensure you are on that page, click
on the File tab, then click on Print All Pages for the drop down menu and select Print Current Page. If
you have more than one printer, click on the button under Printer for the drop down menu, and select
your printer.

If there are no special requirements, you just click on the square Print box in the upper left corner.
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45 of6 b 58% (=)—} + &
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File Tab Save & Send Option

There is a nice email feature on the Save & Send option under the File tab. You can choose to send your
document as an email attachment. Clicking the Send as Attachment button causes a new Outlook email
box to open with your Word file attached! You can also choose to send it as a PDF file by clicking the
Send as PDF button. You may also choose to save your document as a PDF file by clicking the Create
PDF/XPS Document button.

T B R = Document23 - Microsoft Word o B 52
Home Insert Page Layout References Mailings Review View & e
i save . .
Save & Send Send Using E-mail
Save As ]
S : 2 Attach a copy of this document to an e-mail
> "% Send Using E-mail L
L5 Open ‘ |i] 4 \| :G=\. Everyone receives separate copies of this document
£ Close e Changes and feedback need to be incorporated manually
end as
Q e ch Attachment
Info _
"1 Saveto SharePaint ik i that contaisa ok to this d t
Recent Ll reate an e-mail that contains a link to this documen
9 Everyone works on the same copy of this document
New i—j Publish as Blog Post — Everyone always sees the latest changes
n Keeps the e-mail size small
Print File Types /8 Document must be saved in a shared location
H Change File Type = Attach a PDF copy of this document to an e-mail
l:mpﬁ_!f Documnent looks the same on most computers
Help = i Preserves fonts, formatting, and images
: Q Create PDF/XPS Document ESDFEE Content cannot be easily changed
2] Options
Exit
- Attach a XPS copy of this document to an e-mail
Txps Document looks the same on most computers
Preserves fonts, formatting, and images
Send as XPS Content cannot be easily changed

Send as Internet Fax

=) Send a fax without using a fax machine
> Requires a fax service provider

Send as
Internet Fax
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File Tab Help Option

You may also find Help with Word 2010 under the File tab. Clicking the Getting Started button offers
nice videos on basics for all the Office suite programs from Microsoft.com. The Microsoft Office Help
button offers the same useful help information as the question mark symbol in the upper right corner.

You can also see which version of Word is loaded on this view.

90 &l Document23 - Microsoft Ward o B R
Home Insert Page Layout References Mailings Review View & e
H Save
Support

Save As Lt # Microsores
- Microsoft Office Help a Ice
L5 Open 9 Get help using Microsoft Office. L'

[_j‘ Close

Getting Started Product Activated

Info La See what's new and find resources to help Microsoft Office Professional Plus 2010
you leam the basics quickly. This product contains Microsoft Access, Microsoft Excel, Microsoft SharePeint

Recent Workspace, Microsoft OneMote, Microsoft Outlock, Microsoft PowerPoint, Microsoft
Contact Us Publisher, Microsoft Word, Microsoft InfoPath.
New Let us know if you need help or how we
can make Office better, Change Product Key
Print Tools for Working With Office About Microsoft Word /
Save & Send — Options I Version: 14.0.6112.5000 (32-bit}
|ﬁ Customize language, display, and other Additional Yersion and Copyright Information
program settings. Part of Microsoft Office Professional Plus 2010
© 2010 Microsoft Corporation. All rights reserved.
3 — Check for Updates Mi £ i s 45 i+
in i g icrosoft Customer Services and Suppo
{4 Otions ) Get the latest updates available for or
-~ Microsoft Dffice, Product 1D: 02260-556-0052232-48582

Microsoft Software License Terms
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File Tab Options Option

You can customize many tools and features in Word by clicking on the Options button. For example, you
can change the color scheme under the General button on the dialog box that opens in the screen shot
seen below. Changes can also be made for Display, Proofing and how files can be saved.

Word Options

]l el @ - O Document23 - Microsoft Word o B o
File Home Insert Page Layout References Klaifings Review Viewr N 7]
i Seve 4 e e

Information about Document23 e
& save s
15 Gpen P Permissions
=3 Close |£|fi Anyone can open, copy, and change any part of this document,
" Protect —— -
[nfa Document =
Fropertiss +
Recent z
s Prepare for Sharing
hiew { ,_—‘] Before sharing this file, be swere that it contains:
= Decument propertise, auther's name and related dates i
Print Check for e
Tssues =
ags
Save & Send Commanits dd comments
Help o Versions Related Drates
L }5] ] There are no grevious versions of this file. Last Madified Taday, 978 AL
| 1} “optians Manage Created
=T it st Frinted
Relaten Paople
futho bhark Mellaskey
Last Modified By
Show 41l Properties

General P . . .
E@ General options for warking with Word.
Display
Proofing User Interface options
Save Show Mini Toolbar on selection &
L Enable Live Preview (i)
anguage
Always use ClearType
Advanced Color scheme:
Customize Ribbon ScreenTip style: |Showfeature descriptions in ScreenTips L
Quick Access Taolbar Personalize your copy of Microsoft Office
Add-Ins User name: |Mark McClaskey
Trust Center Initials:
Start up options
|:| Open e-mail attachments in Full Screen Reading view (i)
[ Ok J ’ Cancel
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The Insert Tab

The Insert Tab offers many tools that can add nice features to a document.

™ s A Document2l - Microsoft Word = E £

=R
Home Page Layout References Mailings Review View & @

|€] Cover Page - :l | ,_]g| Lr'_|__. i__f_’iSmartia.rt &, Hyperiink =S| Header - A |Z Quick Parts ~ [~  JT Equation -
_'] Elank Page . I—I Ee == .'Ei'] Chart A& Bookmark ﬂ Footer = ...lﬂ Wordart = jl, 2 Symbol =
=i Table | Picture Clip Shapeey.. Teti o

h= Page Break - ) ~ / fazt Screenshot ~ | |'#] Cross-reference ] Page Mumber =] poy- 2=

|
>ﬂ - I

Pages Tables Ltrations Links / Header & Footer Text Symbals |

Pictures or drawings can be added by clicking on the Picture button. A The Insert Picture box will open
prompting you to browse to the picture on your PC. Click the picture you want then click Insert. It will
appear on your document.

Clipart are pictures or illustrations that can be added through the Internet from Office.com. Simply click

the Clipart button and a dialog box will appear. Type in the subject in the ‘Search for:’ field, click the box
for ‘Include Office.com content’ and then click the Go button. Click the picture you want from the results
that appeared and it will be inserted into your document.

Shapes like lines, arrows, basic geometric shapes, equation shapes, flowchart shapes, stars, and banners
can be added. Clicking the Shapes button will cause a large dropdown of multiple shapes to appear.
Click your choice, and then click your cursor on the document where you want, and the shape will
appear.

Charts can also be added to a document. There are many to choose from such as column charts, line
graphs, pie charts, bar charts, area graphs, and stock charts. Click on the Chart button and the Insert
Chart box will appear. Select the type of chart on the left, select the chart on the right, click OK and the
chart will appear and it then can be manipulated.

Headers, Footers and Page Numbers can also be added to a document from the Header & Footer group
on the Insert Ribbon. For a multi-page document, the content of the Header will be seen at the top of
each printed page and the Footer will be seen at the bottom as well as the page number when added.

These are just a few common examples on the Insert tab. The size of your object can also be changed.

After you add the object, a box appears around it with circles in each corner. Hover your cursor over the
bottom right circle until the arrow appears, hold the left mouse button and just move your mouse!
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Page Layout Tab

The Page Layout Tab lets you control the look and feel of a document in Microsoft Word 2010. You can
apply a global design to your document by using one of the available themes and color schemes.

e OB :
@. I 9~ == Document21 - Microsoft Word
Home Insert Page Layout References Mailings Review View
j - = [ Orientation = ¥= Breaks ~ |4 Watermark = Indent Spacing = |
== A&]-| = [3sze- fHLine Numbers = | <3| Page Color ~ | £E 0° || = opt F 4 U
Themes gins __ 7 - e x| = ~71| Posit ra o 2
- ' - £= Columns = bi~ Hyphenation ~ ﬂ Page Border Si1° , 4= 0pt , Text L-.Q Selection Pane ilk Rotate
Themes Page Setug | Page Ba-?l:gmunl\ Paragraph Pl Arrange

The margins can be controlled on your document giving you smaller or greater size in which to work.
Just click on Margins, and just click on the desired choice of options.

Click on Orientation for Portrait or Landscape layout.
Page Color and Page Borders can be added from the Page Background group.

As you may notice, the Page Layout tab has some of the same commands that you will find on the Home
tab like Indentation, Spacing and Line Numbering.

The Page Setup group has the triangle button at the bottom right in which to click and see the more

advanced Page Setup options. The Paragraph group also has the triangle button for the advanced box
like it does on the Home tab.
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References Tab

The References Tab on Microsoft Word 2010's ribbon offers a quick way to enter your document
sources, citations etc. On the References tab you will find groups like Table of Contents, Footnotes,
Citations & Bibliography, and Captions.

wEH9- 6 &= Dacument2l - Microsoft Word = @ R
Home Insert Page Layout References Mailings Review View & 0
S Add Text ~ ._'[';']Insert Endnote [ g é Manage Sources [ -4 Insert Table of Figures j = _?-{In =
4 7 ol | e e (=t
2 Update Table AE Next Footnote ~ | — [, Style: APAFiftt ~ = Update Table : Ey N
Table of Insert i s Insert s Insert Mark Mark
Contents = Footnote = =how Note Citation - ﬁJBlbhography' Caption ] Cross-reference Entry Citation
Table of Contents Footnotes a Citations & Bibliography Captions Index Table of Authorities

N
One of the nicest features on the References tab is adding the Table of Contents for a document. One
thing you need to make sure is that you type your document using one of the heading styles for the

items that need to be included in the Table of Contents. Click the Table of Contents button and the table
below appears. Automatic Table 2 is a good choice. Click this option and your table is created!

Built-In I
Automatic Table 1

Contenls
Hegding 1......c..c. . R . S . . P |

Automatic Table 2

Table of Cantents

LIEE T o et i i A i3l ok, |
{1 [T R B R R L S AR I Y N o iy [ AT, |

Manual Table

Table of Contents
Type chapter tithe [level 1) .........
Type chapter title {level 2)

Type chapter title {level 3]
TYPE R R T A ol o s et s e s e e i oot et vt i

] Insert Table of Contents...

_:.\_ Bemove Table of Contents
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Mailings Tab

One of the most common features on the Mailings tab is the Envelopes and Labels for printing.

w9~ o &= Document2l - Microsoft Word o @O
Home Insert Page Layout References Mailings Review View &3 a
- Iy A . =D = =P Rules sy M | L |

Merge = Recipients = R 5 E ts
Create Start Mail Merge Write & Insert Fields Preview Results

En7{ope5 Labels | Start Mail Select

Clicking the Envelopes button produces the box below which allows you to enter in the Delivery address
and Return address. Clicking the Options button gives the choices for the envelope size. On the Labels
tab, the Options button is also available for the needed label size.

Envelopes and Labels

Labels

E

Delivery address:

[] Add electronic postage
Return address: G - O] omit

A | Preview Feed

W

When prompted by the printer, insert an envelope in your printer's manual feeder,

Print l [ Add to Document l ’ Opkions... ] [E-postage Properties... ]

Cancel
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Review and View Tabs

The Proofing group is one of the most popular groups on the Review tab.

@ |+ Document23 - Microsoft Ward
Home Insert Page Layout Referencas Mailings View
i& [, Research aja a = Al Defete _-':}f 4% Finak Show Markup «{ T '-/ > '?;:3. s % Previous _j
5 Thesaurus ) 2 Previous P 2 show Markup ~ 1= — P Mext -
Spelling & g Translate Language Mew Track 2 o Accept Reject Compare
Grammar fzg Word Caunt - - Comment . Mexd Changes = ERewewmg Pane - - - -
Proofing Language Camments Tracking Changes Compare

Once you have finished your document, you can perform one last spell check by choosing the Spelling &
Grammar button. This is an automated process going through the entire document.

The Research button will allow you to access different dictionary lookups of any word you have
highlighted.

The Thesaurus button will suggest other words with a similar meaning for the word you have
highlighted.

The Word Count button will give you statistics for the number of pages, words, paragraphs, lines, etc.

View Tab

The View Tab is the last of the tabs on the Microsoft Word 2010 Ribbon.

Wid9- 0 &= Document23 - Microsoft Word = B8R

Home Insert Page Layout References Mailings Review & @

[T J | _|:J : Q '_'—=- = [ Ruter [ : ) P ‘[ﬁ JJ One Page 13 View Side by Side e
' . = k [C] Gridlines Vool EQT\'\D Pages 3; Synchronous Scrolling ==
Print |Full Screen Web  Outline  Draft = p—— Zoom 100% . . Mew Arrange Split X - Switch Macros

|layout| Reading Layout [l Mavigation Pane = Page Width | window  All 113 Reset Window Positlon  windows = -
Document Views Show Zoom Window Macros

e ; -

By the buttons available on the Document Views group, you can view your document in different ways.
You can see the Print Layout, Full Screen Reading, Web Layout, Outline, and Draft views.

On the Show group, you can measure and line up objects by clicking the Ruler button and the ruler will
appear at the top and left margin of the document.

The Gridlines button also allows you to line up objects by splashing a grid paper view on top of the
document.
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Creating a document to be used by previous versions of Word

If you create a document to send to people who are working in earlier versions of Word and you know
that they have installed the Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint 2007
File Formats, you can work in Microsoft Word 2010 mode.

If you aren't sure whether the people you send your document to have installed the Microsoft Office
Compatibility Pack for Word, Excel and PowerPoint Open XML File Formats, you can work in
Compatibility Mode. Compatibility Mode makes sure that no new or enhanced features in Word 2010
are available while you work in a document, so that people who are using previous versions of Word will
have full editing capabilities.

Note: If you already created a document, and you want to find out what content won't be available for
editing in earlier versions, see Features that behave differently in earlier versions.

Turn on Compatibility Mode
When you create a new document that will be used in an earlier version, you can turn on Compatibility
Mode by saving the file in Word 97-2003 format.

1. Open a new document.

2. Click the File tab.

3. Click Save As.

4. In the Save as type list, click Word 97-2003 Document. This changes the file format to .doc.
5. In the File name box, type a name for the document.

6. Click Save.

26



The CutePDF Writer Addition

With the deployment of all new staff computers, there will be a program loaded called CutePDF Writer.
The purpose of this program is to allow you to create PDF files from any Windows program that is able
to print. If you needed to send a document to someone who doesn’t have Word or a compatible
version, this is the answer for everyone has access to Adobe Reader. To create the PDF document from
Word, click on the Print button from the File tab. From the drop down menu under Printer, choose
CutePDF Writer, then click the Print button. The Save As box below appears. You can save the converted
PDF to your PC!

w1 L 3| Office2010G etStart (Autosaved) doce - Microsoft Word ]
“ Home  Tnsert  Pagelayout  Peferences  Mailings  Review  Wiew Q
el save
—_— Print -
[l saveds Ll
h'—lh Copiest 1 P
[ Open -
Brint
L Crase

Info Printer
b CutePDF Writer
Recent S5 Ready

Prnter Properhies
Mew
Settings

m % Frink &1l Fages

— Print the entirz decumant

Save B Send
Help
e oF
3 optiens eirdihib
B4 Ear ki
| Portratt Crientation -

I | Letter .
b S5 xal”

Hzrmal Margins
Lef: I Right 1°

| 18age Par Sheet B

Ed T

4125 ofd5 5?-},.;5... 1t .|.

Save jn: |@' Desktop ﬂ ck BE-
h:lMy Dacurngnks [CiMFolder

:J My Compuker |CIRDP
HMy Metwork Places [C)5tinger Anti-Yirus app
[C)Dameviare 5 Software installs an 'Husd-storage’ (|
() Imanes
[CLightspesd:

< | %

File name:  [testfe.pf
Save as type: | PDF Files [*.pdf] | Cancel

towe up to CutePDF Pro and get advanced control over your PDF documents.
E azily merge & zplit POFz, add secuity, digital zsignature, stampz, bookmarks or
header/footer, make bookletz, ndlp, zave POF forme, zcan to PDF and more!

Help hittp: v, CutePDF. com
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MS EXCEL

A spreadsheet is essentially a matrix of rows and columns.
Consider a sheet of paper on which horizontal and vertical lines are
drawn to yield a rectangular grid. The grid namely a cell, is the result
of the intersection of a row with a column. Such a structure is called a
Spreadsheet.

A spreadsheet package contains electronic equivalent of a pen,
an eraser and large sheet of paper with vertical and horizontal lines to
give rows and columns. The cursor position uniquely shown in dark
mode indicates where the pen is currently pointing. We can enter text
or numbers at any position on the worksheet. We can enter a formula
in a cell where we want to perform a calculation and results are to be
displayed. A powerful recalculation facility jumps into action each time
we update the cell contents with new data.

MS-Excel is the most powerful spreadsheet package brought by
Microsoft. The three main components of this package are

% Electronic spreadsheet
< Database management
% Generation of Charts.

Each workbook provides 3 worksheets with facility to increase the
number of sheets. Each sheet provides 256 columns and 65536 rows
to work with. Though the spreadsheet packages were originally
designed for accountants, they have become popular with almost
everyone working with figures. Sales executives, book-keepers,
officers, students, research scholars, investors bankers etc, almost any
one find some form of application for it.

You will learn the following features at the end of this section.

% Starting Excel 2003

% Using Help

» Workbook Management
Cursor Management
Manipulating Data

Using Formulae and Functions
% Formatting Spreadsheet

% Printing and Layout

% Creating Charts and Graphs

L)

>

R/
%

>

R/
25

R/
°

>

MS Excel Page 1 of 40



Starting Excel 2003

% Switch on your computer and click on the Start button at the
bottom left of the screen.

% Move the mouse pointer to Programs, then across to
Microsoft Excel, then click on Excel as shown in this screen.

0= 2l
Pragram Accecs and Defaults

| mspaint

| Windows Cataing

: W windows Updete

:Lb Documents

|3 ettros 3 Ft-Ciffice

;,J Zearch ¥ ) Advanced GIF Animetor v [ SRR

| ) Help znd Support - L‘E Micrasaft Office Aocess 2003
15 Bun, @] Mizrossft Gffice FometPaink 2003
|12 Log Offieg.. 4

@ Turr OFf Computer..,

) Cosurentd - Mic | e & iLae A

% When you open Excel a screen similar to this will appear
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% The options shown below is called as Menu Bar

“ File Edit iew Insert Format Tools Data \Window Help

% The collection of icons for common operations shown below

is called as Standard Tool Bar

MS Excel
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TOOLBARS AND THE ICONS

Standard Toolbar

D QY &R B A A 0 -3,
MNew [} Open

Creates a new blank file. Opens ot finds afile.

Alfernafive: File — New Alternafive: File — Open

Shortat — Ctel + | Shorfadt—s Ctrl +0
Save & E-Mail

Saves the active file. Sends conterts of the current worksheet as

Alfermafive: File — Save ~ — body ofthe e-mail message

Shorfouf — Clrl +3

=
Primt ./
Frints the active file using current defaults.
Alfermafive: File — Print

Shorfouf — Ctel +F

Print Proview Spelling
Displays fll pages as they are printed. & Checks the spelling in the active file.
Alfernative: File — Print Preview Alternafive: Tools — 3pelling and
Shorfout — Ctel +F2 Gramines

i Shorfout — F7
Cus
Cuts the gelection and s it on the d Past
if];zf:c:;ie Bdit — Cut Ingetts the Cliphoard contents at the
’ insettion poitt.
+
Shorfout = Ctel + 2 Alfernafive: Edit — Past
Shorfosf — Ciel + W
Copy . )
Copies the selection and pats it on the — B3 ) Fongat Painter )
clipboard. Copies the formaffing of the selecfion fo a
Alfermative: Edit — Copy <t specified location. ]
Shorfout — Ciel + 0 Shorfouf — Ctrl + 3hift +C
Hado
LUnd K |-
T e c:l:ur:m:nds Revetses the action of the Undo conunand.
Alfernative: Edit — Tado ' Alternafive: Edit — Fepeat
Shortout — Ctel +2 | S e G e
Insert Hyporlink Auto .5‘.11« )
Displays the destination object, document X #ilds m:mb.ers automatically with the
or page. — | EUM function. Excel suggests the range of
Alternative: Edit — Repeat cells to be added. If the suggested range is
Shorict _)I Ol + K ¥ incorrect, drag through the range you want,
and then press ENTER
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Insort Hyporlink Auto Sun

Displays the destination object, document % ?T_?I?; m}tz‘;ﬁ ?::I:Denlmsicgaégtfit}it?;ge o

or page. L g

AHI;,EM-%. Edit — Repeat cells to be added. If the suggested range is

Shortous _}I el + K 5 — incorrect, drag through the range you want,
|| atud then press ENTER

Displays a list?;:uf:t?;::;d their 5 Sort Ascending

formats and allows you to set values for Horts the selected items in order from the

arguments. 4l — hegitming of the alphabet, the lowest

numbet, or the eatliest date, using the
columi that contains the ingertion point. IF

Sort D 2 z you previously set other sorting options are
ot Sesconding &l still in effect.

Borts the selected items in order from the Alternative: Tabl Sott—> A din
erud of the alphabet, the highest mumber, or srnalive: Lable = ootk — Ascensing
the highest date, using the column that

cotrtaitg the insertion point. If you g Drawing

previously set other sotting options are still — Shows or hides the Drawing Toolbar,

inn effect.

Alternative: View — Toolbars — Drawing
Alternative: Table — Sort — Descending

ChartWizard Ll
Btatts the chart Wizard, which guides vou
theough the steps for creating an embedded
chart on a worksheet or modifying an
existing chart.
Alternative: View — Toolbars — Drawing

Microsoft Excel Help
Prowides help topics and tips to accomplish o zﬂﬂ‘fﬂ_ Cﬂﬂffﬂf
your tagk L @ Acales the ed1tfing FiEW [ 00).
Alternative: Help — Wlicrosoft Word Help Alfernafive: View — Zoom
Shotteut — Fl L~
100%: -

% The formula bar is the place in which you enter the
formula(=A3*B5)

[ &7 =] E T

% The alphabets A,B... are known as columns
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A | B | ¢ | o] E | F | 6 | H |

% This is the name of the workbook. (Book1)
Wl Book]

00| OO | = [T | P L |-

% The rows are numbered as 1,2,3...

< Sheetl,Sheet2, Sheet3 are known as worksheet tabs

'\ Sheetl / Sheet? [ Sheet3 /

How to use Help Menu
% Click on Help, Contents and Index, then click on the Index
tab. The following screen will appear

About Micrasoit Excel X

Microsoftd Offics Exod 2003 {11,561 2, 5606]
| Part of Micrasaft Office Prafessional Editian 2003
Copynght (£ 1985-2003 Miorosoft Carporation, &1 nghts reserved.,

Povtions of [nt=matioral CerrectSpell™ pellinig torecicn system © 1993 by Lemout 8 Hauspie Speeth
Prioduas Mt Al righs resarved. French spelling checker and dicionaiies © 13942000 SYHAPSE
Ceualoppement, Toulouze (France], all nghts resenved, Spanizh Spalling Engine @ 15382002 by
SLEHUM Cia, Lda, Quito, Exuadee, All Hchis resenvad.

Thiis product i licenzed ka:

i ieg

| ieg

| Product 1Dy 73931-6+1-3054546-57640

Whew the End-User License Adreerent

‘Warning: This cormoiber program is protecked by copyicht law and intemational
treabies. Unauthorized reproduction or distribution of this program, of any portion of %=
It, may resul i severe civil and criminal pendties, and will e prosecuced to the
mainum extkent passible undsr the (2w,

| §'(stcm]nl;0... |
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<% Type the first few letters to see the help entries for those letters.

% You can get the printout of any help topic by selecting it, right
clicking and then clicking Print Topic.

Workbook Management
Task 1: Creating a new workbook

« Click on File menu and then click on New.

LiPocuments and Sethirgsyegile.  Ltmetehis-fomat
21D Datalls Caleges

3400 rd

440 s and Sebtirgeieg | Desktap)

Ext

% Click Workbook and then click OK button. You will get the
screen as shown below.
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Task 2: Saving Workbook

*

% Click on File menu and then click save. You will get the below

screen
Save As
Savein: I@ Deskkap [ ~ Tools -
\_“5 || Mame: el
! a My Documents
My Recent j My Computer
Dacuments
T | Sy Mebwork Places
= {18 DIST MAPS
@ [japmaps
Desktop |yaptitude Question papers
{1 C-Programs
\ [2)D0M Books DS
__.-/ I Degres JKC
My Documents || =) pistrict wise maps
[iemprews
g! |C)Englishpapers
' I FEP
My Computer (=5 e -z008 v
= £ *
File name: [ V! [ Save ]
My Metwork, ; i
Places save as bype: | Microsoft Office Excel Workbook v| Cancel :

*

button

Task 3: Opening an existing workbook

*

will appear

MS Excel

% In the File name text box, type sample and then click Save

% Click on the File menu and click on Open. The open dialog box
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Lookin: || Desktop v @ @@ X [y EFoTodkse
5 | [CiaPoET MaRs ) payment details e ICTRank Anantapur
_:3 |Cyapmans () Perding maps Bk akatiyaMahilzDegraeclleged, 3,200
My Recen: ||| dptitude Question papers ) Reascning Eorveported X Stucertslst1) |
Dretments - ) | C-Progrars I hschedules Eﬂpﬂ@sh
== 300 Books (DS [C)srisha @;]Shortcut to M Details Colleges
w | ) Degree KT 2ot Slls iﬂjSRI\fTF Billa{ 1)
Desktop | |2 District wise maps ) silaksmi
Jemaneis SRHT Files
| CiEnglishpapsts ) Timetable
|irep S)TTach
| My Documents ||(Z3KC 2008 Heocks Detailsi1(1)
| Citearring Resawrces @Eﬁcks D5 farmnat
. |Symals B Eacksh, ods datals
f‘)‘g (C3MaPS FINAL ) Candidates selected for GENPACT
My Computer || = ms0fice @JCDIbges Lisk Tncentives Received Lethers(1) |
‘“;- & 2|
'1}; Fle name: | vl
1y Mebwork = ==, :
Places | Flesoftspe: | ul wirosoft Office Excel Files v

% Click on some file (Example: sample.xls), then click on Open.

Task 4: Closing your workbook

K/
£ %4

Click on File menu, then click Close to close your workbook

Cursor Management

Task 1: Moving around the worksheet

Open sample.xls workbook.

Move the cursor in your worksheet by using the arrow keys on
the right-hand side of the keyboard.

When you have got lots of rows of data you can move the cursor
more quickly by using the PgUp and PgDn keys to move up and
down a screen at a time.

To move one screen to the right, press the Alt key and PgDn
keys together.

To move one screen to the left, press the Alt and PgUp keys

together.

To move further to the right, just keep pressing the right arrow
key

To move back to cell Al, press the Ctrl and Home keys
together.

Pressing the Home key on its own takes you back to column A
To move to the last column(IV) press the Ctrl and right arrow
keys together.
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% To move to last cell containing data, press Ctrl and End keys
together.

% To move to the last row(65,536), press Ctrl and the down
arrow keys together.

% You can also move the cursor with the mouse. Move the mouse
pointer to the location you want. Press and release the left
mouse button once when the cursor is where you want it.

Task 2: Moving to a Specified cell

% Click on the Edit menu, choose Go To. You will get the below
screen

Go To @

G0 ko

Reference:

[ special. .. ] [ (o] 4 ] [ Cancel ]

< Enter the destination cell reference in the Reference text box.

% Click OK to move directly to the specified cell.

Data Manipulation
Task 1: Entering data

+ Start Excel. Click File and then New. An empty worksheet
appears as shown below
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18
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“ Type Expenditure in cell Al then press down arrow key to move

to cell A2.

% Type Month then press the down arrow key to move to cell A3

% Continue to type the data. The resulting worksheet should

appear like the following screen.
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IS Microsoft Excel - Book2

He Edt yimw [t Fomat Iodk Do Sicow  Heb Tpramuestoniforbel B @ K
[ERE RERETIE WERR- A A RS EE T RS A T N RS HEaes =
s tewRoman 510 x| B L W= ==l gy e e e Al e sy i B
o s motper N S OE A
EL - &
A | B ¢ | B B F | G H | B
Al Expenditure
2 Month Tan Feb Mar
3 Rent 200 200 200
4 Electricity 20 22 18
5 Household 150 145 150
6 4
8
9
10
11|
12 |
13
15
1O Ny sheet) {Ehast [ Gheeta [ sl
_ NUM

74 Start O OB G L memmed Wil ) Ficks - Mirosofb i B

% Save your work by clicking File and then Save As. This dialog
box appears.

Save As @

Save in: | @ Diesktop |55 ~ Tools »
Lé Mame = Lo
- iﬁMy Documents
My Recent M C k
Diocurents "" s
‘:ﬂMy Metwork Places
-F: 18P DIST MAPS
Iy apmaps T
Desktop |yAptinude Question papers

) C-Programs
{)DDM Books CDS

[C)Degres JKC

My Documents || == pictrict wise maps
Iﬁempnews

g_! |CIEnglishpapers

SiFER

My Computer || == e anng v

iy < I | 2

File: name: im w ! [ Save ]

My Metwork,

Places Save as type: iMicrosnFt OFfice Excel workboak ~ | Cancel )

% Type cash in the File Name text box and then click Save button.
Excel automatically adds the extension .xls to your file name.
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Task 2: Editing data

Click File and then click Open.

Click cash.xls and then click Open.

Move the mouse pointer to cell D4, click and release. The cell is
highlighted and 18 appears in the formula bar.

Move the mouse pointer to the formula bar and click once to the
right of 18.

X/ X/
R X X4

7
L X4

X/
°

I Microsot Excel Book2

(] Hieo Eck Vew Irewt Fomer Tods Debs Widw  Hep Tipeaqmdento by DI
RN T LT 1 MVl N T e AR [ N 1 30001 1) el Pt e =B
Times Nk Foman 10 B /U E =l s %o Wl = vi'an‘\v!EJ-_- v | ) 5 E
o o agothees- N N OO B A WA S-S A-S== 0 F
T = £ 10
A B | ¢ BB E | F | ¢ | H | &

1 Expenditure

2| Month | Jan | Teb Mar |

3 Rent 200 200 200

4 |Electricity 20 22| lSl

5 Household | 150 145 150

6

8

9

10

11

12

13

14

15

Wb W Sheett J shest { Sheeta / ¢ i ol
Heady UK

7. start. @ T | h sz st | IO P - Drascitad B Ml s -Qf_,{'v. 01 FA

% Use the Backspace key to delete 8,then type 4 and press
Enter. Cell D4 now contains the value 14.

Task 3: Replacing cell data
% Make the cell B5 active by clicking on it.
% Type 200 and press Enter. The cell B5 will now contain the value
200 replacing old value (150).
Task 4: Deleting cell contents
% Move to cell C5 and click to select.

% Press the Delete key.
< The cell becomes blank.
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% Drop down the Edit menu and click Undo to reinstate the 145.
Excel 97 allows 16 levels of undo. You can use Undo and Redo
buttons also.

Task 5: Copying data

% Open the cash spreadsheet.

% Select the cells D3 to D5

% Click Edit menu and then click Copy.

% Select the cells F3 to F5.

% Click Edit menu and then click Paste.

% Now the cells D3 to D5 are copied into F3 to F5.

Task 6: Moving data

% Open cash.xls spreadsheet.

s Select the cells from B3 to B5.

% Click Edit menu and then click Cut.
% Select the cells G3 to G5.

% Click Edit menu and then click Paste.

Task 7: Data Auto Fill

There is an easy method to fill the data in columns and rows. The
data may be Numeric or dates and text.

To fill SIno by using auto fill
¢ Type SIno for 2 cellsi.e 1,2 in the cells A1 and A2 respectively.
¢ Select two cells and drag the Fill Handle +

A B C D E F
I 1 2 3 4 5 6
2 2
] 3
4 4
5] 5
6 6
7 7
] 8
9| 9

To fill dates in the cells
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¢ Type date in the cell
¢ Select the cell and drag the Fill Handle

A | B | ¢ | b
01/01/2008 02/01/2008 03/01/2008 04/01/2008
02/01/2008
03/01/2008
04/01/2008
05/01/2008
06/01/2008
07/01/2008
08/01/2008
9 |09/01/2008
10/01/2008

11/01/2008 | |

—_

12

UI‘J‘-\"M

(@)}

0]

—_
)
J—

—_
—

We can customize the lists with different text data to minimize the
redundancy of work.

Some of the lists are listed below:

1.

2.

3.

4,

Jan, Feb, Mar, Apr, May, June, July.... like months

Sunday, Monday, Tuesday, Wednesday, Thursday...Like week
days

Adilabad, Anatapur, Chittor, Cuddapah... like District names

Ravi, Kiran, Praveen, Rama.... like employees list

To create a customized list follow the steps given below:

¢ Click Tools Menu ,Click Options then click Custom Lists tab, Then
you will find the figure given below:

MS Excel
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Options EJ El

Calor International Save

Wigt Calculation Edit

sun, Mon, Tue, Wed, Thu, Fri, =
Ssunday, Monday, Tuesday, Wet
Jan, Feb, Mar, Apr, May, Jun, 1
January, February, March, April

Press Enter to separate list entries,
Import list From cells:

Custom lisks: Lisk entries:

Speling

EN

Security
Chart

04

] [ Cancel ]

¢ Click NEW LIST and enter the list in the List entries window
¢ Click Add button then click OK button then your list will be
added to the Custom Lists. That list you can use as and when

required to type.
¢ Now you can Drag the fill
automatically.

Using Formulae and Functions

Task 1: Entering a formulae

« Click File and then click New.

(+ ) to get the list

% Enter the data in the new worksheet as shown below

MS Excel
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£ %4

X/
°

X/
°

X/ 7
L X X4

T Wicrassit Excel - Bookl

5] p= poe Wew Jreet Pomab Jooks Datst Winden  beo bstonfo ek W oo @ %

R W = WEE NI WS A <N BT - A, A A= el al o @ Bindo o) ———— W28
jj Timees HuwoProman: = 10 = B W BEEE O oH % Shoa i HlEe R —'"_"A'_'l:'—‘ el S 2] d g ﬁ
! i | | fA W) Favcetagy Gor | G9 pookl -8 s
jomens o ownapmas S 8w [0 ] Al fr LA el - b - S m S @ j_!
B - o~
A B c p | B | F | & | H=H

1 Electricity

2 |Month Tan Feb Mlar Apr May Jun

3 |Rent 200 200 200 250 300 250

4 |Electricity 20 22 L8 25 30 28

5 |Household 150 145 150 130 150 140

6 |FPower

8

9

10

11

1‘1

13

14

1=

WO WhSheett fShEsta f Gheerd g

S R e U S

Cell B6 should contain formula. Move the cell pointer to cell B6.
Type =B3+B5(formulae and functions should always begin with
= sign)

Cell B6 will now contain the value 350

Look at cell B6; you will see the result of the formula in the cell
B6 rather than formula.

Now repeat the appropriate formula for cell C6, D6.

Save your worksheet as cash3.xls.

Task 2: Editing Formulae

X/
°e

X/
°e

Move the cursor to the formula bar with the mouse, clicking
once.
Make the desired changes.
When you have finished editing the formulae, press the Enter
key for the changes to take effect.

(OR)
Edit the contents by pressing F2 key on the keyboard

Task 3: Displaying and Printing formulae

L (4

R/
*
K/
£ %4
K/

£ %4

Click Tools menu and then click Options.

Click View tab.

In Window options check Formulas check box. The below
screen appears.
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Options

Color International Save Error Checking Spelling Security

Wig | Zalculation Edit General Transition Cuskarn Lisks Chart
Shiow

startup Task Pane Eormula bar Status bar windows in Taskbar
Camments

() None * Comment indicator only () Comment & indicatar
Ohijecks

() Show all () show placehaolders () Hide all
‘Window options

[] Page breaks Fow & column headers Hatizantal scroll bar

] : Cutling symbils Yertical scroll bar
Gridlines Zero values Sheet kabs

aridlines colar:

QK ] [ Cancel

% Click OK button.

% To print the worksheet with formulae displayed, click File menu
and click on Print Preview. If the layout is satisfactory, click on
the Print button.

Task 4: Using the SUM function

% Open cash3.xls spreadsheet.

B e e

Pl fh G #en et fpee Do Do Wirdee (e i bot 3K
W= BEWE TR W= N S e N R W RV BE 1 B Eo SN H Ry < B
frembewioren -0 - @ & W= WG S % ¢ dogeoe 0. - A - = TR L l
[ A, Poreien - | g | I Bt i [rerepr—
Plowas o | Mostecss- o w 02 c) ol 0 1l ke A= T @ @R
3 - 3
A | E | C | | E F | G H &

1 Electriety

2 hdonth Jamn Feb Llar Ny Iiay Jun

3 Rent ZOH} 200 2OH} 250 FOH 250

4 Electricity 20 R 18 25 Bl 22

5 Houselwold 150 L45 150 L300 150k I <40

& | Power

% Suppose if you want the summation of the cells B3 to B5 should
appear in the cell B6, then first select the cells from B3 to B6.
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% Click the Auto Sum ﬂ icon on the toolbar.
% The result of (B3+B4+B5) will appear in the cell B6.

Task 4: Copying Formulae

% Open cash3.xls spreadsheet.

% If you want to copy the formula in the cell B6 to C6,D6,E6 then
first select the cell B6.

% Move the cursor to the lower right corner of the cell B6. The
cursor will change to + icon.

% Drag the cursor from B6 to E6 and release left mouse button.

% You will notice that the cells C6, D6 and E6 are updated
immediately as shown below.

B3 Micreseft Fxcel - Book1

] Fle Edt Wew  Insert Formsk  Tooks Dake Windaw  Help ¥Re aquestarfarheln. e
M 3 AT K p e e L2l e (@i o) ——— 2
Tmes Mew Foman = 10 | B O == =Ad) 6 o 0 HR R sEE=] . o A -_.ﬂ:om;lééel-'_‘-ebp e T | | =il E
fas @[ ) Favaribes = | Ga= | S | Baokl _—H—'
Qo s [suoshepes- S x IO S Ao E E@| Sk A===3 I8
B - F =SUMBIES
A B | @ | p | ®w | B [ & | H | =

i

2 [Month Tan Feb Mar Apr May Tun

3 |Rent 200| 200| 200 250| 300 250|

4 |Electricity 20| 23 18 23| 30 28|

5 |HouseHold 150 145 150 130 150 140

6 |Power | 370 367 368 405 480 418

5

8

9

10D

L1

1.2

13

14
uqu. ¥ b Sheetl  Sheet / Shests / | ¥ |v
Srn=z408 LM

= @ S [ meaveelss peasor,, | DA Bk

Task 5: Copying formulae using absolute addressing

% Create the worksheet shown below and save ABS
% If you copy the formula in the cell c2 to c3, c4, c5 you will get

the incorrect

MS Excel
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IS Microsoft Excol - Bookd

Al ple Eie dee [est Fomes Dok Cots Mindow  Heb Type 4 oeston
T .ual il | L R J"- S ANV R ¥ [ N —
D e kW T R W - dy e R TSN N T E
s 2 S ) Favarkagz= ligo = | Boaki _
L= | Autoshapss = doclnl dlw-g-p-===a ul
IF -x\!.&--ﬁzﬂ a!°)
A | » BN v | E | ¥ | ¢ [ H | 7
1 Net Price Total Price
& 6 45| =B2+EBE2" A9
3 589
4 4.78
5] 7.47]
6
8 |[VAT Rate
9| 0265
10
11
152
13
L4
..1-‘:- m i Sheetl f Shesta f cheeta )/ < | »1v

T8 B | Gl ez - Mcromlt

<> result because the formula will change in the cell (C3)to B3*A10
but the value in the A10 is not defined. The reason is that we are
copying relative address but not absolute address. To use
absolute address move to c2 cell.

< Edit the formula to =B2+($B$2*$A$9) and press Enter key.
% Copy the formula to cells C3 to C5.

osoft Fxcel  Book1
iE] ﬁls Edf Mew Lot Famet Took Dok Wirdow e
.r I PR = Wil s N W= (- o M
ETimestewBomen - 10 - | B J U | ==

Farhels = i %

T -
Paa a4 |y &) Favortea e | Gor | S | packy -,
D - ;lﬁﬁhﬂ.:' ;DO—JH,,IS\JQA B A =m=@a ol S
| | A | B [ ¢ | p NN ¢ [ ¢ | H [%
1 Net Price Total Price | |
2 6.45 B.15925
3 589 759925
4 478 648925
5 7.47 917925
: .
7 —
8 |VAT Rate
9 0.265
10
11
12
13
14
..1-:- w 't Sheetd J sheetz f Shesta / < S

Formatting Spreadsheet
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Task1l: Increasing column width

Open an existing worksheet(For example cash3.xls

B3 Microsolt Excel - Book2

SE] Ele Bdt Wew  [reet  Foms Tods  Deba  Window  Help

|

_‘al_.hl_.s_,_ll_é_*l‘ﬁ'.ﬂ,liu;.‘b A N S (U | R L T [ e
fTecMewRoman o0 o B2 W BE W ) $ % e ul B dE el G- A B s e 0 |2 B

e | o | oY &) Feortes= | g3 s | R | Beakz
o L I»:!ut-nﬂ'\_i_:lqs_' S e cd ol o (Al | e A e = ._Jl

Fz'_agvlﬁBlclelE'lF G | ®uH | =

1 |Expenditure
2 |Month [ Jan Feb Mlar Apr May Tun
3 |[Rent 200 200 200 250 300 250
4 |Electricity 20 o] 18 25| 30 28|
5 |Houseliol 150 145 150 130 150 140
6 |power 370 367 368 405
; —
8
Q
10 L
11
12
13
14
T w s Sheetl ¢ Sheeld { Sheeta / |3 =

= & % | 1Ok nesscels - Miaosst ks - Pk asatt Wi W urkltlad - Paint

% Move the mouse pointer to the position(column B)shown below
in the column header. When the black cross appears, hold down
the left button and drag the mouse to the right to increase the
column width by the required amount.

l,_] Eler w Lremit  Farmar  Todke  Gata  dndow  pen P T »
T TR = ) _Jq.l?a"ulgq—u."_‘- F s 2 = oal R[] s - s ST e — =l
p I K P oman B S N S e W ] T e e i N W W N ] : LRl B
. qun |G | [T oo =
Sutcthenms s e [ Ca ol ol S0 (R Gt e et v S =imm o= gk
i = . ==
[ A B (= [ D B =
1 | E:{peuclitlu'c
2 [ NMonth Tay Fel Tlar A Nlas
3 Remt 2O =0 200 =50 R0
1 Electricity 20 232 1= 25 2
5  Household 150 145 150 130 15¢
G | power 370 = 1=l 3cE 405 I

Task 2: Decreasing column width
Open cash3.xls spreadsheet.
% Move the mouse pointer to the column B. When the black cross

appears, hold down the left button and drag the mouse to the
left to reduce the cell width.

Task 3: Changing width of all cells in a spreadsheet
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% Open cash3.xls spreadsheet
% Select the entire worksheet by clicking the Select All button (to
the left of Al cell) at the top left corner of the worksheet. The

worksheet changes from white to black.

Microsoft Excel - Book
O] mle Edb Wew  Inset  Format  Took  Data Window  Hep

R = T TR N e < T I e - T e vma
: Tines New Roman 10 = | B £ U= = = £5 8 % 1 %8 88 =,E'§ i A.- ERE Bl s M B 0 N | 2 = i ]
2| 0 o & Fevorites - | Go- | | Bocka
dpswr by |autoshapes = N w IO ) Al oz ol @l |- d- A-S= @ @l
Al - A Expenditure
A B & | D E | r =

1 |Expenditure

2 |Month Jan Feb Mar Apr May

3 |Rent 200 200 200 250 30¢
4 |Electricity 20 22 18 25 3(
5 [Household 150 145 150 130 15¢
6 |[power 370 367 368 405

-

8

Q

10O

11

]\

13

14
'« w\sheet1 / shests / sheets / < Bl

Raady Sum=3915 UM

[ T Pridts - Mirosaftwiord | 14 unittled- Rait

Click Format menu, click Column, then click Width

% In the column width text box type 20, then click OK button. Your
worksheet cells should all increase in width.

Column Width

Column width:

[ ] 4 ] l Cancel ]

% You will get the below screen. You will notice that widths of all
columns are now changes to 20
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B3 Microseft Fxcel - Book?
Elo Bl Mew Isert Format  Tocs  Dea Mindow  Help

Type a guestion for help = |

TR N = e = W[l - THEE o

(£ Times New Roman w10 | B I 11|E_=_.!i % Y » R PR | EFE ER

Zlosmole =l gl dulagleo e Pisi e ——— 22§
ENES i s RS LT Y NI TR - W W LTI

Dralate Comment

G s | e € Favorkes = | Go v |‘=||auuk2
me-wlmus% e NS <3 8 | %
BT
A | B | & | D | &
1 Expenditure
2 |Month Tan Fely Mar s
3 |Rent 200 200 200
4 |Electricity ' 20| e 18|
5 |Household 150 145 150|
6 |power | 370| 367 368
=
8
9
10
11
12
13
s O 3P e e Je | i

Click the Undo button to revert to the previous cell width.

Task 3: Inserting Columns

Open cash.xls spreadsheet.
% Move to cell B2 and click.
Click Insert menu, click Columns. You will get the below

screen.

;TlmusNewRumun - 10 ‘-nf-l'!'_,,-,;_ﬁ's L)

e | WY Favoritess | G- | ]| Booke
e - g |3&t95t|an=="\ oot e o T T, 11 2 A0 e L S
A
A | B | o D | E I
1 Expenditure
2 |Month | l.T a Feb \Mar Apr
3 Rent _ 200 200 200
4 |Electricity | | 20 B3| 18
5 |Household 150 145 150
6 |power | 370 367 | 368
7
8 . . |
)
LO
11
2
13
L4
Klq:> wIysheetl { sheetz 4 sheets l< - i

i it s - P
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% A blank column will be inserted before(to the left of column B)
Task 4: Deleting Column contents

% Open cash.xlIs spreadsheet.
% Move the mouse pointer to column E header and click to select

column E
c D F

1 enditure

2 |Jan Feb Mar Apr
3 200 200 200 250
4 20 22 18 21
N 150 145 150 130
6 | 370 367 368 40!
e

8

Press Delete button. The column contents will be deleted.
Click Undo button to revert to the previous screen.

R/ R/
R X X4

Task 5: Removing columns, rows, and cells completely

« Select individual columns or rows or cells.
« Click Edit menu and click Delete

Task 6: Inserting a row

% When you insert a row, it is inserted above the current row, so if
you want to insert a new row above row 6(between rows 5 and
6), place the cursor on a cell in row 6 and

% Click on the Insert menu.

% Click Entire Rows insert a blank row between rows 5 and 6.

Task 7: Deleting row contents
% Open cash.xls spreadsheet.

% Move the mouse pointer to row 2 header and click to select the
row as shown below
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B microsoft Excel - Book?

G Ble Bdi Mew  Insst  Founat Dok Dafa Window  Heb
T = I NN (- NI TP e G [

Sl E -l 5[] - o Wiod - g

Timas Mevy Soman - .in

=B o U |E=E =S v

g s | a2y W) revoritezs L go- | B | Boake

S W] S WSS - G I T (Ll T ve e |

AT - #~ Mcah

| A

(&) | D

Expenditure

IIonth

Jan

Feb

Rent
Electricity
5 Household
| 6 |power

4o IR — |

200 200
20 22
150 145
370 367

(w5}

o

10
o]
Jhe

13 |
14 |
i it Sheors  Shesta A SreaE L ! =

| T ez - Microsoet L

Cl Pricks - Miorsantt oo

% Press Delete to remove the contents of row.
% Click the Undo button to cancel the delete operation.

Task 7: Inserting cells

< Open cash.xls spreadsheet.

% Select cells B2 to D4 by moving the mouse pointer to cell B2,
holding down the left mouse button and dragging the mouse
pointer to cell D4, then releasing the left button. The cells should
be highlighted.

EI micraen Tt Excel - Hook?

TE)pie par Wen Jneert Pames Dok ate ndon  ben
T R U T TR - W T S NP e N Ry B S P )

~ebEb ] os - Wi 2 o |

frmesNewREman w10 | B £ N | EE W S ) S % 1 el 2 gF e e e e G0 R o ) s B
N W SO . = W . S o W i =
Aomnz i Jmtheeer S > DO A G Bl O et b ST R
H3 - 5
A ! B | 5 | D | E | P~
1 Expenditure
2 |Month Jan Feb Mar Apr
3 |[Rent 200 200 200
4 |Electricity 20 23 1=
5 |Household 150 145 150
6 |power 370 367 368
7
8
9
10 f -
11 |
12
13 X i
14
WS IBlweet 1 Sheats f Shests / e ® I-

D e - Mol

% Click Insert menu and click Cells. This dialog box appears.
% Click OK to shift the cell down.
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Inserk
{7 shift cells right

() Enkire row
{3 Enkire colurmn

[ Ik ] [ Cancel ]

Task 8: Changing data justification

% Open cash.xls spreadsheet.

% Select the cell B2 as shown below.

% Here the text “Jan” by default left justified. You can modify
alignment as right justified or center by clicking right justify

or center the text ' =

within the cell by clicking respectively.

Task 9: Merge and Center data

% Open cash.xlIs spreadsheet.
% Select the cells A1 to H1 as shown below

A B c D E F G H
1 {Expenditur | O
.2 |Month Jan Feb Mar
L3 |Rent 200 200 200
L4 |Electricity 20 22 18
.5 |Household 150 145 150
&

% Click Merge and Center button on the toolbar

% You will get the below screen.

A | B | ¢ | b | e | F | & | H
Expenditurs
honth Jan Feb har
Rent 200 200 200
Electricity 20 22 18
Househaold 150 145 150

m|m‘b|m‘m—\
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Task 10: Formatting cells

A [ B | e | b |

Marks
200 66 GEBGEEET
4410 2222222222
640 213.3333333

% Create a new spreadsheet as shown below and save it as
“marks.xls”

% Now you can format the cells in column C by selecting column C
by clicking on the column heading

Format Cells EI g|

i alignment Fonk Border | Patterns || Protection

Sample
Jan

Murmber

Currency

Accounting General Format cells have no
Date specific number Format,
Time

Percentage

Fraction

Scienkific

Texk

Special

Cuskomn

(0] 4 ] [ Cancel

% Click Format menu and click on Cells. Click on Number.

< Use the Down arrow in the Decimal Places to set to 0. Click
OK.

% Now repeat the formatting but this time format the cells to two
decimal places.

MS Excel Page 28 of 40



% Again, repeating the formatting operation, but this time to four
decimal places.

% Finally, format the cells to eight decimal places. This screen will
appear.

% The #### symbols indicate that the cell is too narrow to display
the data in the chosen format. However, if you increase the cell
width sufficiently, the data will be displayed to eight decimal
places.

% Increase the width column C until the data is displayed.

% Now change the formatting back to two decimal places, and
reduce the column width to a suitable width.

Changing the data Orientation (Vertical, Horizontal etc.)
% Excel offers three options that let you control the orientation of

the text within a cell. These are Text alignment, Text orientation,
and Text control.

Murmber Fonk Border || Patterns | Protection
Text alignment Cirienkation
Horizonkal; ..
Left (Indent) | Inderk: * ]
Yertical: o | ;
Biotkam b ® Text _0
k .
*
Texk conkral .
|:| Wrap text
[ Shrink ta fit 0 % |Degrees
[ ]Merge cells
Right-to-left

Text direckion:

Contexk b

[ Ok ] [ Cancel

Vertical text alignment can be any one of the following
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6

7

8

9
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11

12

13

14

i SRR e e e — Tl i i
_ _ _ Sum=100TeEHZ : CAPS hLM

+4 starl oM G | T Sk Veriabechia . | @ MSCFcet 0§ asmscals - Micko., | O Probs - Maosoto, | BT Meosoft Beoel - e TR diin o
Bottam F|

Top [

i_enter i

Justify b

To display text vertically in a cell:

¢ Choose Cells from the Format menu.

Click the Alignment Tab.

¢ Specify the desired text orientation by selecting one of the
orientation boxes.

¢ Select the Wrap text check box, if you want Excel to wrap
the text

¢+ Click OK

<*

Here are some examples of the different alignment options
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Horizontal Text i W
B W oe %
r For
t a t %%
[ poiot o
Wirapped C pcoe s w
Horizontal a B oa X ‘a&@ %;;
Text | d 1t & %

¢ Select vertical list box and select top to align the data at the
top of the cell (Eg: cell A1)

¢ The below figure shows you different Text control options.

Text control with
Wrap text Test control with Shrink tofit | Text cantrol with merge cells

Printing and layout
Task 1: Previewing a printout
% Open cash.xls spreadsheet.

< Click on the File menu and click on Print Preview. A screen
similar to this should appear.

Frevisu: Fags | of 1
J start N - | b, B MSOHeeL

L8 Prits by
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% Since the size of the text is very small, you can click on Zoom
button, it magnifies the worksheet. Clicking on Zoom second
time returns you to the original preview format.

% Press PgDn to move through your worksheet if it is more than
one page long.

% Before printing make sure that your printer is switched on, is
loaded with the appropriate paper, and is on-line.

% If you are happy with the layout of your document, click on the

Print. .. |

Print button to obtain a printout. You should see a message on
screen telling you that your file is being printer, and on which
paper.

Task 2: Printing landscape
% To select landscape mode, click on the File menu, Page Setup

this screen will appear.
% Click on the Landscape button.

_________ F‘ age Margins | Header/Footer | Sheet

Crientation
(¥} Partrait () Landscape
(%) adjust ko: 100 3 % normal size
(JFibEo: |1 o+ | pagels) wide by |1 = |kall

Faper size: Letker e

Print guality: | 600 dpi "

First page number: Auta F

_____ f
[ 0K, ] [ Cancel

Task 3: Fitting your worksheet to one page

% In the above screen click on the Fit To: box and type: 1 page
wide by 1 page tall.
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% If you need to make changes to your worksheet before printing,
click on the Close button to return to your workbook.

Task 4: Adjusting margins

< In the Page Setup dialog box, click the Margins tab and enter
the appropriate sizes(in inches or centimeters)

Task 5: Setting Header/Footer to your worksheet

% From the Page Setup dialog box, click on the Header/Footer
tab to display the below screen.

Page | Margins || HeaderFooter || Sheet
Header:
(none)
[ Cuskom Header. .. ] [ Cuskom Fookter,,, ]
Foaker:
(none) "
[ (] 4 ][ Cancel ]

% In the Header box either you select a title from the drop down
menu or enter your own title. Similarly for Footer box also you
can set your own title.

% Click on OK.

Task 6: Printing selected cells
% Open cash.xls spreadsheet.

% Click on the row 2 button (or any other row containing data) to
highlight the entire row.

MS Excel Page 33 of 40



Click on File, Print Area, Set Print Area. The preview screen
should only display the selected cells. (Row 2).

If the preview is satisfactory, click the Print button to print out
only row 2.

Click on File, Print Area, Clear Print Area to reset the Print
Area.

Creating charts and graphs

Task 1: Creating a Pie Chart

Open cash.xls spreadsheet.
Select the cells A1 to G5 as shown below

1
2
3
4
5

145 150 130 150 140
Click on Insert menu and click Chart option. This will start the
Office Assistant, to guide you through creating chart.

Follow the instructions in each step of the Wizard. The Assistant
explains each step.

At step 3, you can specify the Chart title, X-axis title and Y-
axis title separately.

At step 4, click As object in sheet 1, then click Finish.

Your chart is now finished. Save as cash4. Your chart is saved
with the spreadsheet. This type of chart is known as an
embedded chart and is saved with its worksheet.

Task 2: Creating charts when the data range is not continuous

Open cash4.xls

If your requirement is create a chart to show expenditure for
February, then first select cells A2 to A5.

Hold down the Ctrl key and, while holding it down, select cells
C2 to C5. Your screen should be similar to this one.

Click on the Chart Wizard and create a column chart. Your
screen should look similar to this.
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% If your chart doesn’t appear to show any data, you probably
included some other cells, probably Al and/or C1. If so, delete
your chart and re-select the correct range.

Task 3: Sizing a chart

¢ Open the cash3.xlIs created earlier. A screen similar to this one
should appear.

B2 Microsoft Excal - Book1

i) e Edb Miew Inestt  Formab  Toos Daka Windew  Help I'vpe & restion for help
HIE =R NERE I MR A N G A R R R e | P T Hi S ol
iTimesNewRoman =110 o B F U [E = =] 8 g 0 Gl Q=2 - (-%-A-!_E_J i A s BT N LS E
L8 @A o | R Fertes s | 6o | | ookt B
o g |awosnepses NSO AG | S - A== d dfl
] % & 2 = . . .
B c [ D] E F G | H | I 8
|
2 Mouth Jan Feb Mar April May Jun |
3 House Hold 520 200 322 345 5237 254
4 |Rent 233| 233 333' 233' 233 233
5 |Electricity | 150 120 140/ 130 152 200
6 |Power | 150 100 118 120 111 200
8 600 [Ghart e e Hold
: 100 ]} -
g “ I [] |h |i |] H Rent
200 ; e1ll
10 9= " e o i s ey | CLBlGCHRIY
11 E s & B § E
=R ey B 3 O Power
12 '
13
14
' i\ heets {ghesto (cheste / [ sl

Ready

Ty —

iq slart 28 G |3 5 verkateswarat,,, | I MissealE - MEttt ., T eries - Micosatt wird B Microsoft Excel - Bookl

X/
A X4

MS Excel

The small black markers at each corner and mid-way along
each side of the chart. These indicate that the chart is
selected, and are called its selection squares.

Click on the mid-point marker on the right-hand side, hold
down the left mouse button and drag the mouse to the right
about one inch(3cm), then release the mouse. The width of
the chart will have increased.

Now practice the same operation on the mid-point marker of
each of the other sides of the chart.

Now try the above, but this time on one of the four corner
markers. Note that when you use these techniques, the whole
chart changes in size, but it retains its original proportions.
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Now use the same technique to reduce the size of the chart.

: Deleting Charts

Make sure the chart is selected(the small black markers are
visible). If not, move the mouse pointer into the chart area
and click and release the left mouse button once.

Press Delete to delete the chart.

: Moving charts and graphs

Make the chart active.

Move the mouse pointer into the chart area.

Hold down the left mouse button and drag the chart to the
desired position.

: Chart headings and labels

While creating charts the step3 asks for Chart heading,
labels for X-axis and Y-axis. You can define your own
labels or click Next button so that the default values can be
accepted.

Chart Wizard - Step 3 of 4 - Chart Options

Titles Axes aridines | Legend || DataLabels | Data Table

Chart Litle:

Expenditure Expenditure

Category (X} axis: £00
Months s00 ]
400 O House Hal

Walue () axis:
H Rent

Sales o0 4 O Electricity
200 H O Pawer
100 H
o H

Jan Feb Mar April  May  Jun
Month=

[ Zancel ][ < Back ” Mext = ][ Finish ]

% For example Chart title is Expenditure, X-axis label is

months and
Y-axis label is Sales
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Task 7: Editing chart items

% Create the chart as shown below and save it as cash4.xls.

B2 Microsoft Excal - Book1
3] Ble Edt Mew Inswt Fomab Iods Chat Window  Help [yre adestion forhelp = o @ X

AR =™ MW T MW A0 W[ SERRT, G g R [0 e W) 7 | I~ . e -zl
PTimestewRoman <12 2[Rz o [SE]= S8 5 0 i A== G- e,g.-é-!_g_ ERI e e | g E
L8] A |0 R Feeikess | G | ] ockt -H
o g [Agotheeer N N IOH A Sl Y- t-A-Sm2 @l

el B & _ :

B | ¢ |p] B | F | @ | ®H# | 1 ] B

|

2 Mouth Jan Feb Mar April May Jun |

3 |House Hold 520 200 322 545 522 254

4 |Rent _ 233| 233 233 233| 233 233|

5 |Electricity | 150| 120 140 130] 152 200

6 |Power | 150 100 118 120| 111| 200

8 Expenditure

9

10 g 1008 O House Hold

11 w TR B Rent

1 (= = L

12 _ O Electricity

13 Month

E - LI Power

14
W H\Sheet1 {chesta { chasta / I< i [ sl
Ready ML

;.f start =8 G | 3 o vereatestwa,, | OF ssscelE-Mioo,,, | OB Rhnks - Microsoft.. BT microsaft Excel -, " unftier] = Faint -R::__;I;:

% Click the chart title(Expenditure). Selection markers(small black
squares) will appear around the selected item.

% You can move or size the title in the same way that you can
move or size a chart. Click the title box and drag it up by about
one inch (3 cm), then release the mouse.

% You can format the title by selecting it, then right clicking and
then selecting "Format Chart Title” from the drop down menu.
You will get the below screen.
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Format Chart Title

X

| Alignment
Eonk: Faont style: Size:
|Times Mew Roman |Eh:|||:| | | 1z
Syskem ~ Regular 9 A
T Tahoma b Tkalic 10 —=
Terminal = Biold 11
Times Mew Bold Ikalic 12 v
nderline: Color: Background:
|N|:une W | | Aukomatic V| |.|5.ut-:|mati|: b |
Effects Presview
[ strikethrough
[] superscript AaBbCeYvZz
[ ] subscript

Auto scale

WaUr sCreen.,

This is a TrueType font, The same font will be used on bath wour prinker and

| ok

] [ Cancel ]

*0

above
s Click OK.

Task 8: Adding text to a chart

X/
°

Open cash3.xls worksheet.
Click View menu, click Toolbars, D

L X4

L X4

rawing.

Click the Text box icon on the Drawing toolbar.

* You can select font type, font style and font size as shown

L)

. e
Expenditure ;| :
i 5
© 500
L]
E O |-LrﬂIl-l_rﬂIl-l_rl-lll-l_r”Il-l_l-I Il-l_l-I DRent 5
- L N B Electricity
[ & ]
= = O Household
months O Power
MS Excel

» Draw a text box inside the chart area as shown below
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% Click inside the text box. A flashing text cursor will appear. Now
type Household Expenditure
% You can use the same procedure for any other text that you
want to appear in charts.
Task 9: Adding a legend to a chart

% Create a pie chart as shown below.

Expenditure

@ Jan
EFeb
O Mar
OApr
| Mday
O Jun

% Display the Chart toolbar, by dropping down the view menu and
clicking Toolbars, Chart. In the above figure the legend is
already added.

% Click inside the pie chart, then click once on the add or delete
legend button on the Chart toolbar. The legend will be added if
not already present and removed if it is currently present.

‘ChartTitle vﬁilﬁvlﬁlml‘?«ﬁ @\

% You can also add or delete a legend from the Chart, Chart
options menu

Task 10: Adding gridlines to a chart
% Open cash3.xls worksheet and change chart type to Column
chart.
% Click Chart, Chart options to display this box.
% Click the Gridlines tab and tick the gridlines boxes required.
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Chart Wizard - Step 3 of 4 - Chart Options

Axes aridlines | Legend | Datalabels | Data Table

Chart kitle:
| Expenditure | Ezpenditure
Cakeqgory () axis; £00
|Ml:unth | — _
Yalue ) axis: . 0o O Houss: Hel
- aon 4 o Rent
| Sales | 5 O Electricity
200 41 O Power

| | 100 H

dan Feb Mar April May  Jun
| | Motk

[ Cancel ][ « Back “ Blext = ][ Einish ]

Task 11: Adding data labels to a chart
% Open cash3 worksheet and change chart type to pie chart.
% Drop-down the chart menu and click Chart options.
% Click on the Data Labels tab.
% Click on Show label and percent. Your screen should look
similar to this.

Chart Options

Titles || Legend | Data Labels

Label Cantains

|:| Series name Ezpenditure

|:| Category name

[] value 1%

Percentage =
| Fub
O Mar
O Apri

Separator: | May

O Jun

[ ] Legend key a

Show leader lines |

ok ][ Cancel ]
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Introducing Microsoft
PowerPoint 2010

Microsoft PowerPoint 2010 is a full-featured presentation program that helps you quickly
and efficiently develop dynamic, professional-looking presentations and then deliver
them to an audience. You can use PowerPoint to:

Introduce an idea, proposal, organization, product, or process with professionally
designed, high-impact slides.

Use themes, galleries of styles, and formatting options to achieve the right combi-
nation of colors, fonts, and effects.

Bolster your arguments by easily adding pictures, shapes, and fancy display text.

Convey numeric data in easy-to-grasp ways with styled tables or visually compelling
charts.

Use the SmartArt Graphics tool to create sophisticated diagrams that reflect pro-
cesses, hierarchies, and other relationships.

Create custom themes, designs, and layouts so that your presentations have a
unique look and feel.

Collaborate with colleagues, giving and receiving feedback to ensure the best
possible presentation.

PowerPoint 2010 builds on previous versions to provide powerful tools for all your pre-
sentation needs. This introduction provides an overview of new features that we explore
throughout the book.

New Features

If you're upgrading to PowerPoint 2010 from a previous version, you're probably most
interested in the differences between the old and new versions and how they will affect
you, as well as how to find out about them in the quickest possible way. The following
sections list new features you will want to be aware of, depending on the version

of PowerPoint you are upgrading from.
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If You Are Upgrading from PowerPoint 2007

If you have been using PowerPoint 2007, you might be wondering how Microsoft could
have improved on what seemed like a pretty comprehensive set of features and tools.
The list of new features includes the following:

® The Backstage view Finally, all the tools you need to work with your files, as
opposed to their content, really are accessible from one location. You display the
Backstage view by clicking the File tab, which replaces the Microsoft Office Button
at the left end of the ribbon.

® Customizable ribbon The logical next step in the evolution of the command cen-
ter introduced with PowerPoint 2007: Create your own tabs and groups to suit the
way you work.

® A window for each presentation You no longer display all presentations in the
same window, so you can arrange open presentations for easy comparison or
work on different presentations at the same time.

® Reading view This new way to preview presentations makes it easy to quickly
check the effect of one or two changes.

® Presentation videos Now turning a presentation into a Windows Media Video is
a simple matter of saving in that format.

® Paste preview No more trial and error when moving items to new locations.
Preview what an item will look like in each of the available formats, and then pick
the one you want.

® Animation Painter If you spend time developing a complex animation for one
object, you can now copy the animation settings to another object with a few
mouse clicks.

® New themes and transitions Adding pizzazz to your presentations is just a matter
of applying a professional-looking theme or a snazzy dynamic-content transition.

® Graphics editing Found the perfect picture, but its colors or style aren't quite right
for your presentation? Now after inserting a picture, you can edit it in new ways.
In addition to changing color, brightness, and contrast, you can remove the back-
ground and, most exciting of all, apply artistic effects that make it appear like a
watercolor, pencil drawing, or pastel sketch.
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Improved cropping Not only can you drag crop handles to manually crop a
picture but you can also apply a built-in cropping ratio and then move the crop-
ping "window" around over the picture until you get precisely the part you want.

Text effects WordArt has had a makeover. You can still use WordArt to create
distinctive headlines, but now you can use its effects on any selected text.

Screenshots You no longer need to go outside of PowerPoint when you want to
insert a screenshot into a slide. This capability is now built into Word.

Improved SmartArt Graphics tool A whole new category has been added to
SmartArt so that you can include pictures as well as text in your diagrams.

Video tools Found a perfect video, but it is too long to include in a presenta-
tion? Now you can insert the video and then use the video editing tools built into
PowerPoint to trim and format it. You can also insert a link to a video on a Web
site into a slide.

Version merging You can merge two versions of the same presentation and
accept or reject changes.

Team collaboration Team members can now work simultaneously on a presenta-
tion stored on a Microsoft SharePoint 2010 server or in Windows Live SkyDrive.

Broadcasting You can review a presentation with colleagues via the Web by work-
ing through a free broadcasting service. Your colleagues can view the presentation
in their Web browsers and give feedback via a conference call.

Language support If you need to conduct business internationally across language
lines, you can easily tailor the language of your working environment. You can also
use new translation tools to collaborate with team members in other countries.

Unsaved file recovery How many times have you responded No without thinking
to the "save changes" message when closing files, only to find that you have dis-
carded work you wanted to keep? PowerPoint now preserves your unsaved files
for a period of time, allowing you to recover them if you need them.
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If You Are Upgrading from PowerPoint 2003

In addition to the features listed in the previous section, if you're upgrading from
PowerPoint 2003, you'll want to take note of the new features that were introduced in
PowerPoint 2007. The 2007 upgrade provided a more efficient working environment
and included a long list of new and improved features, including the following:

The Microsoft Office Fluent Ribbon No more hunting through menus, submenus,
and dialog boxes. This new interface organizes all the commands most people use
most often, making them quickly accessible from tabs at the top of the program
window.

Live Preview See the effect of a style, theme, or other option before you apply it.

Custom layouts Easily create your own layouts with placeholders for specific
objects, and then save them for use in other presentations.

SmartArt Graphics tool Use this awesome new diagramming tool to create sophis-
ticated diagrams with 3-D shapes, transparency, drop shadows, and other effects.

Improved charting Enter data in a linked Microsoft Excel worksheet and watch as
your data is instantly plotted in the chart type of your choosing.

Slide libraries Share slide content with team members in a special SharePoint
library for presentations and slides.

Presentation cleanup Have PowerPoint check for and remove comments, hidden
text, and personal information stored as properties before you declare a presenta-
tion final.

New file format The new Microsoft Office Open XML Formats reduce file size and
help avoid loss of data.

Let's Get Started!

We've been working with PowerPoint since its debut, and each version has offered
something that made daily presentation creation a little easier. Microsoft PowerPoint
2010 is no exception, and we look forward to showing you around.
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The goal of the Microsoft Office 2010 working environment is to make working with
Office files—including Microsoft Word documents, Excel workbooks, PowerPoint pre-
sentations, Outlook e-mail messages, and Access databases—as intuitive as possible. You
work with an Office file and its contents by giving commands to the program in which
the document is open. All Office 2010 programs organize commands on a horizontal bar
called the ribbon, which appears across the top of each program window whether or not
there is an active document.

Ribbon tabs Ribbon groups

i |7 | Bookl - Microsaft Excel o e 2

A typical program window ribbon.

Commands are organized on task-specific tabs of the ribbon, and in feature-specific
groups on each tab. Commands generally take the form of buttons and lists. Some
appear in galleries. Some groups have related dialog boxes or task panes that contain
additional commands.

Throughout this book, we discuss the commands and ribbon elements associated with
the program feature being discussed. In this topic, we discuss the general appearance
of the ribbon, things that affect its appearance, and ways of locating commands that
aren't visible on compact views of the ribbon.

See Also For detailed information about the ribbon in Microsoft PowerPoint, see
“Working in the User Interface” in Chapter 1, “Explore PowerPoint 2010.”

Tip Some older commands no longer appear on the ribbon, but are still available in the
program. You can make these commands available by adding them to the Quick Access
Toolbar. For more information, see “"Customizing the Quick Access Toolbar” in Chapter 15,
“Customize PowerPoint.”
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Dynamic Ribbon Elements

The ribbon is dynamic, meaning that the appearance of commands on the ribbon
changes as the width of the ribbon changes. A command might be displayed on the
ribbon in the form of a large button, a small button, a small labeled button, or a list
entry. As the width of the ribbon decreases, the size, shape, and presence of buttons
on the ribbon adapt to the available space.

For example, when sufficient horizontal space is available, the buttons on the Review
tab of the Word program window are spread out and you're able to see more of the
commands available in each group.

Small labeled button

Drop-down list Large button
Mid?-0]s Dacument] « Microsoft Word of| & =
Home  dnser  Pegelsjout  Refespees  Malings | Review | View o @
2 &L Reseanchi a‘ &= ) Delete 4 : Show MaTkup | e 52 revlous E
% 35 Thesaurus ) S ol B Frevious -»2 Fow Markup = EH s 3 Next ]

Speling
Gramma

: e
425 Ward Court 5 3 omment B Hext ._A,, ces E Feviewing Fane -

Proofing Language Comments 2king hanges Compare

Compare | Elo
= it

The Review tab of the Word program window at 1024 pixels wide.

If you decrease the width of the ribbon, small button labels disappear and entire groups
of buttons hide under one button that represents the group. Click the group button to
display a list of the commands available in that group.

Group button Small unlabeled buttons
@“ =R RN N Documentl - Microzoft Word = = 53
Home Insert Pags Layout References Mailngs Review View ) e
ﬁ ﬂ & Q _-]' | / ‘{]_J Final: Show Markup - |_l' =-[j R
[ show Markup ~ ‘ﬁ‘
ﬁpellmg& Languagel Tra fecept| Compare Protect
Grammar n__:ll 3 Comment .J Changes 3 dE Reviewing Pane = - -
Proofing Camments Tracking Changes Compate il

The Review tab of the Word program window at 675 pixels wide.

When the window becomes too narrow to display all the groups, a scroll arrow appears
at its right end. Click the scroll arrow to display hidden groups.
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5 |+ Documentl - M. —~ [E =2

Hom | Insel | Page | Refe | Mail || Revii| Wiew & a

S| |w (B |2 (3

Proofing | Language| Comments Tracking Changes Compare +— Scroll arrow

-

Compare

The Review tab of the Word program window at 340 pixels wide.

Changing the Width of the Ribbon

The width of the ribbon is dependent on the horizontal space available to it, which
depends on these three factors:

® The width of the program window Maximizing the program window provides
the most space for ribbon elements. You can resize the program window by
clicking the button in its upper-right corner or by dragging the border of a
non-maximized window.
Tip On a computer running Windows 7, you can maximize the program window by
dragging its title bar to the top of the screen.

® Your screen resolution Screen resolution is the size of your screen display expressed
as pixels wide x pixels high. The greater the screen resolution, the greater the
amount of information that will fit on one screen. Your screen resolution options
are dependent on your monitor. At the time of writing, possible screen resolutions
range from 800 x 600 to 2048 x 1152. In the case of the ribbon, the greater the
number of pixels wide (the first number), the greater the number of buttons that
can be shown on the ribbon, and the larger those buttons can be.

On a computer running Windows 7, you can change your screen resolution from
the Screen Resolution window of Control Panel.
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(===
OU E.l < Display » Screen Resolution - | +5 | | Zeorch Control Panel F e |
Change the appearance of your displays
Identify
Display: 1. Viewsonic YX2235wm ¥
Resolution: 1680 = 1050 (recommended) v
Orientation: High
[ 1680 = 1050 {recommended)
huttiple displays:
1440 = 900
This is currently yo Advanced settings
IMake text and othel
What display setting
1280 = 300
ok | [ cancel Apply
960 « 600
800 = 600
Low

You set the resolution by dragging the pointer on the slider.

The density of your screen display You might not be aware that you can change
the magnification of everything that appears on your screen by changing the screen
magnification setting in Windows. Setting your screen magnification to 125% makes
text and user interface elements larger on screen. This increases the legibility of
information, but means that less fits onto each screen.

On a computer running Windows 7, you can change the screen magnification from
the Display window of Control Panel.



Modifying the Display of the Ribbon  xvii

mvlgl v Control Panel » Al Control Panellterns » Display - | +y I| Eearch Control Panel

Control Panel H s .
iiditlin s Make it easier to read what's on your screen

Adjust resclution You can change the size of text and other items on yeur screen by choosing one of these options. To
temporarily enlarge just part of the screen, use the Maanifier tool,
Adjust brightness
S!' Calibrats color
- : 0 Emaller - 100% (default) Preview
Change display s=ttings
Connect to a projector
Adjust ClearType test @ Medium - 125%

Set custom tet size (DPT)

See also

Personalization

/I, Some items may not fit on your screen if you choose this setting while your display Apply
Devices and Printers

is set to this resolution.

You can choose one of the standard display magnification options, or create another by
setting a custom text size.

The screen magnification is directly related to the density of the text elements on
screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms
are interchangeable, and in fact are both used in the Windows dialog box in which
you change the setting.) The greater the dpi, the larger the text and user interface
elements appear on screen. By default, Windows displays text and screen elements
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text
and screen elements to 120 dpi. You can choose a custom setting of up to 500%
magnification, or 480 dpi, in the Custom DPI Setting dialog box.

=

Custam DFI Setting ==

For a custom DPI setting, select a percentage from the list, or
drag the ruler with wour mouse,

Scale to this percentage of normal size; | 200% -
| ‘ | ‘ | |

|a |1

9 point Segoe Ul at 192 pixels
per inch.

| [ Use Windows 2P style DPT scaling [ QK ] [ Cancel ]

You can choose a magnification of up to 200% from the lists, or choose
a greater magnification by dragging across the ruler from left to right.
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See Also For more information about display settings, refer to Windows 7 Step by Step
(Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or Windows XP
Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and Joyce Cox.

Adapting Exercise Steps

The screen images shown in the exercises in this book were captured at a screen resolu-
tion of 1024 x 768, at 100% magnification, and the default text size (96 dpi). If any of
your settings are different, the ribbon on your screen might not look the same as the one
shown in the book. For example, you might see more or fewer buttons in each of the
groups, the buttons you see might be represented by larger or smaller icons than those
shown, or the group might be represented by a button that you click to display the
group’s commands.

When we instruct you to give a command from the ribbon in an exercise, we do it in this
format:

® On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, we give the instruction in this format:

® On the Page Layout tab, in the Page Setup group, click the Breaks button and
then, in the list, click Page.

The first time we instruct you to click a specific button in each exercise, we display an
image of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to
look different from the one shown in the book, you can easily adapt the steps to locate
the command. First, click the specified tab. Then locate the specified group. If a group
has been collapsed into a group list or group button, click the list or button to display
the group’s commands. Finally, look for a button that features the same icon in a larger
or smaller size than that shown in the book. If necessary, point to buttons in the group
to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you
read and work through the exercises in the book.



Features and Conventions
of This Book

This book has been designed to lead you step by step through all the tasks you're most
likely to want to perform in Microsoft PowerPoint 2010. If you start at the beginning
and work your way through all the exercises, you will gain enough proficiency to be
able to create and work with most types of PowerPoint presentations. However, each
topic is self contained. If you have worked with a previous version of PowerPoint, or if
you completed all the exercises and later need help remembering how to perform a
procedure, the following features of this book will help you locate specific information:

@ Detailed table of contents Search the listing of the topics and sidebars within
each chapter.

® Chapter thumb tabs Easily locate the beginning of the chapter you want.

® Topic-specific running heads Within a chapter, quickly locate the topic you
want by looking at the running heads at the top of odd-numbered pages.

® Glossary Look up the meaning of a word or the definition of a concept.

® Keyboard Shortcuts If you prefer to work from the keyboard rather than with
a mouse, find all the shortcuts in one place.

® Detailed index Look up specific tasks and features in the index, which has been
carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the Step by Step series
shows exercise instructions, keys to press, buttons to click, and other information.

Xix



XX

Features and Conventions of This Book

Convention

Meaning

SET UP

This paragraph preceding a step-by-step exercise indicates the prac-
tice files that you will use when working through the exercise. It also
indicates any requirements you should attend to or actions you should
take before beginning the exercise.

CLEAN UP

This paragraph following a step-by-step exercise provides instructions
for saving and closing open files or programs before moving on to an-
other topic. It also suggests ways to reverse any changes you made to
your computer while working through the exercise.

Blue numbered steps guide you through hands-on exercises in each
topic.

1
2
1
2

Black numbered steps guide you through procedures in sidebars and
expository text.

See Also

This paragraph directs you to more information about a topic in this
book or elsewhere.

Troubleshooting

This paragraph alerts you to a common problem and provides guid-
ance for fixing it.

Tip

This paragraph provides a helpful hint or shortcut that makes working
through a task easier.

Important

This paragraph points out information that you need to know to com-
plete a procedure.

Keyboard Shortcut

This paragraph provides information about an available keyboard
shortcut for the preceding task.

Ctrl+B

A plus sign (+) between two keys means that you must press those
keys at the same time. For example, “Press Ctrl+B” means that you
should hold down the Ctrl key while you press the B key.

]

Pictures of buttons appear in the margin the first time the button is
used in a chapter.

Black bold In exercises that begin with SET UP information, the names of program
elements, such as buttons, commands, windows, and dialog boxes,
as well as files, folders, or text that you interact with in the steps, are
shown in black, bold type.

Blue bold In exercises that begin with SET UP information, text that you should

type is shown in blue bold type.




Using the Practice Files

Before you can complete the exercises in this book, you need to copy the book’s practice

files to your computer. These practice files, and other information, can be downloaded

from the book’s detail page, located at:

http://go.microsoft.com/fwlink/?Linkid=192149

Display the detail page in your Web browser and follow the instructions for downloading

the files.

Important The Microsoft PowerPoint 2010 program is not available from this Web site. You

should purchase and install that program before using this book.

The following table lists the practice files for this book.

Chapter

File

Chapter 1:
Explore PowerPoint 2010

BuyingTrip_start.pptx
DesigningColor_start.pptx
MayMeeting_start.pptx
SalesMeetingMay_start.pptx

Chapter 2:
Work with Slides

Projects.pptx
ServiceA_start.pptx
ServiceB_start.pptx
ServiceC_start.pptx
ServiceD_start.pptx
ServiceOrientation.docx

Chapter 3:
Work with Slide Text

BuyingTripsB_start.pptx
BuyingTripsC_start.pptx
CommunityServiceA_start.pptx
CommunityServiceB_start.pptx
CommunityServiceC_start.pptx

Chapter 4:
Format Slides

BusinessTravelA_start.pptx
BusinessTravelB_start.pptx
ColorDesign_start.pptx
CompanyMeetingA_start.pptx
CompanyMeetingB_start.pptx
Landscaping_start.pptx
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Chapter File

Chapter 5: Agastache.jpg

Add Simple Visual JournalingA_start.pptx

Enhancements JournalingB_start.pptx
Penstemon.jpg
WaterConsumption.xIsx
WaterSavingA_start.pptx
WaterSavingB_start.pptx
WaterSavingC_start.pptx

Chapter 6: Harmony_start.pptx

Review and Deliver
Presentations

Meeting_start.pptx
SavingWater_start.pptx
ServiceOrientationA_start.pptx
ServiceOrientationB_start.pptx

YinYang.png

Chapter 7: FinancialMeeting_start.pptx

Add Tables NewEquipment.xlsx
Temperature_start.pptx
TemperatureFormatted_start.pptx

Chapter 8: GardenResidents_start.pptx

Fine-Tune Visual Elements

LandscapingChart_start.pptx
NativePlantl.jpg through NativePlant8.jpg
PhotoAlbumTitleSlide.pptx
ReorganizationMeeting_start.pptx

Chapter 9:
Add Other Enhancements

DesertPlants_start.pptx
MeetingAction_start.pptx
Organization_start.pptx
OrganizationLinks_start.pptx
Procedures.docx
TemperatureCelsius_start.pptx

Chapter 10:
Add Animation

NaturalGardeningA_start.pptx
NaturalGardeningB_start.pptx
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Chapter

File

Chapter 11:
Add Sound and Movies

AGKCottage_start.pptx
Amanda.wma

Bird.jpg

Butterfly.wmv
HealthyEcosystemsA_start.pptx
HealthyEcosystemsB_start.pptx
Wildlifewmv

Chapter 12:
Share and Review
Presentations

CottageShow_start.pptx
HarmonyReview_start.pptx
MeetingCompareA_start.pptx
MeetingCompareB_start.pptx
MeetingThemeA _start.pptx
MeetingThemeB.pptx
MeetingThemeC.pptx
ServiceProjects_start.pptx
WaterUse_start.pptx

Chapter 13:
Create Custom Presentation
Elements

NativePlantl.jpg through NativePlant3.jpg
NaturalLayout_start.pptx
NaturalMaster_start.pptx
NaturalTemplate_start.pptx

Chapter 14:
Prepare for Delivery

CottageVideo_start.pptx
JournalingTimings_start.pptx
OrganizationCD_start.pptx
Procedures.docx
ServiceShows_start.pptx

Chapter 15:
Customize PowerPoint

BuyersSeminar_start.pptx
ColorNew_start.pptx
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Your Companion eBook

The eBook edition of this book allows you to:

® Search the full text
® Print
® Copy and paste

To download your eBook, please see the instruction page at the back of this book.



Getting Help

Every effort has been made to ensure the accuracy of this book. If you do run into
problems, please contact the sources listed in the following sections.

Getting Help with This Book

If your question or issue concerns the content of this book or its practice files, please
first consult the book'’s errata page, which can be accessed at:

http://go.microsoft.com/fwlink/?Linkid=192149

This page provides information about known errors and corrections to the book. If
you do not find your answer on the errata page, send your question or comment to
Microsoft Press Technical Support at:

mspinput@microsoft.com

Getting Help with PowerPoint 2010

If your question is about Microsoft PowerPoint 2010, and not about the content of this
book, your first recourse is the PowerPoint Help system. This system is a combination of
tools and files stored on your computer when you installed PowerPoint and, if your com-
puter is connected to the Internet, information available from Office.com. You can find
general or specific Help information in the following ways:

® To find out about an item on the screen, you can display a ScreenTip. For example, to
display a ScreenTip for a button, point to the button without clicking it. The ScreenTip
gives the button’s name, the associated keyboard shortcut if there is one, and unless
you specify otherwise, a description of what the button does when you click it.

® In the PowerPoint program window, you can click the Microsoft PowerPoint Help
button (a question mark in a blue circle) at the right end of the ribbon to display
the PowerPoint Help window.

@ After opening a dialog box, you can click the Help button (also a question mark)
at the right end of the dialog box title bar to display the PowerPoint Help window.
Sometimes, topics related to the functions of that dialog box are already identified
in the window.
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To practice getting help, you can work through the following exercise.

» SET UP You don't need any practice files to complete this exercise. Start PowerPoint,
and then follow the steps.

(2] 1. At the right end of the ribbon, click the Microsoft PowerPoint Help button.

The PowerPoint Help window opens.

@ PowverPoint Help [ [=] 3
PR AN d
- P Search -
: HeI.Eande\'-m ~
ﬁao‘fﬁ-&g Search Support E bn".g’

Getting started with PowerPoint 2010

5 | = Getting started with PowerPaint 2010

‘ _ * Familiarize yourself with the ribbon
@ = Deliver a presentation on multiple

manitars

m

Browse PowerPoint 2010 support

= Importing content = YWarking with
= Organizing and animatian
formatting = Warking with charts
= ging masters = Warking with maovies
= Using templates = Wyarking with sounds Sl
see all
All PoweerPoint | | g-CDnnected to Office.com -

Your Help window might look different from this one because the
material on the Office.com Web site is constantly being updated.

Tip You can maximize the window or adjust its size by dragging the handle in the lower-
right corner. You can change the size of the font by clicking the Change Font Size button
on the toolbar.
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2. Below the bulleted list under Browse PowerPoint 2010 support, click see all.

The window changes to display a list of help topics.

In the list of topics, click Activating PowerPoint.

PowerPoint Help displays a list of topics related to activating Microsoft Office
programs. You can click any topic to display the corresponding information.

On the toolbar, click the Show Table of Contents button, and then scroll down
the pane that appears on the left.

Like the table of contents in a book, the Help table of contents is organized in sec-
tions. If you're connected to the Internet, PowerPoint displays sections, topics, and
training available from the Office Online Web site as well as those stored on your

computer.
) PowerPoint Help = =
(€ = (g () & AL @
= B Search ~
Tahle of Conterts X | PowerPoint 2010 Hom e > PowerPoint 2010 Helpand How-to
eview wour speaker notes privately, while deli i . . .
_..J b e - [~ > .
ewhat is & PowerPoint template? ﬂnOfﬁCG Search Support u bll"lg

ewhat is a slide layout?

ewhat i a slide master?

ewhat is a thame?

ewhat is Presenter View?

eDuplicate animations with the animation paint
e\-'idec-: See translations in PowerPaoint with th
echange of remove an animation effect

eBe Ribbon Hero {and have Fun daing it) B
echange ot delete header and Foater informat
@What‘s nst

@Installing |4
@Activating PowerPoint

@Getting help

@File rnanagemmenk

@/Getting starbed with PowerPoint

@Workjng with Eext

@/Spelling, grammar, and thesaurus

@Workjng with Eables

@Workjng with charts o
i r—rp— » |

Activating PowerPoint
Topics

Sictivate Microsoft Office programs

ARTICLE | The following infarmation is provided to help you £,

Sctivate wolume editions of Microsoft Office

ARTICLE | There are tweo types of activation methods for Micra...

Locate the Product ID for wour Office program

ARTICLE | The Product ID is specific to your Microsoft Office 2.,

All PowerPaint |

| 0 Coni‘uected to 01‘f|g%0_|'-nI

Clicking any section (represented by a book icon) displays that section’s topics (represented by

help icons).
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(€ 5. In the Table of Contents pane, click a few sections and topics. Then click the Back
(3 and Forward buttons to move among the topics you have already viewed.
E 6. At the right end of the Table of Contents title bar, click the Close button.

7. At the top of the PowerPoint Help window, click the Search box, type saving, and
then press the Enter key.

The PowerPoint Help window displays topics related to the word you typed.

&) PowerPoint Help = = =
CAREOM GME e B

saving * J Search ~

PowverPoint 2010 Hom e -

E,SOfﬁE'é' Search Support m bnng

Search results for: saving

A pack Mext P

Save A
ARTICLE | Select options inthe Sawe &3 dialog box ta sawve 3.,

Recover earlier versions of a file in Office 2010
ARTICLE | IE i now easier to recover a MicrosoftWword 2010..,

Autornatically save and recover Office files
ARTICLE | The AutoRecower feature is not a substitute far m..,

Save an Office file as an earlier version
ARTICLE | Ifyoud are using Microsoft Office 2010, you can 5.,

Sawe a3 POF or XP3
ARTICLE | Sornetimes you want £o save files 50 that they can..,
Determine whether a PowerPoint 2010 presentation is cornpatibl.,

ARTICLE | To ensure that you can open your Microsoft Powe..,

Sawve a file
ARTICLE | Wher wou save a file, you can save itto a folder 0.,

Al PowerPoint | | 0 Connected to Office.com

Next and Back buttons appear to make it easier to search for the topic you want.

Tip If you enter a term in the Search box and then click the adjacent Search arrow,
you specify the type of help you are looking for or where you want to look for it.
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8. In the results list, click the Recover earlier versions of a file in Office 2010 topic.
The selected topic appears in the PowerPoint Help window.
9. Below the title at the top of the topic, click Show All.

PowerPoint displays any hidden auxiliary information available in the topic and
changes the Show All button to Hide All. You can jump to related information by
clicking hyperlinks identified by blue text.

Tip You can click the Print button on the toolbar to print a topic. Only the displayed
information is printed.

CLEAN UP Click the Close button in the upper-right corner of the PowerPoint Help
window.

More Information

If your question is about Microsoft PowerPoint 2010 or another Microsoft software
product and you cannot find the answer in the product's Help system, please search
the appropriate product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the
Microsoft Knowledge Base are addressed by Microsoft Product Support Services.
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/
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8 Fine-Tune Visual
Elements

In this chapter, you will learn how to
v Edit pictures.
v/ Customize diagrams.
v Format charts.
v Arrange graphics.

In Chapter 5, "Add Simple Visual Enhancements,” you were introduced to the primary
ways you can use graphic elements to convey information or dress up your slides. You
inserted pictures and clip art images, created a diagram, plotted data in a chart, drew
shapes, and eased the transition from one slide to another with a graphic effect. These
simple techniques might be all you need to enhance your presentations. But if you
need to manipulate graphic elements to produce more dramatic effects, you can push
the Microsoft Office PowerPoint 2010 capabilities further to get just the result you are
looking for.

In this chapter, you'll create a photo album and insert and manipulate photographs.
Next, you'll manipulate shapes to customize an organization chart. Then you'll format a
chart and save it as a template. Finally, you'll use various techniques to arrange graphics.

Practice Files Before you can complete the exercises in this chapter, you need to copy
the book’s practice files to your computer. The practice files you'll use to complete the
exercises in this chapter are in the Chapter08 practice file folder. A complete list of
practice files is provided in “Using the Practice Files” at the beginning of this book.
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Editing Pictures

From time to time in this book, we have alluded to the modern trend away from slides
with bullet points and toward presentations that include more graphics. Successful
presenters have learned that most people can't listen to a presentation while they are
reading slides. So these presenters make sure most of their slides display graphics that
represent the point they are making, giving the audience something to look at while
they focus on what is being said.

PowerPoint 2010 gives you the tools you need to create graphic-intensive rather than
text-intensive presentations. When you want to display a dynamic array of pictures in
a presentation, you can use a photo album template to do the initial layout and then
customize the album by adding frames of different shapes, as well as captions.

Tip To integrate the slide layouts from a photo album template into a more traditional
presentation, create the photo album and then import its slides into the other presentation

by clicking Reuse Slides at the bottom of the New Slide gallery. For information about reusing
slides, see "Adding Slides with Ready-Made Content” in Chapter 2, “Work with Slides.”

After you insert any picture into a presentation, you can modify it by using the buttons
on the Format tab that is displayed on the ribbon only when the graphic is selected. For
example, you can do the following:

® Remove the background by clicking the Remove Background button and then
designating either the areas you want to keep or those you want to remove.

® Sharpen or soften the picture, or change its brightness or contrast, by choosing
the effect you want from the Corrections gallery.

® Enhance the picture’s color by making a selection from the Color gallery.

® Make one of the picture’s colors transparent by clicking Set Transparent Color at
the bottom of the gallery and then selecting the color.

® Choose an effect, such as Pencil Sketch or Paint Strokes, from the Artistic Effects
gallery.

® Apply effects such as shadows, reflections, and borders, or apply combinations
of these effects by choosing a predefined style from the Picture Styles gallery.

® Add a border consisting of one or more solid or dashed lines of whatever width
and color you choose.

® Rotate the picture to any angle, either by dragging the green rotating handle or
by clicking the Rotate button and then choosing a rotating or flipping option.

® Crop away the parts of the picture that you don't want to show on the slide.
(The picture itself is not altered—parts of it are simply covered up.)
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® Minimize the presentation’s file size by clicking the Compress Pictures button and
then choosing where or how the presentation will be viewed—for example, on
the Web or printed—to determine the optimum resolution. You can also delete
cropped areas of a picture to reduce file size.

In this exercise, you'll create a photo album displaying pictures of native plants. You'll
crop, resize, remove the background, apply an artistic effect, and add captions.
You'll also reuse a slide from another photo album, and apply a theme.

SET UP You need the NativePlantl through NativePlant8 photographs and the
PhotoAlbumTitleSlide presentation located in your Chapter08 practice file folder to
complete this exercise. Open a blank presentation, and then follow the steps.

1. On the Insert tab, in the Images group, click the Photo Album button.
The Photo Album dialog box opens.

2. Under Insert picture from, click File/Disk.
The Insert New Pictures dialog box opens.

3. Navigate to your Chapter08 practice file folder, click NativePlantl, hold down
the Ctrl key, and click NativePlant3 through NativePlant5. Then click Insert.

The Photo Album dialog box now has four graphics files listed in the Pictures In

Album list.
Photo Album ===
alburn Content
Insert picture from: Pictures in album: Prewview:
FileDisk. ., [1 MativePlant1 |
= 2 MativePlank3
Insert text: 3 MativePlants
4 MativePlants

Mew Text Box

Picture Cptions:
[l aptions below ALL pictures
[l aLL pictures black and white

G [ ] ey

Picture layaut; ' Fit ko slide E‘

- -—-F
>

Frame shape;  |Rectangle - | .

Theme: Browse, .. i

I Create |I Cancel ]

Album Lavout

You can click each picture in turn to view it in the Preview box.
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. In the Pictures in album list, click NativePlant4, and then click the Move Up

button to make it the second picture in the list.

. Preview the pictures in turn, and then click the Contrast and Brightness buttons

as necessary to give the four photographs a more even tone.

You could also adjust the rotation of a picture, but in this case, that is not necessary.

. In the Album Layout area, display the Picture layout list, and click 2 pictures.

. Display the Frame shape list, click Rounded Rectangle. Then click Create.

PowerPoint creates a presentation called Photo Album that contains a title slide
and two slides each containing two pictures.
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Click to add notes L.
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On the title slide, PowerPoint inserts the user name stored in the PowerPoint Options
dialog box.

Troubleshooting The appearance of buttons and groups on the ribbon changes
depending on the width of the program window. For information about changing the
appearance of the ribbon to match our screen images, see “Modifying the Display of
the Ribbon” at the beginning of this book.

Save the presentation as My Photo Album.

Display Slide 2, and click the photo on the left. Then on the Format contextual tab,
in the Size group, click the Crop arrow. In the list, point to Aspect Ratio, and then
under Portrait, click 2:3.
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PowerPoint crops away parts of the picture, leaving a centered “window" over the
photo, sized to the proportions you specified.

Cropping handles surround the active area so that if you want, you
can adjust the cropped areas.

Click the photo on the right, and then repeat the cropping process in step 9.

In turn, select each photo, and drag the upper-left and bottom-right corner
handles until the photos occupy the majority of the space on the slide.

Tip When sizing the photo on the right, release the mouse button when the dotted
guide appears, letting you know that the photo is aligned with the photo on the left.
Display slide 3, and crop the photo on the left to Square, 1:1. Then point inside
the crop window, and drag to the left until the cropping window is centered on
the flower.

PowerPoint maintains the size of the crop window but moves the photo under
the window to the left.

The image of the flower is centered in the crop window.
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Click the photo on the right, and in the Size group, use the down arrow to reduce
the height to 3”. Then crop the photo to Square, 1:1, adjusting the crop window
so that all of the flower is showing.

. Enlarge and align the photos so that they occupy the entire width of the slide.
. Click the left photo, and in the Adjust group, click the Remove Background

button.

The Background Removal contextual tab appears, and PowerPoint marks the
areas of the photo that will be removed.

RBllH9-0|- '
Background Remaowval Slide Show e

@& @ v

Mark Areas Mark Areas Delete | Discard All - Keep
to Keep  to Remowe  Mark Changes Changes

ST by Photo Alburm - Microsoft PowerPoint

Format

Refine | Close
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1

Photo & 1bum
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The thumbnail on the Slides tab shows what the flower will look like after its background
is removed.

. Drag the handles on the frame surrounding the flower until the entire flower is

visible within the frame. Then in the Close group, click the Keep Changes button.

Repeat steps 15 and 16 to remove the background of the photo on the right. Then
click a blank area of the slide.

The background is removed from both flower photos.
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The flowers stand out vividly against the plain slide background.

18. Click the photo on the left, and then on the Format tab, in the Adjust group, click
[@ e v] the Artistic Effects button.
The Artistic Effects gallery appears.

B, Artistic Effects Options..,

You can choose from a wide variety of effects in this gallery.
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Point to each thumbnail in turn to see a live preview of the photo with the
effect applied. Then click the third thumbnail in the second row (Paint Brush).

Repeat steps 18 and 19 for the photo on the right.
The two photos now resemble paintings.

On the Insert tab, in the Images group, click the Photo Album arrow, and then
click Edit Photo Album.

The Edit Photo Album dialog box opens. This dialog box is the same as the Photo
Album dialog box. With it, you can make changes to an existing photo album.

In the dialog box, under Picture Options, select the Captions below ALL pictures
check box, and then click Update.

Replace the file names below each photograph with the following captions:
NativePlantl Achillea

NativePlant4 Hedysarum

NativePlant3 Gaillardia

NativePlant5 Oenothera

Click slide 1, and on the Home tab, in the Slides group, click the New Slide arrow,
and at the bottom of the gallery, click Reuse Slides.

The Reuse Slides task pane opens.

In the Reuse Slides task pane, click Browse, and click Browse File. Then browse to
your Chapter08 practice file folder, and double-click the PhotoAlbumTitleSlide
presentation.

This presentation contains one slide that was based on a slide in the Contemporary
Photo Album template available under the Sample Templates on the New page of
the Backstage view.

In the Reuse Slides task pane, click Slide 1 to insert it after the title slide of the
My Photo Album presentation. Then close the task pane.

Delete the blank title slide. Then on the Design tab, in the Themes group, display
the Themes gallery, and select a theme that showcases the photos.

We chose the Trek theme.
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Careful theme selection can pull an entire presentation together.

x CLEAN UP Save the My Photo Album presentation, and then close it.

Customizing Diagrams

We've already told you how to use SmartArt to create a diagram, and we've shown
you how to move and size it and apply simple formatting. But many diagrams involve
different levels of information and benefit from more sophisticated formatting tech-
niques. After you create a basic diagram, you can customize it at any time by clicking
it and then using the commands on the Design and Format contextual tabs.

You can use the commands on the Design contextual tab to make changes such as
the following:
@ Add and change the hierarchy of shapes.

Tip You can remove a shape by selecting it and then pressing the Delete key.
You can also rearrange shapes by dragging them.
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® Switch to a different layout of the same type or a different type.

Tip If some of the text in the original diagram doesn't fit in the new layout, that text is not
shown, but it is retained so that you don't have to retype it if you change the layout again.
You can use the buttons on the Format contextual tab to customize individual shapes
in the following ways:

® Change an individual shape—for example, change a square to a star to make it
stand out.

® Apply a built-in Shape Style.
® Change the color, outline, or effect of a selected shape.

Tip If you customize a diagram and then decide you preferred the original version, you can
revert to the original by clicking the Reset Graphic button in the Reset group on the Design
contextual tab.

In this exercise, you'll customize an organization chart by adding subordinate shapes.
You'll change the layout of the chart as a whole and then change the color, size, and
text of individual shapes.

é SET UP You need the ReorganizationMeeting_start presentation located in your
Chapter08 practice file folder to complete this exercise. Open the Reorganization-
Meeting_start presentation, and save it as ReorganizationMeeting. Then follow
the steps.

1. Display slide 5, click the diagram to activate it, and then select the Ryan Danner
shape for manipulation.

2. On the Design contextual tab, in the Create Graphic group, click the Add Shape

arrow, and then click Add Shape Below.

PowerPoint adds a shape to the organization chart.

3. Open the Text pane, click to the right of the bullet symbol, type Jerry Orman,
and press Enter.

PowerPoint adds a duplicate shape at the same level in the hierarchy.

Type your text here 2 II Fl]
* Florian Stiller Stiller ‘

® Ryan Danner
|

® Jerry Orman
L
® Lukas Keler

® Erin Hagens

Organization Chart... i

The colors of the shapes in the diagram reflect the theme color scheme
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Troubleshooting Our instructions assume you are entering text in the Text pane. Typing
and pressing Enter in a diagram shape enters a new paragraph in the same shape instead
of creating a new shape.

4. Type Nate Sun.

5. In the Text pane, click to the right of Erin Hagens, press Enter, press Tab, and then
type Sarah Davis.

The new shape is a subordinate of Erin Hagens.

6. In the diagram, select the Florian Stiller shape for manipulation, click the Add
Shape arrow in the Create Graphic group, and then click Add Assistant.

7. In the Text pane, click to the right of the arrow bullet symbol, and type Andy
Ruth. Then close the Text pane.

8. In the diagram, select the Nate Sun shape for manipulation, and then in the

Create Graphic group, click the Promote button.

The selected shape moves up one level in the hierarchy.

Florian
Stiller

Nate Sun is now a peer of his former manager.

Troubleshooting Don't worry if your chart still shows the box and handles in the former
location of the Nate Sun shape. It will disappear when you work on a different shape.

9. Drag the handles around the frame of the diagram until it fills the available space
on the slide.

10. On the Design contextual tab, display the Layouts gallery, and point to each
thumbnail in turn to see a live preview of the various layout options for an organi-
zation chart. Then click the second thumbnail in the second row (Hierarchy).

Tip Some of the new PowerPoint 2010 layouts allow you to insert pictures of people
as well as their names.

11. Display the SmartArt Styles gallery, and after previewing the available styles,
under 3-D, click the last thumbnail in the first row (Cartoon).
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12. Andy Ruth is an assistant, not a manager, so select his background shape, and on
H the Format tab, in the Shape Styles group, click the Shape Fill arrow. Then under
Theme Colors in the palette that appears, click the tan box (Tan, Text 2).

13. Click the Florian Stiller shape (not the text), and then in the Shapes group, click

the Larger button three times.
Larger

Troubleshooting Be sure to click the border of the shape. Otherwise, you will select
the text for editing instead of the shape itself.

The background shape grows with the selected shape.

14. In the Shape Styles group, click the Shape Fill arrow, and then in the palette,
click the third box in the fifth column (Gray-50%, Accent 1, Lighter 40%)

15. Display the WordArt Styles gallery, explore the options, and then click the third
thumbnail in the first row (Fill - White, Drop Shadow).

The text in the shape is now a contrasting color.
16. Click outside the diagram frame.

You can now see the final result.

Organizational Overview

Stiller
Ryan ‘ l I Lukas
Danner b Keller

Orman

The number of employees that you want to include in an organization chart often determines
which layout you choose.

x CLEAN UP Save the ReorganizationMeeting presentation, and then close it.
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Formatting Charts

You already know how to plot data in simple charts and how to edit that data in the
associated Microsoft Excel worksheet. Often, you will need nothing more than these
basic techniques to be able to convey your numeric data in a visual format. However,
for those times when you need more than a basic chart, PowerPoint provides formatting
capabilities that enable you to produce just the effect you want.

If you decide that the type of chart you selected doesn't adequately depict the most
important characteristics of your data, you can change the type at any time. There are
11 chart types, each with two-dimensional and three-dimensional variations, and you
can customize each aspect of each variation. Common chart types include the following:

® Column charts Used to show how values change over time.

® Bar charts Used to show the values of several items at one point in time.
® Line graphs Used to show erratic changes in values over time.

® Pie charts Used to show how parts relate to the whole.

If you don't want to spend a lot of time on a chart, you can apply the predefined com-
binations of formatting from the Chart Layouts and Chart Styles groups on the Design
contextual tab to create sophisticated charts with a minimum of effort. However, if you
want more control over the appearance of your chart, you can use the options on the
Layout and Format contextual tabs. It is worth exploring these options so that you know
how to do the following:

® Add shapes and pictures.
Format individual elements such as titles, axes, data labels, and gridlines.
Add trend lines, bars, and other lines.
Customize the walls and floor or otherwise manipulate a three-dimensional chart.
Customize the look of shapes.

Add and format fancy text (WordArt).

Arrange objects precisely.
® Precisely control the overall size of the chart.

You can double-click almost any chart object to change its attributes. For example, you
can double-click an axis to display the Format Axis dialog box, where you can change
the scale, tick marks, label position, line style, and other aspects of the axis. If you have
trouble double-clicking some of the smaller chart elements, you can select the element
you want to format from the Chart Elements list in the Current Selection group on the
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Change
Chart Type

Format tab, and then click the Format Selection button in the same group to display the
Format dialog box for the selection.

If you make extensive modifications, you might want to save the customized chart as a
template so that you can use it for plotting similar data in the future without having to
repeat all the changes.

In this exercise, you'll modify the appearance of a chart by changing its chart type and
style. You'll change the color of the plot area and the color of two data series. You'll then
hide gridlines and change the layout to display titles and a datasheet. After adding an
annotation in a text box, you'll save the chart as a template.
SET UP You need the LandscapingChart_start presentation located in your Chapter08
practice file folder to complete this exercise. Open the LandscapingChart_start presen-
tation, and save it as LandscapingChart. Then follow the steps.

1. Display slide 14, and click the blank area above the chart legend to activate the

chart without selecting any of its elements.

Troubleshooting Be sure to click a blank area inside the chart frame. Clicking any of its
elements will activate that element, not the chart as a whole.

PowerPoint displays the Design, Layout, and Format contextual tabs.

2. On the Design contextual tab, in the Type group, click the Change Chart Type
button.

The Change Chart Type dialog box opens.
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Each chart category provides several different design options.



=

3.

4.

5.

Formatting Charts 209

In the gallery on the right, under Line, double-click the fourth thumbnail (Line
with Markers).

The column chart changes to a line chart, which depicts data by using colored lines
instead of columns.
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The temperature data plotted as a line chart.

In the Chart Styles group, click the More button.
The Chart Styles gallery appears.
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You can quickly switch to a different color scheme or data marker style.

In the gallery, click the last thumbnail in the fourth row (Style 32).

The lines are now thicker, and the data markers are three-dimensional.
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6. Move the pointer over the chart, and when a ScreenTip indicates you are
pointing to the plot area, click to select it.

The plot area is the area between the axes that contains the data markers.

|ﬁ | 7. On the Format contextual tab, in the Shape Styles group, click the Shape Fill
arrow, and then in the list, click More Fill Colors.

The Colors dialog box opens.
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When none of the theme or standard colors meets your needs, you can pick a color
in the Colors dialog box.

8. On the Standard page, click the pale yellow below and to the left of the center,
and then click OK.

The plot area is now a pale yellow shade to distinguish it from the rest of the chart.

Tip To change several aspects of the plot area, right-click the area and then click Format
Plot Area to open the Format Plot Area dialog box. You can then change the fill, border,
shadow, and 3-D format in one location.
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At the top of the Current Selection group, click the Chart Elements arrow, and
then in the list, click Series “Maximum”.

Tip If you have trouble selecting an element of the chart by clicking it, you can choose
it from the Chart Elements list.

An outline appears around the data points of the selected series.
In the Current Selection group, click the Format Selection button.

The Format Data Series dialog box opens.

Format Data Series ==
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You can change several aspects of the selected data series in this dialog box.

In the left pane, click Marker Fill, and on the Marker Fill page, click Solid Fill. In
the Fill Color area, click the Color button, and under Standard Colors, click the
first box (Dark Red).

In the left pane, click Line Color. Then on the Line Color page, click Solid line,
and change the color to the same dark red.
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13. Repeat step 12 for the marker line color, and then click Close.
The Maximum data series is now represented by the dark red color.

e 14. On the Layout tab, in the Axes group, click the Gridlines button, point to Primary
MJ Horizontal Gridlines, and then click None to remove the horizontal gridlines from
Gridlines the chart.

-

15. On the Design contextual tab, in the Chart Layouts group, click the More button.
The Chart Layouts gallery appears.
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You can quickly change the layout of the chart by selecting one of the predefined options.

16. In the gallery, click the first thumbnail in the second row (Layout 4).

The legend now appears below the chart.
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The plot area has expanded to occupy the area vacated by the legend.



Text
Box

-

Save As
Template

17.
18.

19.

20.

21.

22.

Formatting Charts 213

Tip When you don't have a lot of data, choosing a layout that includes a datasheet—a
table with all the values plotted in the chart—can clarify without adding clutter. In this
case, we have too much data to add a datasheet.

On the Layout contextual tab, in the Insert group, click the Text Box button.

Point below the chart title and above the July maximum temperature, and then
drag diagonally down and to the right until the text box stretches as far as the
December data.

Type Hot periods can last several days. Then select the text, and on the Home
tab, in the Font group, change the size to 10 points and the color to Red.

Click a blank area within the chart frame to release the text box selection.

You can now see the results.
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The annotated chart.

On the Design contextual tab, in the Type group, click the Save As Template
button.

The Save Chart Template dialog box opens and displays the contents of your Charts
folder, which is a subfolder of your Templates folder.

Troubleshooting If the Charts folder does not appear in the Address bar, navigate to
the AppData\Roaming\Microsoft\Templates\Charts folder under your user profile.

With the Charts folder displayed in the Address bar, type Temperature By
Month in the File name box, and then click Save.
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23. In the Type group, click the Change Chart Type button, and then in the left
pane of the Change Chart Type dialog box, click Templates. Then point to the
icon under My Templates in the left pane.

A ScreenTip identifies this template as the one you just created.
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In the future, you can click the custom template to create a chart with the same layout
and formatting.

Tip To delete a custom chart template, click Manage Templates in the lower-left corner
of the Change Chart Type dialog box, and then when Windows Explorer opens with
your Charts folder displayed, right-click the template and click Delete. Confirm that you
want to delete the template by clicking Yes, close Windows Explorer, and then close the
Change Chart Type dialog box.

24. Click Cancel to close the dialog box.

CLEAN UP If you don't want to keep the chart template, delete it by following the
directions in the preceding tip. Then save and close the LandscapingChart presentation.

Arranging Graphics

After inserting pictures or drawing shapes in the approximate locations you want them
on a slide, you can align them and change their stacking order by clicking the buttons in
the Arrange group on the Format contextual tab.
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Clicking the Align button gives you access to commands for aligning individual or
multiple graphics in several ways. For example, you can:

@ Align graphics vertically by the left or right edges or centerline, or horizontally
by the top or bottom edges or centerline.

® Distribute graphics evenly within their current space, either horizontally or
vertically.

@ Align graphics relative to the slide that contains them or to other selected objects.
@ Align graphics relative to a position on the slide.

@ Align graphics against gridlines and adjustable horizontal and vertical guides.

Tip If you added pictures to a slide by clicking the Picture button in the Images group on the
Insert tab, you can group them and then align and position them as a group the same way
you would group shapes. However, if you have added them by clicking the Insert Picture From
File button in a content placeholder, you cannot group them. For information about grouping
shapes, see "Drawing Shapes” in Chapter 5, “Add Simple Visual Enhancements.”

When graphics overlap each other, they are stacked. The stacking order is determined
by the order in which you inserted the graphic. You can change the stacking order by
selecting a graphic and then clicking the Bring Forward or Send Backward button to
move the graphic to the top or bottom of the stack. To move the selected graphic forward
in the stack one graphic at a time, click the Bring Forward arrow and then click Bring To
Front in the list; to move it backward, click Send To Back in the Send Backward list.

Tip If you can't select a graphic because it is covered by others in the stack, click the Selection
Pane button to display the Selection And Visibility task pane, and then select the graphic you
want from the Shapes On This Slide list.

In this exercise, you'll align graphics in various ways, change their stacking order, and
position them with the help of a grid and guidelines.

9 SET UP You need the GardenResidents_start presentation located in your Chapter08
practice file folder to complete this exercise. Open the GardenResidents_start presen-
tation, and save it as GardenResidents. Then follow the steps.

1. Onslide 1, select the three pictures.

2. On the Format contextual tab, in the Arrange group, click the Align button, and
then in the list, click Distribute Vertically.

=1
I-:|1r
=

The middle picture moves down so that it is the same distance below the left
picture as it is above the right picture.
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3. In the Arrange group, click the Align button, and then click Align Center.

The pictures are now stacked on top of each other.

Garden Residents

Sometimes graphics are completely hidden when they are stacked.

4. Click away from the stack, and then click the top picture.

5. In the Arrange group, click the Bring Forward arrow, and then click
[I} Bring Forward *] Bring to Front.

The top picture moves forward in the stack, obscuring the middle picture.

6. In the Arrange group, click the Selection Pane button.
[EI} Selection Pane

] The Selection And Visibility task pane opens.
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The top and middle pictures are designated as content placeholders because
they were inserted into placeholders.

In the task pane, under Shapes on this Slide, click Content Placeholder 10.
On the slide, the selection rectangle indicates that the middle picture is selected.
Close the Selection and Visibility task pane.

In the Arrange group, click the Bring Forward button.

The middle picture moves forward in the stacking order.

In the Arrange group, click the Align button, and then click View Gridlines.

A faint dotted grid appears on the slide.

Drag the selected cat picture to the right and down, so that its right and bottom
borders align with the first gridlines from the right and bottom edges of the slide.

Drag the crow picture so that its right and bottom borders align with the second
gridlines from the right and bottom edges of the slide.
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13. Drag the frog picture so that its right and bottom borders align with the third
gridline from the right and bottom edges of the slide.

The pictures are now evenly stacked and spaced.

Gridlines make it easier to precisely align multiple graphics.

14. In the Arrange group, click the Align button, and then click Grid Settings.
The Grid And Guides dialog box opens.

Gric and Guides

Snap ko
Snap objects to grid
[7] Snap objects ko other objecks

arid settings

Spacing; ; 0.033 |E| Inches

Display grid on screen

Guide setkings

[T pisplay drawing guides on screen

Display smart guides when shapes are aligned

’Set as Def_al,llt] £ [o]:4 ! [ Cancel ]

In this dialog box, you specify the size of the grid and other options.
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In the Grid settings area, clear the Display grid on screen check box.

In the Guide settings area, select the Display drawing guides on screen check
box, and then click OK.

The grid disappears, and vertical and horizontal guides span the slide.

Point to the vertical guide away from any text or objects, and drag it to the left,
releasing it when the accompanying ScreenTip reads 3.50. Then drag the horizontal
guide down until its ScreenTip reads 0.50.

Troubleshooting If you move an object on the slide instead of a guide, click the Undo
button, and then point outside the margins of the slide to drag the guide.

The ScreenTips show in inches how far each guide is from the 0 mark in the center
of the slide. As you drag, numbers are skipped because the Snap Objects To Grid
check box is selected in the Grid And Guides dialog box.

Tip The Snap Objects To Grid option snaps guides and graphics to an invisible grid. You
can turn off this option, and you can set the spacing of the grid in the Grid And Guides
dialog box.

Point to the selected frog picture, and drag it to the left until its left and bottom
borders align with the guides.

Select all the pictures. Then on the Format tab, in the Arrange group, click the
Align button, and in the list, click Distribute Horizontally.

Repeat step 19 to distribute the pictures vertically.

In the Arrange group, click the Align button, click Grid Settings, and in the Grid
and Guides dialog box, clear the Display drawing guides on screen check box.
Then click OK.

Click the shape behind the pictures, and drag the green rotating handle clockwise
until the shape stretches diagonally across the slide. Then drag the shape’s middle
sizing handles until it is almost as wide as the pictures.

With the shape still selected, in the Arrange group, click the Send Backward

[L:'] Send Backward|'] arrow, and click Send to Back.

e

24,

The shape now sits behind the slide title as well as the pictures.

On the View Shortcuts toolbar in the lower-right corner of the program window,
click the Reading View button.

You can now see what the slide will look like during presentation delivery.
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|E| PasverPaint Slide Show - [GardenResidents] - Microsoft PowerPoint

Garden Residents

Slide 1 of 1 | e G+ |@DEEe

The finished slide in Reading view.

x CLEAN UP Save the GardenResidents presentation, and then close it.

Alt Text

Alt (alternate) text is a title and description associated with a graphic object that

enables people with vision or other impairments to determine what the object is.
You can add alt text to your objects to improve the accessibility of presentations
that will be viewed on the screen without a presenter.

To associate alt text with an object:
1. Right—click the object, and click the corresponding Format command.
2. In the left pane of the Format dialog box, click Alt Text.
The Alt Text page is displayed.

3. Enter a title and a description for the graphic object, and then click Close.
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Key Points

A growing trend among presenters is to create graphic-intensive rather than text-
intensive presentations.

If you want to move beyond simple diagrams, you need to know how to
manipulate levels of text in shapes and how to format individual shapes as
well as the diagram as a whole.

With all the sophisticated chart formatting tools PowerPoint provides, it is
important to remember that to be effective, charts need to be simple enough
for people to grasp key trends at a glance.

Knowing how to manipulate graphics on a slide will help you position, align,
and stack them to get the effect you want.
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11 Add Sound and
Movies

In this chapter, you will learn how to
v Insert and play sounds.
v Insert and play videos.

A Microsoft PowerPoint presentation is usually created to convey a lot of information

in a short time. That information can be in the form of text, graphics, charts, and tables,
but it might also consist of audio content. And sometimes the best way to ensure that
your audience understands your message is to show a video. For example, if your com-
pany has developed a short advertising video, it makes more sense to include the video
in a presentation about marketing plans than to try and describe it with bullet points or
even pictures.

In this chapter, you'll insert a sound clip and a sound file and make various adjustments
to their settings. You'll also insert two video files, edit one of them, and format them both.

Practice Files Before you can complete the exercises in this chapter, you need to copy
the book’s practice files to your computer. The practice files you'll use to complete
the exercises in this chapter are in the Chapterll practice file folder. A complete list of
practice files is provided in “Using the Practice Files” at the beginning of this book.

Inserting and Playing Sounds

In “Adding Transitions” in Chapter 5, "Add Simple Visual Enhancements,” you added
sound to a slide transition. You can also insert the following types of sounds:

® Audio files You can insert an audio file—for example, a speech or interview—Dby
clicking the Audio button in the Media group on the Insert tab, and then selecting
the file.

263
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Sound clips You can insert a sound clip by clicking the Audio arrow in the Media
group on the Insert tab, and then clicking Clip Art Audio to display the Clip Art task
pane, where you can search for and select the sound you want. Clicking Find More
At Office.com at the bottom of the task pane takes you to the Office.com Web site,
where you can search for additional sounds.

See Also For information about using the Clip Art task pane, see “Inserting Pictures and
Clip Art Images” in Chapter 5, “Add Simple Visual Enhancements.”

Recorded sounds You can record a sound or narration and attach it to a slide, all

from within PowerPoint.

See Also For information about recording sounds, see the sidebar “Recording
Presentations” in Chapter 14, “Prepare for Delivery.”

After you add a sound object, it appears on the slide represented by an icon. When the
sound object is selected, a play bar appears below its icon with controls for playing the
sound, and PowerPoint adds Format and Playback contextual tabs to the ribbon. You
can change the icon as follows:

Drag the object to locate it anywhere on the slide.
Drag its sizing handles to make it larger or smaller.

Use commands on the Format tab to change its appearance, in much the same
way that you would format a picture.

Click the Change Picture button to replace the default icon with a picture.

You can modify the sound itself on the Playback tab, as follows:

Click the Trim Audio button in the Editing group to edit the sound so that only
part of it plays.

Specify Fade In and Fade Out settings to have the sound gradually increase and
decrease in volume.

Click the Volume button to adjust the volume to Low, Medium, or High, or to
mute the sound.

Specify whether the sound plays:
O Automatically when the slide appears.
O Only if you click its icon.
O Throughout the presentation.
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® Select the Hide During Show check box to make the sound object invisible while
the presentation is displayed in Reading view or Slide Show view.

® Select the Loop Until Stopped check box to have the sound play continuously until
you stop it.

® Select the Rewind After Playing check box to ensure that the sound starts from the
beginning each time it is played.

To play a sound, you must have a sound card and speakers installed. In Normal view, you
can test the sound associated with a slide by clicking its icon and then either clicking the
Play/Pause button on its play bar or clicking the Play button in the Preview group on the
Playback contextual tab.

In this exercise, you'll insert a sound clip into a slide, adjust the position of the sound
object, change its picture, and make various other adjustments to its settings. Then you'll
insert an audio file into another slide and make the file play continuously throughout a
presentation.

SET UP You need the HealthyEcosystemsA_start and AGKCottage_start presentations,
the Bird picture, and the Amanda audio file located in your Chapterll practice file
folder. Open the AGKCottage_start presentation, and save it as AGKCottage. Then
open the HealthyEcosystemsA_start presentation, and save it as HealthyEcosystemsA.
Be sure to turn on your computer’s speakers for this exercise. (If you do not have a
sound card and speakers, you can still follow the steps, but you won't be able to hear
the sound.) With HealthyEcosystemsA displayed on your screen, follow the steps.

1. On the Insert tab, in the Media group, click the Audio arrow, and then click Clip
Art Audio.
The Clip Art task pane opens, displaying thumbnails of common sound clips.

2. In the Search for box, type birds, and then click Go.
The task pane now displays thumbnails of bird calls.

3. Click any thumbnail, click the arrow that appears, and then click Preview/
Properties.
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The Preview/Properties dialog box for the sound clip you selected opens.

Previeu| ijropeﬁfés [ ]
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Type! Wave Sound
Resolution:

Size: 2409 KB
Created:
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Caption: Birds at dawn

Provided by:  iStockphobo

< Previols Re

Paths

=sh [ Mexk = I [EditKevwords...

File: Ci\UsersiSidney HigalAppDatalLocaliMicrosoft\Windows) Temporary Internet Files! Content. IESLFYSRW,
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When you display this dialog box, PowerPoint downloads and plays the sound clip.

Troubleshooting The sound clips available from Office.com change frequently, so
don’t worry if you don’t see the Birds At Dawn clip in your Clip Art task pane. Just use
a different clip.

4. Click Close to close the dialog box, and continue previewing sound clips.

. When you are ready, double-click a sound clip that you think is appropriate for the

slide, and then close the Clip Art task pane.

We chose Birds Singing. A small speaker icon representing the sound object
appears in the middle of the slide, along with a play bar. It is hard to see the icon
because it is on top of the picture.

. Drag the sound object to the upper-left corner of the slide.

The play bar moves with the sound object.
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The handles around the sound object indicate that you can resize it, just like any other object.

On the play bar, click the Play/Pause button to hear the sound.
The sound plays. Now let’s change the picture associated with the object.

With the sound object selected, on the Format contextual tab, in the Adjust
group, click the Change Picture button. Then in the Insert Picture dialog box,
double-click the Bird picture in your Chapterll practice file folder.

On the Playback contextual tab, in the Audio Options group, display the Start
list, and click Automatically. Then select the Loop until Stopped check box.

. On the View Shortcuts toolbar, click the Reading View button.

PowerPoint plays the sound clip.

. Move the pointer over the bird representing the sound object, and when the play

bar appears, click the Play/Pause button. Then press the Esc key to return to
Normal view.

Display the AGKCottage presentation, and view it in Reading view, pressing Esc
after a few slides.

This presentation would benefit from a “sound track.”
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With slide 1 displayed, on the Insert tab, in the Media group, click the Audio
button. Then in the Insert Audio dialog box, double-click the Amanda file in
your Chapterll practice file folder.

On the Playback tab, In the Audio Options group, display the Start list, and
then click Play across slides. Then select the Hide During Show and Loop until
Stopped check boxes.

Switch to Reading view.
The audio file plays while PowerPoint moves from slide to slide.

Press Esc to stop the presentation and return to Normal view.

x CLEAN UP Save and close the HealthyEcosystemsA and AGKCottage presentations.

Inserting and Playing Videos

In keeping with the trend toward more visual presentations, PowerPoint 2010 has new
video capabilities that broaden the range of videos you can use and what you can do
with them. You can insert the following types of movies in slides:

® Video files You can insert a digital video that has been saved as a file in one of

two ways: If a slide’s layout includes a content placeholder, you can click the Insert
Movie Clip button in the placeholder. You can also click the Video button in the
Media group on the Insert tab. Either way, the Insert Video dialog box opens so
that you can select the file.

Videos from Web sites For information, see the sidebar “Inserting Videos from
Web Sites” later in this chapter.

Clip art videos Clip art videos are animated graphics, rather than real videos.
Clicking the Video arrow in the Media group on the Insert tab and then clicking

Clip Art Video displays the Clip Art task pane, where you can search for and select
the clip you want. Clicking Find More At Office.com at the bottom of the task pane
takes you to the Microsoft Office Online Web site, where you can search for ad-
ditional clips. When you insert a clip art video, it appears as a picture on the slide,
and PowerPoint adds a Format contextual tab to the ribbon so that you can adjust
the way the picture looks. The clip moves only when you display the slide in Reading
view or Slide Show view, and you cannot adjust its action.

See Also For information about using the Clip Art task pane, see “Inserting Pictures and
Clip Art Images” in Chapter 5, “Add Simple Visual Enhancements.”
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Both video files and videos from Web sites appear on the slide as video objects that you
can size and move to meet your needs. When you select a video object, PowerPoint adds
Format and Playback contextual tabs to the ribbon. You can change the way the object
appears on the slide as follows:

® Drag the object to locate it anywhere on the slide.

® Drag its sizing handles to make it larger or smaller.

® Use commands on the Format tab to change its appearance, in much the same way
that you would format a picture.

You can modify the video itself on the Playback tab, as follows:

® Click the Trim Video button in the Editing group to edit the video so that only part
of it plays.

Tip You can find out the total playing time of a video by displaying the Trim Video
dialog box.

® Specify Fade In and Fade Out settings to have the video gradually appear and
disappear.

® Click the Volume button to adjust the volume to Low, Medium, or High, or to mute
the sound.

® Specify whether the video plays:
O Automatically when the slide appears.
O Only if you click the object.

® Select the Play Full Screen check box to have the video occupy the entire slide
space while playing.

® Select the Hide While Not Playing check box to make the video object invisible
while the presentation is displayed in Reading view or Slide Show view.

® Select the Loop Until Stopped check box to have the video play continuously until
you stop it.

® Select the Rewind After Playing check box to ensure that the video starts from the
beginning each time it is played.

In Normal view, you can test the video associated with a slide by clicking the video
object and then either clicking the Play/Pause button on its play bar or clicking the
Play button in the Preview group on the Playback contextual tab.

In this exercise, you'll insert two videos into a slide, adjust the size of their objects,
format the objects, and make various other adjustments to their settings.
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Q SET UP You need the HealthyEcosystemsB_start presentation and the Butterfly

@

]

and Wildlife video files located in your Chapterll practice file folder. Open the
HealthyEcosystemsB_start presentation, and save it as HealthyEcosystemsB. Then
follow the steps.

1. In the Slide pane, in the left content placeholder, click the Insert Media Clip
button.

2. In the Insert Video dialog box, double-click the Butterfly file in your Chapterll
practice file folder.

The video is inserted as an object in the content placeholder with a play bar below it.

,_}l.fr
o

Healthy Ecosystems
oClicktoadd text |

The play bar is similar to the one for a sound object.

3. On the play bar, click the Play/Pause button to watch the video.
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4. Repeat steps 1 through 3 to insert the Wildlife video in the right content place-
holder, and then play the video.

Let’s trim this video so that it shows only the animal that looks like a big ground
squirrel.

5. With the Wildlife video selected, on the Playback contextual tab, in the Editing
group, click the Trim Video button.

The Trim Video dialog box opens.

oo el [ -
oo B pp] s
End Time

Start: Time

| Ok IL Cancel ‘I

You can advance through the video frame by frame to identify the start and end times.

6. Drag the green start marker to the right until it sits at about the 00:17.020 mark.
@ Then click the Next Frame button, pausing after each click, until the first ground
squirrel frame comes into view at the 00:17.288 mark.
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Drag the red stop marker to the left until it sits at about the 00:20.900 mark. Then
click the Next Frame button, pausing after each click, until the last ground squirrel
frame comes into view at the 00:20.799 mark.

Click OK. Then play the trimmed video.

Click the Butterfly video object, and on the Format tab, in the Size group, click
the Height arrow until the object is 3 inches tall.

The width of the object increases proportionally. Let's make the Wildlife object the
same size.

Click the Wildlife object, and in the Size group, change its Height to 3.
Because this video object is now too wide, we need to crop it from the left.

Right-click the object, and click Format Video. Then in the Format Video dialog
box, click the Crop tab.

The settings on this page take the trial-and-error out of any cropping task.

\Forf‘h'at'\ﬁdgo'
Border Color Cl’Op
Border Style Pickure pasition
H A width:  [5.33' 2] Height  [+.28" |2
Reflection Cffseb ¥ 0" = Offset ¥ 0" =

Glaw and Soft Edges Crop position

30 Format “hidth; 15,33 Height: |3

4l | |40k

J5 |

Left: .5-.63.” Top: fé.Sé"

3-D Rakation
Yidea
i- Crop
Size
Position

Alk Texk

Close. |

The Crop page of the Format Video dialog box.

In the Crop position area, change the Width setting to 4”. Then click Close.
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. Drag the objects until they are evenly spaced on the slide, using the Align com-
mands in the Arrange group as necessary to line them up.

. With both objects selected, click the More button in the Video Styles group.
The Video Styles gallery appears.
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You can select a frame for the video from this gallery.

Tip In addition to formatting a video with a ready-made video style, you can choose
from the Video Shape, Video Border, and Video Effects galleries to create your own
combinations. Just be careful not to overdo it.

. Under Intense, click the fifth thumbnail in the first row (Reflected Bevel, Black).
Then click away from the objects.
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You can now see the results.

,_;{fr
o
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The two video objects have rounded frames and reflections.

16. Click the Butterfly object, and on the Playback contextual tab, in the Video
h Options group, click the Volume button, and then click Mute.

17. In the Video Options group, display the Start list, and click Automatically. Then
Walume select the Loop until Stopped check box.

18. Click the Wildlife object, set Volume to Mute, leave Start set to On Click, and
select the Loop until Stopped check box.

19. Switch to Reading view, and preview and pause the Butterfly video. Then preview
and pause the Wildlife video.

20. Press Esc twice to return to Normal view.

x CLEAN UP Close the HealthyEcosystemsB presentation without saving your changes.
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Inserting Videos from Web Sites

If you find a video on a public Web site that you want to use to illustrate a point in
a presentation, you might be able to insert a link to the video into a slide. The for-
mat of the video must be supported by Windows Media Player, and the owner of
the video must have made it available to the public. You can tell which videos are
publicly available by right-clicking the video and looking for a Copy Embed HTML
command. If you do not see this command, the owner has secured the video, and
you cannot play it from anywhere but the site on which it is published.

To insert a link to a video on a Web site:

1. Display the video, right-click it, and then click Copy Embed HTML.
2. Display the slide into which you want to insert the video.

3. On the Insert tab, in the Media group, click the Video arrow, and then click
Video From Web Site.

The Insert Video From Web Site dialog box opens.

4. In the dialog box, click in the text box, and then press Ctrl+V (the keyboard
shortcut for the Paste command).

The copied embed code is inserted at the cursor.

Tnsert Wideo From Web Site @

Toinsett a link to a video you've uploaded to a Web site, copy the embed code Ffrom that Web site and
paste it into the text box below:

<object width="640" height="385"= <param name="movie"

walue="http: ffinana, yautube, comfvi4-94JRLEIND2color1=0xb1b1b 1 &ealor 2=0xd0d0d0
#hl=en_lU5&feature=player _embedded&fs=1"><fparam=<param name="allowFull5creen”
walue="true" = <fparar = <param name="allawscriptAccess” value="always" = < /param > <embed
sre="http:/ fraw, voutube, comfvi4-94 JhLEMNO2color 1 =0xb1b1bl rolor2=0:xd0d0d0
ahl=en_U5efeature=plaver_embeddedafs=1" type="application/x-shackwave-Flash"
allowfullscreen="true" allowScriptAccess="always" width="640" height="385"= = /embed></nbjsct:]|

Help and examples

Insert ][ Cancel ]

A link to a video available from YouTube.
5. Click OK.

To view the video, switch to Reading view or Slide Show view, and then click the
Play/Pause button. PowerPoint then uses the embed code to locate and play the
video. Provided the video remains available in its original location, and provided
you have an active Internet connection, you will be able to access and play the
video from the slide at any time.
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Introducing Microsoft Access 2010

Microsoft Access 2010 is a powerful relational database program that includes hundreds
of tools you can use to quickly start tracking, sharing, and reporting information, even
if you are new to database development. Users have access to a large library of profes-
sionally designed templates; wizards that automatically create tables, forms, queries,
and reports; and extensive local and online help resources.

Access supports sharing data with other sources, including other Microsoft Office 2010
programs, Microsoft SQL Server, Windows SharePoint Services, and documents in XML,
HTML, XPS, and PDF formats. Advanced features allow you to create sophisticated executable
database applications that your employees and customers can use to gather and view
data without needing to know anything at all about database design or development.

This book gives you straightforward instructions for using Access to create databases.
It takes you from knowing little or nothing about Access—or, for that matter, about
databases—to a level of expertise that will enable you to create complex databases
for use by one person or by many people.

New Features

If you're upgrading to Access 2010 from a previous version, you're probably more
interested in the differences between the old and new versions and how they will
affect you than you are in the basic functionality of Access. To help you identify the
entire scope of changes from the version of Access you're familiar with, we've listed
here the new features introduced in Access 2010, as well as in Access 2007.
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If You Are Upgrading from Access 2007

If you have been using Access 2007, you might be wondering how Microsoft could have
improved on what seemed like a pretty comprehensive set of features and tools. In addition
to enhancing many of the new features introduced with Access 2007, Access 2010 includes
the following new features:

The Backstage view Finally, all the tools you need to work with your files, as opposed
to their content, really are accessible from one location. You display the Backstage
view by clicking the File tab, which replaces the Microsoft Office Button at the left
end of the ribbon.

Customizable ribbon The logical next step in the evolution of the command
center introduced with Access 2007: Create your own tabs and groups to suit
the way you work.

Unifying themes Adding pizzazz to database objects such as forms and reports is
just a matter of applying a professional-looking theme from a gallery of options.

Web capabilities Companies that have employees and clients in different geographic
locations can publish databases to Access Services, thereby making those databases
accessible over the Internet in a Web browser.

Navigation forms Offering the sophisticated browsing techniques people are accus-
tomed to using on Web sites, these new forms provide an essential navigation tool
for Web databases, and can also increase the usability of non-Web databases.

New database templates Getting started with the creation of common types of
databases has never been easier. The databases that come with Access are supple-
mented by those made available by a community of database developers through
Microsoft Office Online.

Application parts You can now add predefined database objects to an existing
database. In addition to 10 types of forms, several Quick Start parts are available.
For example, adding the Contacts part adds one table and associated queries,
forms, and reports.

Enhanced Layout view and layout controls It is now easier to make design changes
in Layout view while actively viewing the underlying data.

Enhanced Expression Builder The layout of the Expression Builder dialog box has
been refined to make building an expression more intuitive. In addition, a feature
called IntelliSense has been incorporated to display options based on what you
type and to provide syntax guidance.
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Improved conditional formatting You can now use data bars to add at-a-glance
insight into the data in Number fields.

Ability to export to PDF and XPS files When you want to make a report or other
database object available to people but don’t want them to be able to manipulate
it, you can export the object in either PDF or XPS format. You can optimize the file
size for printing or publishing online.

If You Are Upgrading from Access 2003

Access 2010 builds on Access 2007, which introduced a long list of new and improved
features that made it easier than ever to create databases to track, share, manage, and
audit information, including the following:

The ribbon The new user interface organizes the most common commands for
any database object into tabs and groups so that the appropriate commands are
immediately accessible for the current object.

Quick Access Toolbar Customize a portion of the toolbar to include commands
you regularly use, regardless of which object is currently active.

Navigation pane The customizable Navigation pane replaces the Database window
from Access 2003. You can display or hide all tables, queries, forms, reports, macros,
and modules, or create a custom group that displays only the objects you want to
work with at the moment. You can even hide the Navigation pane to make more
room on the screen for your database object.

View Shortcuts toolbar This context-sensitive toolbar at the lower-right corner of
the program window provides single-click switching among the supported views
of the current database object. Quickly switch between Datasheet view, Design
view, PivotTable view, PivotChart view, Form view, Layout view, Report view, and
other views appropriate to the current object.

Tabbed documents Open multiple database objects and switch between them
quickly by clicking tabs on a tab bar.

Template library Quickly locate and download professionally designed templates
for common database projects.

Improved sorting and filtering Easily sort all records in a table based on one or
more fields, or filter a table or form to display or hide records matching multiple
criteria.
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Layout view Redesign a form or report while viewing it.

Stacked and Tabular layouts Group controls in a form or report layout so you
can easily manipulate the entire group as one unit.

Automatic calendar The Date/Time data type includes an optional calendar
control. Click the calendar, and select the date you want.

Rich Text Memo fields now support most common formatting options, including
fonts, color, and character formatting. The formatting is stored with the database.

Create tab Quickly create a new table, form, query, report, macro, SharePoint list,
or other Access object.

Totals function Add a totals row to a query, and select from a list of formulas to
automatically calculate aggregate values for forms and reports.

Field List Drag and drop fields from one or more related or unrelated tables onto
your active table.

Attachment data type Attach photos and other files to a database record.

Embedded macros Macros embedded in a form or report offer a higher level
of security in database applications.

Microsoft Access Help Easily search end-user and developer help content from
within Access.

Improved information sharing Easily import and export data between Access and
other Office applications or XML, HTML, PDF, and dBase files; collect information
through e-mail surveys in Microsoft Office Outlook and automatically update your
database with the responses; create or link a database with a SharePoint list; or pub-
lish your database to a SharePoint library and allow users to update and extract
information.

Improved report design Quickly create a professional-looking report, complete with
logo, header, and footer; and use Report view, combined with filters, to browse only
selected records in the report.

Group, Sort, and Total pane This feature makes it much easier to group and sort
data in reports, and add totals from a drop-down list.

Enhanced security Adding password protection to a database now causes Access
to automatically encrypt the database when it closes, and decrypt it when it
opens.
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Let's Get Started!

There are so many new and improved features to this already feature-rich program
that there are bound to be some exciting discoveries for even the most advanced users.
If you are new to Access, you will find many automated features that let you painlessly
create databases and add queries, forms, and professional-looking reports to track and
share your data. We look forward to showing you around Microsoft Access 2010.
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Modifying the Display of the Ribbon

The goal of the Microsoft Office 2010 working environment is to make working with Office
files—including Microsoft Word documents, Excel workbooks, PowerPoint presentations,
Outlook e-mail messages, and Access databases—as intuitive as possible. You work with

an Office file and its contents by giving commands to the program in which the docu-
ment is open. All Office 2010 programs organize commands on a horizontal bar called

the ribbon, which appears across the top of each program window whether or not there

is an active document.

Ribbon tabs Ribbon groups
- Boold - Microsoft Ewcel o @
| ome | dnseet view | N
B calibd Genezal E ) }:_l %1’ .‘fi
i = i - 5ol Find &
ns g B oA = B s wse | - 2% 258
Clipboord 5 Lot : Aspnanert A Humber Editing )

A typical program window ribbon.

Commands are organized on task-specific tabs of the ribbon, and in feature-specific
groups on each tab. Commands generally take the form of buttons and lists. Some appear
in galleries in which you can choose from among multiple options. Some groups have
related dialog boxes or task panes that contain additional commands.

Throughout this book, we discuss the commands and ribbon elements associated with
the program feature being discussed. In this section, we discuss the general appearance
of the ribbon, things that affect its appearance, and ways of locating commands that
aren't visible on compact views of the ribbon.

See Also For detailed information about the ribbon in Microsoft Access, see “Working
in Access 2010” in Chapter 1, “Explore an Access 2010 Database.”

Tip Some older commands no longer appear on the ribbon, but are still available in the
program. You can make these commands available by adding them to the Quick Access
Toolbar. For more information, see “Customizing the Quick Access Toolbar” in Chapter 13,
"Customize Access.”

Xv
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Dynamic Ribbon Elements

The ribbon is dynamic, meaning that the appearance of commands on the ribbon
changes as the width of the ribbon changes. A command might be displayed on the
ribbon in the form of a large button, a small button, a small labeled button, or a list
entry. As the width of the ribbon decreases, the size, shape, and presence of buttons
on the ribbon adapt to the available space.

For example, when sufficient horizontal space is available, the buttons on the Review
tab of the Word program window are spread out and you're able to see more of the
commands available in each group.

Drop-down list  Small labeled button Large button

WiE2-0 = Document |- Microsoft Woed

Home Triedt Fage Loyt Referendes Madlings Review o
B Receaich o - Wil Diedete - =h B | o Sk ek ~ 1 of &5 Previow: =
% ;au | 3#) 'F_ I £l Detete D D Finet Show Markus W )V_?l )P..uol.\l ;J
& 5 1] B rreviows | = |3 shiow Markup = = =1 ek —r
SPGB | Transimte Langusge e ! Track o Atcept Heject Compare
Grammar g3 Word Coant = o Comment T Ned Changes = 18] Reviewing Pane - = = =

The Review tab of the Word program window at 1024 pixels wide.
If you decrease the width of the ribbon, small button labels disappear and entire groups

of buttons are hidden under one button that represents the group. Click the group button
to display a list of the commands available in that group.

Group button Small unlabeled buttons
@“ o= Documentl - Microzoft Word = & 53
Home Insert Pags Layout References Mailngs Review View () e

g - [ B3 Finak Show Markup | B - = -
v S s [mg B3 o] 3 2
(%) o | = = show markup - = |
Spelling & . |language|  Mew »: Track i . Campare Protect
Grammar {23 o Comment = Changes = ;]E Reviewing Pane ~ > - x
Proofing | Comments Tracking Changes Compare

Accept

The Review tab of the Word program window at 675 pixels wide.



Modifying the Display of the Ribbon  xvii

When the window becomes too narrow to display all the groups, a scroll arrow appears
at its right end. Click the scroll arrow to display hidden groups.

j |= Documentl -M. o ®m =

Hom | Insei - Page | Refe | Mail || Revii| View < a

Proofing | Language Comments Tracking Changes Compare

-

T Scroll arrow

Compare

The Review tab of the Word program window at 340 pixels wide.

Changing the Width of the Ribbon

The width of the ribbon is dependent on the horizontal space available to it, which
depends on these three factors:

® The width of the program window Maximizing the program window provides
the most space for ribbon elements. You can resize the program window by
clicking the button in its upper-right corner or by dragging the border of a
non-maximized window.

On a computer running Windows 7, you can maximize the program window by
dragging its title bar to the top of the screen.

@ Your screen resolution Screen resolution is the amount of information your screen
displays, expressed as pixels wide by pixels high. The greater the screen resolution, the
greater the amount of information that will fit on one screen. Your screen resolution
options are dependent on your monitor. At the time of writing, possible screen reso-
lutions range from 800 x 600 to 2048 x 1152. In the case of the ribbon, the greater
the number of pixels wide (the first number), the greater the number of buttons that
can be shown on the ribbon, and the larger those buttons can be.
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On a computer running Windows 7, you can change your screen resolution from
the Screen Resolution window of Control Panel.

P

{ '?U = IEJ < Dis_p:i?y v Screen Fesolution - |_¢’ | | Feﬂﬁ Conﬁfof I"D_ﬂel’ }3|
Change the appearance of your displays
m
@ % -
Display: 1. Viewsonic YX2235wm ¥
Resolution: 1680 = 1050 (recommended) v'
Orientation: High
[ 1680 = 1050 {recommended)
huttiple displays:
1440 = 900
This is currently yo Advanced settings
IMake text and othel
What display setting
1280 = 300
Ok ] [ Cancel || Apply
960 « 600
800 = 600
Low

You set the resolution by dragging the pointer on the slider.

The density of your screen display You might not be aware that you can change the

magpnification of everything that appears on your screen by changing the screen mag-
nification setting in Windows. Setting your screen magnification to 125% makes text

and user interface elements larger on screen. This increases the legibility of informa-

tion, but it means that less information fits onto each screen.

On a computer running Windows 7, you can change the screen magnification from
the Display window of Control Panel.

See Also For more information about display settings, refer to Windows 7 Step by Step
(Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or Windows
XP Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and Joyce Cox.
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Control Panel H 8 T :
i s i Make it easier to read what's on your screen

temporarily enlarge just part of the screen, use the Maagnifier tool,
Adjust brightness

Calibrate color

(=]

@ Smaller - 100% (defa Previ
Change display szttings - ot etk i

Connect to a projector
Adjust ClearType text @ Medium - 125%

Set custom test size (DPT)

See also
Personalization

Drevices and Printers is set to this resolution.

%v'ﬂ!l v Contral Panel » All Control Panellterns » Display - | +y I| Eearch Control Panel

I\, Someitems may not fit on your screen if you choose this setting while your display

Adjust resclution You can change the size of text and other items on your screen by choosing one of these options. To

You can choose one of the standard display magnification options or create another by setting

a custom text size.

The screen magnification is directly related to the density of the text elements on

screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms
are interchangeable, and in fact are both used in the Windows dialog box in which
you change the setting.) The greater the dpi, the larger the text and user interface

elements appear on screen. By default, Windows displays text and screen elements
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text and
screen elements to 120 dpi. You can choose a custom setting of up to 500 percent

magnification, or 480 dpi, in the Custom DPI Setting dialog box.

Custom DP Setting =

For a custom DFI setting, select a percentage from the lisk, or
drag the ruler with wour mouse,

Scale to this percentage of normal size; | 200% -
| ‘ | ‘ | ‘

] |1

9 point Segoe Ul at 192 pixels
per inch.

|| Use Windows 5P style DPT scaling [ QK ] [ Cancel ]

You can choose a magnification of up to 200 percent from the lists, or choose a greater

magnification by dragging the ruler from left to right.
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Adapting Exercise Steps

The screen images shown in the exercises in this book were captured at a screen reso-
lution of 1024 x 768, at 100% magnification, and with the default text size (96 dpi).
If any of your settings are different, the ribbon on your screen might not look the same
as the one shown in the book. For example, you might see more or fewer buttons in
each of the groups, the buttons you see might be represented by larger or smaller
icons than those shown, or the group might be represented by a button that you
click to display the group’s commands.

When we instruct you to give a command from the ribbon in an exercise, we do it in
this format:

® On the Insert tab, in the lllustrations group, click the Chart button.

If the command is in a list, we give the instruction in this format:

® On the Page Layout tab, in the Page Setup group, click the Breaks button
and then, in the list, click Page.

The first time we instruct you to click a specific button in each exercise, we display
an image of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to
not appear as shown in the book, you can easily adapt the steps to locate the command.
First, click the specified tab. Then locate the specified group. If a group has been collapsed
into a group list or group button, click the list or button to display the group’s commands.
Finally, look for a button that features the same icon in a larger or smaller size than that
shown in the book. If necessary, point to buttons in the group to display their names in
ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you
read and work through the exercises in the book.



Features and Conventions
of This Book

This book has been designed to lead you step by step through all the tasks you're
most likely to want to perform in Microsoft Access 2010. If you start at the beginning
and work your way through all the exercises, you will gain enough proficiency to be
able to manage complex databases through Access. However, each topic is self con-
tained. If you have worked with a previous version of Access, or if you completed all
the exercises and later need help remembering how to perform a procedure, the
following features of this book will help you locate specific information:

Detailed table of contents Scan the listing of the topics and sidebars within
each chapter.

Chapter thumb tabs Easily locate the beginning of each chapter by looking
at the colored blocks on the odd-numbered pages.

Topic-specific running heads Within a chapter, quickly locate a topic by looking
at the running heads at the top of odd-numbered pages.

Glossary Look up the meaning of a word or the definition of a concept.

Keyboard Shortcuts If you prefer to work from the keyboard rather than with
a mouse, find all the shortcuts in one place.

Detailed index Look up specific tasks and features in the index, which has been
carefully crafted with the reader in mind.

xxi



xxii

Features and Conventions of This Book

You can save time when reading this book by understanding how the Step by Step series
shows exercise instructions, keys to press, buttons to click, and other information. These
conventions are listed in the following table.

Convention Meaning

SET UP This paragraph preceding a step-by-step exercise indicates the practice
files that you will use when working through the exercise. It also indicates
any requirements you should attend to or actions you should take before
beginning the exercise.

CLEAN UP This paragraph following a step-by-step exercise provides instructions
for saving and closing open files or programs before moving on to
another topic. It also suggests ways to reverse any changes you made
to your computer while working through the exercise.

1 Numbered steps guide you through hands-on exercises in each topic,
2 as well as procedures in sidebars and expository text.
See Also This paragraph directs you to more information about a topic in this

book or elsewhere.

Troubleshooting  This paragraph alerts you to a common problem and provides guidance
for fixing it.

Tip This paragraph provides a helpful hint or shortcut that makes working
through a task easier.

Important This paragraph points out information that you need to know to
complete a procedure.

Keyboard Shortcut This paragraph provides information about an available keyboard
shortcut for the preceding task.

Ctrl+B A plus sign (+) between two keys means that you must press those
keys at the same time. For example, “Press Ctrl+B” means that you
should hold down the Ctrl key while you press the B key.

|Q Pictures of buttons appear in the margin the first time the button is
used in an exercise.

Bold In exercises that begin with SET UP information, bold type displays
text that you should type; the names of program elements, such as
buttons, commands, windows, and dialog boxes; and files, folders, or
text that you interact with in the steps.




Using the Practice Files

Before you can complete the exercises in this book, you need to copy the book's practice
files to your computer. These practice files, and other information, can be downloaded

from the book’s detail page, located at:

http://go.microsoft.com/fwlink/?Linkid=192153

Display the detail page in your Web browser and follow the instructions for downloading

the files.

Important The Microsoft Access 2010 program is not available from this Web site. You should
purchase and install that program before using this book.

The following table lists the practice files for this book.

Chapter

File

Chapter 1:
Explore an Access 2010 Database

GardenCompany01_start.accdb

Chapter 2:

Create Databases and Simple Tables

None

Chapter 3: GardenCompany03_start.accdb
Create Slmple Forms Logo'png

Chapter 4: GardenCompany04_start.accdb
Display Data

Chapter 5: GardenCompany05_start.accdb
Create Simple Reports

Chapter 6: GardenCompany06_start.accdb
Maintain Data Integrity

Chapter 7: GardenCompany07_start.accdb
Create Custom Forms Hydrangeas.jpg

Chapter 8: GardenCompany08_start.accdb
Create Queries

Chapter 9: GardenCompany09_start.accdb

Create Custom Reports

(continued)
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Chapter

File

Chapter 10:
Import and Export Data

Customers.xlsx

Employees.txt
GardenCompany10_start.accdb
ProductsAndSuppliers.accdb
Shippers.xlsx

Chapter 11:
Make Databases User Friendly

GardenCompanyll_start.accdb
Icon.ico

Logo.png

Chapter 12:
Protect Databases

GardenCompanyl2_start.accdb

Chapter 13:
Customize Access

GardenCompanyl13_start.accdb

Your Companion eBook

The eBook edition of this book allows you to:

® Search the full text
® Print

® Copy and paste

To download your eBook, please see the instruction page at the back of this book.



Getting Help

Every effort has been made to ensure the accuracy of this book. If you do run into
problems, please contact the sources listed in the following sections.

Getting Help with This Book

If your question or issue concerns the content of this book or its practice files, please
first consult the book'’s errata page, which can be accessed at:

http://go.microsoft.com/fwlink/?Linkid=192153

This page provides information about known errors and corrections to the book. If
you do not find your answer on the errata page, send your question or comment to
Microsoft Press Technical Support at:

mspinput@microsoft.com

Getting Help with Access 2010

If your question is about Microsoft Access 2010, and not about the content of this book,
your first recourse is the Access Help system. This system is a combination of tools and
files stored on your computer when you installed Access and, if your computer is con-
nected to the Internet, information available from the Microsoft Office Online Web site.
You can find general or specific Help information in the following ways:

® To find out about an item on the screen, you can display a ScreenTip. For example, to
display a ScreenTip for a button, point to the button without clicking it. The ScreenTip
gives the button’s name, the associated keyboard shortcut if there is one, and some-
times a description of what the button does when you click it.

® In the Access program window, you can click the Microsoft Access Help button (a
guestion mark in a blue circle) at the right end of the ribbon to display the Access
Help window.

@ At the right end of the title bars of some dialog boxes is a Help button (also a question
mark) that you can click to display the Access Help window. Sometimes, topics related
to the functions of that dialog box are already identified in the window.

XXV
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To practice getting help, you can work through the following exercise.

» SET UP You don't need any practice files to complete this exercise. Start Access,
and then follow the steps.

(7] 1. At the right end of the ribbon, click the Microsoft Access Help button.

The Access Help window opens.

) Sccess Help = =] 33
CORAR BME K [
» P Search -
__I-EIP_and}-bw-m |
éé_OfﬁEwé— Search Support @ t:urjg

dowenloads | images | ternplates

Recommended
Build an Access database to share on the Weh
Article

Create-a newr desktop database
Article

Introduction to the &ccess 2010 templates
Article

What and where is the Backstage view
Article

Getting started with Access 2010

| | = Getting started with Access 2010
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All Aecess | | @) Connected to Office.com -

Your Help window might look different from this one because the material on the
Office Online Web site is constantly being updated.

Tip You can maximize the window or adjust its size by dragging the handle in the
lower-right corner. You can change the size of the font by clicking the Change Font
Size button on the toolbar.

2. Toward the bottom of the window, below the bulleted list under Browse Access
2010 support, click see all.
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Troubleshooting The See All link is available only if the Search option is set to one of
the Content From Office.com choices. If your Search option is set to one of the Content
From This Computer choices, the complete list is already displayed. To switch among the
available Search options, click the Search arrow and then click your choice in the list.

The window changes to display a list of help topics.
In the list of topics, click Activating Access.

Access Help displays a list of topics related to activating Microsoft Office programs.
You can click any topic to display the corresponding information.

On the toolbar, click the Show Table of Contents button, and then scroll down
the pane that appears on the left.

Like the table of contents in a book, the Help table of contents is organized in
sections. If you're connected to the Internet and the Search option is set to one of
the Content From Office.com choices, Access displays sections, topics, and training
available from the Office Online Web site as well as the Help information stored on
your computer.
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Clicking any section (represented by a book icon) displays that section’s topics
(represented by help icons).
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5. In the Table of Contents pane, click a few sections and topics. Then click the
(€] (3 Back and Forward buttons to move among the topics you have already viewed.
E 6. At the right end of the Table of Contents title bar, click the Close button.

7. At the top of the Access Help window, click the Search box, type relationships,
and then press the Enter key.

The Access Help window displays topics related to the word you typed.

) Access Help = [EOE
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) -

All Access |
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Next and Back buttons appear below the search term to make it easier to search
for the topic you want.

Tip If you enter a term in the Search box and then click the adjacent Search arrow,
you can specify the type of help you are looking for or where you want to look for it.
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8. In the results list, click the Guide to table relationships topic.
The selected topic appears in the Access Help window.
9. Below the first paragraph of the topic, click Database design basics.

Access jumps to the related topic about database design. This type of hyperlink is
identified by blue text. You might also see a Show All button that displays hidden
auxiliary information available in the topic. (The button changes to Hide All when
the hidden information is displayed.)

Tip You can click the Print button on the toolbar to print a topic. Only the displayed
information is printed.

CLEAN UP Click the Close button in the upper-right corner of the Access Help
window.

More Information

If your question is about Access 2010 or another Microsoft software product and you
cannot find the answer in the product’s Help system, please search the appropriate
product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the
Microsoft Knowledge Base are addressed by Microsoft Product Support Services.
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/
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2 Create Databases
and Simple Tables

In this chapter, you will learn how to

Create databases from templates.
Create databases and tables manually.
Manipulate table columns and rows.
Refine table structure.

SRS XXX X

Create relationships between tables.

Creating the container for a database is easy. But an empty database is no more useful
than an empty document or worksheet. It is only when you fill a database with data in
tables (known as populating a database) that it starts to serve a purpose. As you add
forms, queries, and reports, it becomes a useful tool. If you customize it by adding a
startup page and organizing the various objects into categories and groups, it moves
into the realm of being a database application.

Not every database has to be refined to the point that it can be classified as an application.
Databases that only you or a few experienced database users will work with can remain
fairly simple. But if you expect someone without database knowledge to enter data or
generate their own reports, spending a little extra time in the beginning to create a solid
foundation will save a lot of work later. Otherwise, you'll find yourself continually repairing
damaged files or walking people through seemingly easy tasks.

Microsoft Access 2010 takes a lot of the difficult and mundane work out of creating and
customizing a database by providing database applications in the form of templates that
you modify and populate with your own information. Access 2010 also provides templates
for common elements that you might want to plug into a database. These application
parts consist of sets of objects—a table and related forms, queries, or reports—that
together provide a complete, functioning part of a database. All you have to do is fill in
your data. If none of the templates meet your needs, you can create tables manually.
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In this chapter, you'll create a database from a template and create a table manually.
Then you'll adjust the display of a data table to fit your needs. By the end of this chapter,
you'll have a database containing a few tables and you'll understand a bit about how
the tables in the databases you will use for the exercises in the remaining chapters of the
book were created.

Practice Files You don't need any practice files to complete the exercises in this chapter.
For more information about practice file requirements, see “Using the Practice Files” at
the beginning of this book.

Creating Databases from Templates

A few years ago (the distant past, in computer time), creating a database structure involved
first analyzing your needs and then laying out the database design on paper. You would
decide what information you needed to track and how to store it in the database. Creating
the database structure could be a lot of work, and after you created it and entered data,
making changes could be difficult. Templates have changed this process, and committing
yourself to a particular database structure is no longer the big decision it once was.

A template is a pattern that you use to create a specific type of database. Access 2010
comes with templates for several databases typically used in business and education, and
when you are connected to the Internet, many more are available from the Microsoft
Office Online Web site at office.microsoft.com. By using pre-packaged templates, you
can create a database application in far less time than it used to take to sketch the
design on paper, because someone has already done the design work for you.

Using an Access template might not produce exactly the database application you want,
but it can quickly create something that you can customize to fit your needs. However, you
can customize a database only if you know how to manipulate its basic building blocks:
tables, forms, queries, and reports. Due to the complexity of these templates, you probably
shouldn’t try to modify them until you're comfortable working with database objects in
Design view and Layout view. By the time you finish this book, you will know enough to be
able to confidently work with the sophisticated pre-packaged application templates that
come with Access.

In this exercise, you'll create a database application based on the Tasks template. This
template is typical of those provided with Microsoft Access 2010, in that it looks nice
and demonstrates a lot of the neat things you can do in a database.
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6 SET UP You don't need any practice files to complete this exercise. Close any open
databases, and then with the New page of the Backstage view displayed, follow

the steps.

1.

In the Available Templates area, click Sample Templates.

Access displays a list of the templates that shipped with the program and are

installed on your computer.

Click the Tasks template icon.

In the right pane, you can assign a name to the database and browse to the location

where you want to store the database.

@“ HY-M-|s Microsaft Access
Home Create  External Data Database Tools
& save

) Available Templates
Bl Save Objectas
)+ k
@] save Databiase A3 2 Home Sample templates

[ Open

[ Close Databiase

[
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2 GardenCompanyll..

]
Info

Studernts

aladay

L,

Recent

Print

Save & Publish

Help

] Options

B et

4] | I

.{.

o BEOER

. =@

Tasks

File Marne

|Tasksl

| &

ChlsershSidney HigahDocumentsh,

[

The Tasks template is supplied with Access.

In the File Name box, type MyTasks.

Tip Naming conventions for Access database files follow those for Windows files. File
names cannot contain the following characters:\ /:*? “ < > |. By default, file name
extensions are hidden, and you shouldn’t type the extension in the File Name box.
(The extension for an Access 2010 database file is .accdb. For information about this
file format, which was introduced with Access 2007, search for accdb in Access Help.)
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& 4. Click the adjacent Browse button, and then in the File New Database dialog box,
navigate to your Chapter02 practice file folder.

You use the same navigational techniques in this dialog box that you would use in
any Open or Save dialog box.

[l s me e
[A] File Mew Database
@@ﬂ |« Access20105BS » Chapterl? b ~ | 49 ||| Search Chapterz Pl
Organize Mew folder f - @
& Downloads =+ Marne . Date rrodified Type

Gl Recent Places

- Libraries
|=_§| Docurments
J" husic
[ Pictures

B videos

1% Carnputer
&, Local Disk (T2

 RECOVERY (D) o = :
I o e o oo
File name:  MyTasks -
Save as type: ’Microsoﬁ Access 2007 Databases vl
(% Hide Falders Tools = [ Open ] ’ Cancel ]

The File New Database dialog box.

5. With Microsoft Access 2007 Databases selected in the Save as type box,
click OK.

The path to the specified folder is displayed below the File Name box.

Tip By default, Access creates new databases in your Documents folder. You can change
the location when you create each database, as you did here, or you can change the
default save folder. To specify a different default folder, click the File tab to display
the Backstage view, click Options, and then on the General page of the Access Options
dialog box, under Creating Databases, click the Browse button to the right of Default
Database Folder. In the Default Database Path dialog box, browse to the folder you
want to be the default, and then click OK in each of the open dialog boxes.
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Creating Databases from Templates

Click the Create button.

Access briefly displays a progress bar, and then the new database opens, with the
Task List form displayed in Layout view.

Tip Below the form name is a toolbar with commands created by embedded macros.
These commands are an example of what makes this a database application rather
than a simple database. The topic of macros is beyond the scope of this book. For
information, search for macros in Access Help.

If the Navigation pane is closed, click the Shutter Bar Open button at the right
end of its title bar to open it. Then if any of the groups are collapsed, click their
chevrons to open them.

The Navigation pane displays a custom Tasks Navigation category.
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The custom category has custom Tasks, Contacts, and Supporting Objects groups.

Troubleshooting The appearance of buttons and groups on the ribbon changes depending
on the width of the program window. For information about changing the appearance of

the ribbon to match our screen images, see “Modifying the Display of the Ribbon" at t
beginning of this book.

he
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12.
13.

In the Navigation pane, click the Tasks Navigation title bar, and then in the
category and group list, click Object Type to list all the objects in this database.

In the Tables group, double-click Contacts.

The empty Contacts table is displayed. You could now start entering data in this
table.

. Right-click the Contacts tab, and click Close All.
. On the Create tab of the ribbon, in the Templates group, click the Application

Parts button.
The Application Parts gallery appears.

Blank Forms
1 Right 1Tap 2 Right 2Top
Details Dialog List hMedia
v__| = ___
iy 1
Msghox Tahs
Quick Start |
| 8= E [
carmments Contacts Issues Tasks
Users

The Application Parts gallery.

You can add various types of forms and several sets of related tables and other
database objects to this or any other database. These ready-made objects give
you a jump start on creating a fully functional database application.

Click away from the gallery to close it.

Continue exploring the objects that are part of the MyTasks database on
your own.

x CLEAN UP Close the MyTasks database.
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Web Databases

Several of the templates in the Sample Templates gallery and many of the templates
available from the Microsoft Office Online Web site are designated as Web data-
bases. A Web database is one that is compatible with the new Web publishing
capabilities of Access 2010.

If Access Services are installed on your organization’s Microsoft SharePoint server,
you can now publish a database to Access Services. Publishing converts tables to

SharePoint lists stored on the server and makes it possible to work with the data-
base either in Access or in a Web browser.

You can create a Web database based on a Web template or build a new one from
scratch by choosing Blank Web Database on the New page of the Backstage view.
You can also publish a regular database as a Web database, although the tables in
the database must conform to Web database requirements for publication to be
successful. Because of these requirements, if you work for an organization where
future deployment of Access Services is a possibility, you might want to consider
creating a Web database to ensure that your database can be published to Access
Services in the future.

In a Web database, you can create two kinds of objects:

® Web objects These can be created and viewed in either a Web browser
or Access.

® Non-Web objects These can be created and viewed only in Access.

When you are working with a Web database from a browser, you are working with
the database on the server. When you are working with it from Access, you are
working with a local copy of the database that is synchronized with the database
on the server. For both types of objects, you can make design changes only in
Access and only when connected to the server.

These days, more and more companies have employees and clients in different
geographic locations, and more and more people are working away from company
offices. Web databases make it possible for people to access company databases
from wherever they are and from any computer, whether or not it has Access
installed.
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Creating Databases and Tables Manually

Suppose you need to store different types of information for different types of people.
For example, you might want to maintain information about employees, customers, and
suppliers. In addition to the standard information—such as names, addresses, and phone
numbers—you might want to track these other kinds of information:

® Employee identification numbers, hire dates, marital status, deductions, and pay rates
® Customer orders and account status
® Supplier contacts, current order status, and discounts

You could start with a template, add fields for all the different items of information to

a single Contacts table, and then fill in only the relevant fields for each type of contact.
However, cramming all this information into one table would soon get pretty messy. It's
better to create a new database based on the Blank Database template and then manu-
ally create separate tables for each type of contact: employee, customer, and supplier.

When you create a new blank database or insert a new table into an existing database,
the table is displayed on a tabbed page in Datasheet view with one empty row that is

ready to receive data. Because the active object is a table, Access adds the Table Tools
contextual tabs to the ribbon so that you can work with the table.

| el ) - - |5 Databasel: Databaze (fecess 2007 - Mic., e 1o o = 5
File Haome Create External Diata Database Tools Fields Table & @
A sne | #F vame & caption L Modify Lookups -
AB Al > &
J— = M i Default Walue S Modify Expression ing 3
Wig Text  Mumber Currency =t Field
- Ei oo Field Size ab| Memo Settings $ % * %0 400 | Validation
Wigs Add & Delete Properties Formatting
| All Access Objects ® « || =] Tabter’| X
[searcn. = D - | Click to Add  ~
| Tables 2| * (New)
H Tablet
| e - _— _— —
|| Record: 4 lofl bl % Mo Filter | Search |
Datasheet \iew num Lok |[E] &

A new table in a new database.
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If you close the table at this point, it will disappear, because it contains no data and it has
no structure. The simplest way to make the table part of the database is to create at least
one record by entering data, which simultaneously defines the table’s structure.

Tip You can also define the structure of the table without entering data. For information about
table structure, see “Refining Table Structure” later in this chapter. For information about
adding new blank fields to a table, see “Restricting the Type of Data” in Chapter 6, “Maintain
Data Integrity.”

Obviously, to create a record, you need to know how to enter information in Datasheet view.

=] Tablel |
10 - |Click to Add -~
#* (New) Field waiting for data
Primary key

Record selector, displaying New icon

The first record in a new table, before data is entered.

Every table has an empty row that is ready to receive a new record, as indicated by the New
icon (the asterisk) in the record selector at the left end of the row. By default, the first field
in each new table is an ID field designed to contain an entry that will uniquely identify the
record. Also by default, this field is designated as the table’s primary key. No two records

in this table can have the same value in this primary key field. Behind the scenes, the data
type of this field is set to AutoNumber, so Access will enter a sequential number in this
field for you.

Tip Asyou’ll see in a later exercise, the primary key field does not have to be the default
AutoNumber type. If you need to you create your own primary key field, then anything
meaningful and unique will work.

See Also For information about data types, see “Refining Table Structure” later in this chapter.

The first field you need to be concerned about is the active field labeled Click To Add.
You enter the first item of information for the new record in the first cell in this field,
and then press the Tab or Enter key to move to the first cell in the field to the right.
Access then assigns the value 1 to the ID field, assigns the name Fieldl to the second
field, and moves the Click To Add label to the third field. The icon in the record selector
at the left end of the record changes to two dots and a pencil to indicate that this
record has not yet been saved, and the New icon moves to the record selector of the
next row.
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= Tablel |

1D - Fieldl -~ |ClicktoAdd ~
N4 1 Sidney
* | [MNew)

The first record in a new table, after data has been entered in the first field.

When creating a new table in Datasheet view, you need to save the first record after
entering the first item of data. If you don't, Access increments the ID value for each field
you add to that record. For example, if you add seven fields, Access assigns the value 7 to
the ID field of the first record. To avoid this problem, you simply click the icon in the record
selector after you enter your first value in the first record. This saves the record with the
value 1 assigned to the ID field, and subsequent records will be numbered sequentially.

Having entered the first item of data and saved the record, you continue entering items
of information in consecutive cells and pressing Tab or Enter. When you finish entering the
last item for the first record, you click anywhere in the row below to tell Access that the
record is complete.

After you complete the first record of a new table, you will probably want to change the
default field names to something more meaningful. To rename a field, you simply double-
click its field name and then type the name you want.

At any time while you are entering data in a new table, you can save the table by clicking
the Save button on the Quick Access Toolbar and naming the table. If you try to close the
table without explicitly saving it, Access prompts you to save the table. If you click No,
Access discards the table and any data you have entered.

After you have saved the table for the first time, Access automatically saves each record
when you move away from it. You don't have to worry about losing your changes, but you
do have to remember that most data entries can be undone only by editing the record.

Databases almost always contain more than one table. You can create additional empty
tables by clicking the Table button in the Tables group on the Create tab of the ribbon.
If you need to create a table that is similar in structure to an existing one, you can copy
and paste the existing table to create a new one. When you paste the table, Access gives
you the option of naming the table and of specifying whether you want the new table to
have the existing table's structure or both its structure and its data.
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For some kinds of tables, Access provides Quick Start fields that you can use to add
common sets of fields or kinds of fields to a table. The Quick Start options take the
work out of defining these fields and can be very useful when you know exactly what
type of field you need.

In this exercise, you'll create a blank database, enter information into the first record of
its default table, assign field names, add another record, and save and close the table.
Then you'll copy that table to create a second one. Finally, you'll create a new table and
experiment with Quick Start fields.

SET UP You don't need any practice files to complete this exercise. Close any open
databases, and then with the New page of the Backstage view displayed, follow
the steps.

1. In the center pane of the New page, in the Available Templates area, click Blank
Database.

2. In the right pane, click the File Name box, and type MyTables. Then click the
Browse button, navigate to your Chapter02 practice file folder, and click OK.

Tip You can’t create a blank database without saving it. If you don't provide a file name
and location, Access saves the file with the name Database followed by a sequential
number in the default location (your Documents folder, unless you have changed it).

3. In the right pane, click the Create button.

Access creates the blank database in the specified location, opens the database,
and displays a new blank table named Tablel.

4. With the empty field below Click to Add selected, type Scott, and then press Tab
to move to the next field.

The icon in the record selector changes to indicate that this record has not yet
been saved. The value 1 appears in the ID field, the name of the second column
changes to Fieldl, and the Click To Add label moves to the third column.

5. Click the icon in the record selector to save the record before you move on.

Tip Clicking the record selector is necessary only after you enter the first value in a
new table. This action sets the ID field value to 1.




56

Chapter 2 Create Databases and Simple Tables

6. Click the cell under Click to Add, and type the following information into the next

seven cells, pressing Tab after each entry:
Gode
612 E. 2nd
Pocatello
ID
73204
USA
208 555-0161

As the cursor moves to the next cell, the name of the field in which you just entered
data changes to Field followed by a sequential number.

ID | Fleldl ~-| Fleld2 -| Field3 -| Fieldd -| Fields -
1 Scott Gode 612E.2nd  Pocatello 1D 73204 USA 208 555-0161

* (New)

Fields ~-| Field7 ~-| Fields

The first complete record.

Tip Don't be concerned if your screen does not look exactly like ours. In this graphic,
we've scrolled the page and adjusted the widths of the columns so that you can see all
the fields. For information about adjusting columns, see “Manipulating Table Columns
and Rows” later in this chapter.

. Double-click the ID field name (not the ID value in Field5), and then type

CustomerlD to rename it.

Tip Field names can include spaces, but the spaces can affect how queries have to be
constructed, so it is best not to include them. For readability, capitalize each word and
then remove the spaces, or use underscores instead of spaces.

. Repeat step 7 for the other fields, changing the field names to the following:

Fieldl1 FirstName Field4 City Field7 Country
Field2 LastName Field5 State Field8 Phone
Field3 Street Fieldé6 ZIP

The table now has intuitive field names.
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11.

12.

. Add another record containing the following field values to the table, pressing Tab
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T Tablel 53
CustomerlD ~ | FirstName - [LastName - | Street - | City - | State ~| ZIP ~| Country ~| Phone
1 Scott Gode 612 E. 2nd Pocatelio 1D 73204 USA 208 555-0161
* (New)

The renamed fields.

Tip Again, don't worry if your screen doesn’t look exactly like this graphic, because
we've made adjustments so that you can see all the fields.

to move from field to field:

FirstName John City Montreal Country Canada
LastName Frederickson State Quebec Phone 514 555-0167
Street 43 rue St. Laurent  ZIP  (press Tab to skip this field)

At the right end of the tab bar, click the Close button.
When Access asks whether you want to save the design of the table, click Yes.
Important Clicking No will delete the new table and its data from the database.

Access displays the Save As dialog box.

oy B
Table Mame:
Tablel

[ oK ] [ Cancel

You must save the table before closing it.

In the Table Name box, type Customers, and then click OK.

Access closes the table, which is now listed in the Tables group on the Navigation bar.

[ All Access Ohjects

&= «|
[|searc., |2
| Tables =i

E Customers

The database now contains one table.
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Tip You can rename a table by right-clicking it in the Navigation pane and then clicking
Rename. You can delete a table by right-clicking it, clicking Delete, and then confirming
the deletion in the message box that appears. (You can also delete a table by selecting
it in the Navigation bar and then clicking the Delete button in the Records group on
the Home tab or pressing the Delete key.)

13. In the Navigation pane, click the Customers table to select it.

14. On the Home tab, in the Clipboard group, click the Copy button. Then click the
Paste button.

Keyboard Shortcut Press Ctrl+C to copy data. Press Ctrl+V to paste data.

See Also For more information about keyboard shortcuts, see “Keyboard Shortcuts”
at the end of this book.

The Paste Table As dialog box opens.

Paste Tahle &5
Table Mame:
Paste Options

() Skructure Only
@) Structure and Data
) sppend Data ko Existing Table

If you need to create a table that is similar to an existing table, it is sometimes easier
to customize a copy than to create it from scratch.

15. In the Table Name box, type Employees. In the Paste Options area, click
Structure Only to capture the fields from the Customers table but none of
the customer information. Then click OK.

The new Employees table appears in the Navigation pane.

Tip You can also use the Copy and Paste commands to append the information in the
selected table to another existing table. In that case, in the Paste Table As dialog box,
type the name of the destination table in the Table Name box, click Append Data To
Existing Table, and then click OK.

16. Double-click Employees to open it in Datasheet view so that you can view its
fields. Then close the table again.
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20.

21.

17.

18.

Creating Databases and Tables Manually

On the Create tab, in the Tables group, click the Table button.

Access creates a new table containing an ID field and a Click To Add field
placeholder.

With the Click to Add field active, on the Fields contextual tab, in the Add &
Delete group, click the More Fields button.

The More Fields gallery appears.

¥l  onoff
Quick Start
Address

Cateqory

Mame

Payment Type
Phione

Pricority

Start and End Drates

Status

o O e < 4

Tag -
LCalculated Field [

—

.Eli Save Selection as Mew Data Type

The Quick Start fields are at the bottom of the More Fields gallery.

If necessary scroll to the bottom of the gallery, and then under Quick Start,
click Name.

Access inserts ready-made LastName and FirstName fields.

Repeat steps 18 and 19 to add the Address fields from the Quick Start list.

Access inserts ready-made Address, City, State Province, ZIP Postal, and Country
Region fields.

Close the table, saving it with the name Shippers when prompted.

x CLEAN UP Retain the MyTables database for use in later exercises.
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Database Design

In a well-designed database, each item of data is stored only once. If you're cap-
turing the same information in multiple places, that is a sure sign that you need
to analyze the data and figure out a way to put the duplicated information in a
separate table.

For example, an Orders table should not include information about the customer
placing each order, for two significant reasons. First, if the same customer orders
more than once, all his or her information has to be repeated for each order, which
inflates the size of the table and the database. Second, if the customer moves, his
or her address will need to be updated in the record for every order placed.

The way to avoid this type of problem is to put customer information in a Customers
table and assign each customer a unique identifier, such as a sequential number or
unique string of letters, in the primary key field. Then in the Orders table, you can
identify the customer by the unique ID. If you need to know the name and address
of the customer who placed a particular order, you can have Access use the unique
ID to look up that information in the Customers table.

The process of ensuring that a set of information is stored in only one place is
called normalization. This process tests a database for compliance with a set of
normalization rules that ask questions such as “If | know the information in the
primary key field of a record, can | retrieve information from one and only one
record?” For example, knowing that a customer’s ID is 1002 means you can pull
the customer’s name and address from the Customers table, whereas knowing
that a customer’s last name is Jones does not mean that you can pull the cus-
tomer's name and address from the table, because more than one customer
might have the last name Jones.

The topic of normalization is beyond the scope of this book. If you need to design
a database that will contain several tables, you should search for Database
design basics in Access Help to learn more about the normalization process.
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Manipulating Table Columns and Rows

In Chapter 1, "Explore an Access 2010 Database,” we showed you how to quickly adjust
the width of table columns to efficiently display their data. In addition to adjusting column
width, sometimes you might want to rearrange a table’s fields to get a better view of the
data. For example, if you want to look up a phone number but the names and phone
numbers are several fields apart, you will have to scroll the page to get the information
you need. You might want to rearrange or hide a few fields to be able to simultaneously
see the ones you are interested in.

You can manipulate the columns and rows of an Access table without affecting the under-
lying data in any way. You can size rows and size, hide, move, and freeze columns. You can
save your table formatting so that the table will look the same the next time you open it,
or you can discard your changes without saving them.

In this exercise, you'll open a table and manipulate its columns and rows.

SET UP You need the MyTables database you worked with in the preceding exercise
to complete this exercise. Open the MyTables database, and then follow the steps.

1. In the Navigation pane, double-click the Customers table to open it in
Datasheet view.

2. In the field name row, point to the right border of the Street field name, and
when the pointer changes to a double-headed arrow, drag to the right until
you can see all of the street addresses.

3. Double-click the right border of any column that seems too wide or too narrow to
adjust the column to fit its contents.

This technique is particularly useful in a large table where you can't easily determine
the length of a field's longest entry.

4. Point to the border between any two record selectors, and drag downward.

When you release the mouse button, Access increases the height of all rows
in the table.
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=z | Cushxnﬂs\ =3
CustomerlD - | FirstName - | LastName - | Street ~| City - |State - |ZIP - |Country -| Phone -
1 Scott Gode 612 E. 2nd Pocatello 1D 73204 USA 208 555-0161
2 John Frederickson 43 rue St Laurent Montreal Quebec Canada 514 555-0167
*| (New)

You cannot adjust the height of a single row.

. On the Home tab, in the Records group, click the More button, and then click

Row Height.
The Row Height dialog box opens.

Row Height o sl
Rows Height: 3;?,5
Standard Height

You can set the rows to the precise height you want.

. In the Row Height dialog box, select the Standard Height check box, and then

click OK.

Access resets the height of the rows to the default setting.

. Click anywhere in the FirstName field. Then in the Records group, click the More

button, and click Hide Fields.
The FirstName field disappears, and the fields to its right shift to the left.

Tip If you select several fields before clicking Hide Fields, they all disappear. You can
select adjacent fields by clicking the field name of the first one, holding down the Shift
key, and then clicking the field name of the last one. The two fields and any fields in
between are selected.

. To restore the hidden field, in the Records group, click the More button, and then

click Unhide Fields.
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The Unhide Columns dialog box opens.

Unhide Colurmns -2 |l

Columnn:
CustomerID
D Firstharme
IE LastMarme
E| Street

] city

State

2P

|_7_| Counkry
Phone
Click ko Add

Close

You can select and clear check boxes to control which fields are visible.

Tip If you want to hide several columns that are not adjacent, you can display the
Unhide Columns dialog box and clear their checkboxes.

In the Unhide Columns dialog box, select the FirstName check box, and then
click Close.

Access redisplays the FirstName field.

If you can see all of the fields in the table, for the purposes of this exercise, adjust
the size of the program window until some of the fields are no longer visible.

Point to the CustomerlD field name, hold down the mouse button, and drag through
the FirstName and LastName field names. With the three columns selected, click the
More button in the Records group, and then click Freeze Fields.

Scroll the page to the right until the Phone field is adjacent to the LastName field.
The first three columns remain in view as you scroll.

In the Records group, click More, and then click Unfreeze All Fields to restore the
fields to their normal condition.

Tip The commands to hide, unhide, freeze, and unfreeze columns are also available
from the shortcut menu that appears when you right-click a field name.
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14. Click the Phone field name to select that field. Then drag the field to the left,
releasing the mouse button when the thick black line appears to the right of the
LastName field.

15. Close the Customers table, clicking Yes to save the changes you have made to
the column widths and order. If you see a warning that this action will clear the
Clipboard, click Yes.

x CLEAN UP Retain the MyTables database for use in later exercises.

Refining Table Structure

Although you can create the structure of a database in Datasheet view, some structural
refinements can be carried out only in Design view. When you are familiar with tables,
you might even want to create your tables from scratch in Design view, where you
have more control over the fields. You can open a new table in Design view by clicking

the Table Design button in the Tables group on the Create tab.

When you open an existing table in Design view, the tabbed page shows the underlying
structure of the table.

%

B CustomeriD
| FirstName
.LastName
| Street

\City

Field Name

Data Type
AutoMumber
Text
Text
Text
Text

Field Properties

Description

M f e

General {Lookup

[Field Size
Mew Values
Format
|Caption
Indexed
Smart Tags
Text Align

Long Integer

\Increment

Yes (Mo Dupli

General

cates)

A field name can be up to 64 characters long,
including spaces. Press F1 forhelp on field

names.,

The table design page.
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This page has two parts. The top part consists of the following:

® Selector You can click the shaded box at the left end of a row to select the entire
field. You can then insert a row above the selected one, delete the row (thereby
deleting the field), or drag the row up or down to reposition its field in the table.

The selector also identifies the primary key field of the table by displaying the
Primary Key icon (a key with a right-pointing arrow).

Tip If you don’t want a table to have a primary key (for example, if none of the fields
will contain a unique value for every record), select the field designated as the primary
key, and on the Design contextual tab, in the Tools group, click the Primary Key button
to toggle it off. If you want to designate a different field as the primary key, select the
new field, and click the Primary Key button to toggle it on. (You don't have to remove
the primary key from the current field first; it will happen automatically.)

® Field Name column This column contains the names you specified when you created
the table. You can edit the names by using regular text-editing techniques. You can
add a new field by typing its name in the first empty cell in this column.

® Data Type column This column specifies the type of data that the field can contain. By
default, the ID field in a new table is assigned the AutoNumber data type, and all other
fields are assigned the Text data type. With the exception of fields with the OLE Object
and Attachment data types, you can change the type of any field by clicking its Data
Type entry, clicking the arrow that appears, and clicking a new data type in the list.

Data Type
AutoNumber m?
Text .
Memo
Number

Date/Time
Currency

AutoNumber
Yes/No

OLE Object
Hyperlink
Attachment

Calculated
Lookup Wizard...

The list of data types.

See also For more information about data types, see “Restricting the Type of Data” in
Chapter 6, “Maintain Data Integrity.”

® Description column This column contains an optional description of the field.
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The Field Properties area at the bottom of the design page displays the properties of the
field selected in the top part. Different properties are associated with different data
types. They can determine such things as the number of characters allowed in a field,
the value inserted if the user doesn't type an entry, and whether an entry is required.
Properties can also assess whether an entry is valid and can force the user to select
from a list of values rather than typing them (with the risk of errors).

All fields, no matter what their data type, can be assigned a Caption property that will
appear in the place of the field name in tables or in other database objects. For example,
you might want to use captions to display the names of fields with spaces, such as First
Name for the FirstName field.

See Also For information about using properties to control the accuracy of data entry, see
Chapter 6, “Maintain Data Integrity.” For a comprehensive list of data types and properties,
search on data types in Access Help.

In this exercise, you'll open a table in Design view, add and delete fields, change a data
type, set field sizes, and add a caption.

SET UP You need the MyTables database you worked with in the preceding exercise
to complete this exercise. Open the MyTables database, and then follow the steps.

1. In the Navigation pane, right-click the Employees table, and then click Design
View.

Access opens the table with its structure displayed. Because you created this table
by copying the Customers table, you need to make some structural changes.

2. With CustomerlD highlighted in the Field Name column, type EmployeelD, and
then press the Tab key twice.

3. In the Description column, type Unique identifying number.

4. Click the Country field's selector, and then on the Design contextual tab, in the

Tools group, click the Delete Rows button.

5. In the empty row below the Phone field, click the Field Name cell, and type
Birthdate. Then click the Data Type cell.

Access assigns the default Text data type to the new field.

6. Click the arrow at the right end of the Data Type cell, and in the list, click
Date/Time.

7. Repeat steps 5 and 6 to add another Date/Time field named DateHired.
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Select the ZIP field name, change it to PostalCode, and then change its data type
to Text.

Tip If you use only five-digit ZIP codes, the Number data type is fine. But setting it to
Text allows you to enter ZIP+4 codes or the letter-number postal codes used in Canada
and other countries.

The properties in the Field Properties area at the bottom of the design page
change to those that are appropriate for this type of field.

T Employees >
Field Mame Data Type _ Description
State Text
j PostalCode ext E
Phone Text
| Birthdate Date/Time
| DateHired Date/Time

Field Properties
General {Lgokup

[Field Size |255 .
Format | (
Input Mask ]

|Caption

Default Value | |
\Walidation Rule | | The data type determines the kind of values
Validation Text that users can store in the field, Press F1 for
:Required :No | help on data types.

|Allow Zero Length Yes

Indexed Mo

Unicode Compression  [Mo

IME Mode |No Cantrol

IME Sentence Made |None |
smart Tags -

[t [»

|

The properties for the Text data type.

In the box to the right of Field Size, double-click 255, and type 10.

You are specifying that this field can contain no more than 10 characters.
Change the Field Size property of the following fields as shown:
FirstName 50 City 50 Phone 30

LastName 50 State 20

Tip Sometimes changing the field properties of a table that already contains data can
produce unanticipated results. If you make a change to a field property that might cause
data to be lost (for example, if you make the Field Size property smaller than one of the
field's existing values), Access warns you of this problem when you attempt to save the
table. For more information, see Chapter 6, “Maintain Data Integrity.”
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Text

11.

12.

13.

14.

Click the State field. Then in the Field Properties area, click the Caption box, and
type State or Region.

The Field Name remains State, but in Datasheet view, the column heading will be
State or Region.

=1 Employees x
Field Name Data Type Description =
| city Text '
State Text T
| PostalCode Text n
Phone Text
j Birthdate Date/Time =
Field Properties
[Field Size [20 [
Format (il
Input Mask
|Caption |State or Region

Default Value

WValidation Rule The label for the field when used on a form. If

you don't enter a caption, the field name is

[Validation Text ! ! used as the label. Press F1 for help on
|Required Mo I captions.

Allow Zero Length Yes

Indexed ~ |Mo

Unicode Compression  |Yes

IME Mode Mo Control

IME Sentence Mode |Mone |

smart Tags x

You have changed the Field Size and Caption properties of the State field.

On the Design tab, in the Views group, click the View button to switch to
Datasheet view.

Access tells you that you must save the table before leaving Design view.
In the message box, click Yes to save the table.
Access saves the table and displays it in Datasheet view.

With the table displayed in Datasheet view, click the LastName field name. Then
on the Fields contextual tab, in the Add & Delete group, click the Text button.

A new field called Fieldl that has the Text data type is inserted to the right of the
LastName field.

Tip You can also create a new field with a specific data type by clicking the Click To Add
label to the right of the last field in the field name row. Then in the list that appears, you
can click the data type you want.
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15. With Fieldl selected, type Title, and press Enter.
16. Click the Title field name. Then in the Properties group, in the Field Size box, click

E?E Field Size |255 | 255 to select it, type 50, and press Enter.

17. Type the following information in the first record:
FirstName Karen
LastName Berg
Title Owner

The Employees table is now ready for you to start entering data.

=] Employees B3
EmployeelD ~ | FirstName -  LastName - Title ~ | Street =~ City - [Stat

| 1 Karen Berg Owner

* (New)

The first record of the Employees table.

CLEAN UP Close the Employees table. Retain the MyTables database for use in the
last exercise.

Creating Relationships Between Tables

In Access, a relationship is an association between common fields in two tables. You can
use this association to link the primary key field in one table to a field that contains the
same information in another table. The field in the other table is called the foreign key.
For example, if customer accounts are assigned to specific sales employees, you can
establish a relationship by linking the primary key EmployeelD field in the Employees
table with the foreign key EmployeelD field in the Customers table. Each customer
account is assigned to only one employee, but each employee can manage many
customer accounts, so this type of relationship—the most common—is known as

a one-to-many relationship.

Similarly, if every order is associated with a customer, you can establish a relationship
by linking the primary key Customer|D field in the Customers table and foreign key
CustomerlID field in the Orders table. Each order is placed by only one customer, but
each customer can place many orders. So again, this is a one-to-many relationship.
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Less common relationships include:

® One-to-one In this type of relationship, each record in one table can have one and
only one related record in the other table. This type of relationship isn't commonly
used because it is easier to put all the fields in one table. However, you might use
two related tables instead of one to break up a table with many fields, or to track
information that applies to only some of the records in the first table.

® Many-to-many This type of relationship is really two one-to-many relationships
tied together through a third table. You might see this relationship in a database
that contains Products, Orders, and Order Details tables. The Products table has one
record for each product, and each product has a unique ProductID. The Orders table
has one record for each order placed, and each record in it has a unique OrderlID.
However, the Orders table doesn't specify which products were included in each
order; that information is in the Order Details table—the table in the middle that
ties the other two tables together. Products and Orders each have a one-to-many
relationship with Order Details. Products and Orders therefore have a many-to-
many relationship with each other. In plain language, this means that every product
can appear in many orders, and every order can include many products.

The most common way of creating a relationship between two tables is to add the
tables to the Relationships page displayed when you click the Relationships button in
the Relationships group on the Database Tools tab. You then drag a field in one table
to the common field in the other table and complete the relationship definition in the
Edit Relationships dialog box. In this dialog box, you are given the opportunity to im-
pose a restriction called referential integrity on the data, which means that an entry
will not be allowed in one table unless it already exists in the other table.

After you have created a relationship, you can delete it by deleting the line connecting
the tables on the Relationships page. You can clear all the boxes from the page by
clicking the Clear Layout button in the Tools group on the Relationship Tools Design
contextual tab.
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Tip The coverage of relationships in this topic is deliberately simple. However, relationships
are what make relational databases tick, and Access provides a number of fairly complex
mechanisms to ensure the integrity of the data on either end of the relationship. Some of
these mechanisms are covered in Chapter 6, “Maintain Data Integrity.” For a good overview,
search for Guide to table relationships in Access Help.

In this exercise, you'll create relationships between one table and two other tables.
Then you'll test the referential integrity of one of the relationships.

SET UP You need the MyTables database you worked with in the preceding exercise
to complete this exercise. Open the MyTables database, and then follow the steps.

1. On the Create tab, in the Tables group, click the Table button to create a new
table.

Before we add fields to this table, let's save it.

2. On the Quick Access Toolbar, click the Save button, name the table Orders, and
click OK.

3. To the right of Click to Add, click the arrow, and in the data type list, click
Number. Repeat this step to create a second field with the Number data type.

4. Double-click Fieldl, and type CustomerlD. Then double-click Field2, and type
EmployeelD.

Each order in the Orders table will be placed by one customer and will be handled
by one employee. Let's create relationships between the Orders table and the
Customers and Employees tables so that we don't create records for orders from
customers who don't exist or that seem to have been handled by employees who
don't exist.

5. Close the Orders table.
Tip You cannot create a relationship for an open table.

6. On the Database Tools tab, in the Relationships group, click the Relationships
= button.

Relationships The Show Table dialog box opens so that you can indicate the tables for which
you want to create a relationship.

Troubleshooting If the dialog box doesn’t open automatically, click the Show Table
button in the Relationships group on the Design contextual tab.
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Tables | Queries IBDth

Employvees
Crders

| Add

'

The Tables page of the Show Table dialog box.

Close.

7. With Customers selected on the Tables page, click Add. Then double-click
Orders, and click Close.

Access displays the Relationships page and adds a Relationship Tools contextual tab
to the ribbon.

The two boxes list all the fields in their respective tables.

| H9- -5 My Tables : Database (Access 2007) - Mic.., o = R
Home Create External Data Dratabase Tools Design =] 0
Hide Table B
% )( Clear Layout =] =
gEIDire:t Relationships -
Edit |23 Relationship Repart | Show 2 2 Close
Relationships Table EEEA” Relationships
Tools | Relatiohships |
All Access Objects ® « M% ati
|Searm.. |P
Tables = Customers Orders =
& .
_E = ¥ CustomerlD  |a P
DA Firstiame CustomerlD -
B Employees Lasthame = EmployeelD -
Street
A arders City | 4
State . g ey
Faie [~} I-_ |
r |
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8. In the Customers field list, click CustomerlID, and drag it down and over
CustomerlD in the Orders field list, releasing the mouse button when two
little boxes, one containing a plus sign, appear below the pointer.

The Edit Relationships dialog box opens.

TR oo -8l

Table/Query: Related Table/GQuery;

: Create
Customers * | Orders

Canicel
CustomeriD ECustomerID -

Join Type..

I

Create Mew,,
[ Enforce Referential Integrity HERLRIREHY

Cascade Update Related Fislds

[ lcascads Delete Related Records

Relationship Tvpe: one-To-Many

At the bottom of the dialog box, Access indicates that this will be a one-to-many relationship.

9. Select the Enforce Referential Integrity check box, and then click Create.

Access creates the link between the primary key in the Customers table and the
foreign key in the Orders table, and a line now connects the two field lists on
the Relationships page.

| g - My Tahles : Database (Access 2007) - Mic... ‘_;-_-, ionship Tools. ‘ = = 3
Home Create External Data Database Tools | Design | [ 0
= Hide Table
Py/é:l ¥ Clear Layout -'I'I:Ii s
= ]1" Direck Relationships =
Edit |23 Relationship Repart Show g T 2 Close
Relationships Table 5%-5‘-” Relationships
Tools Relationships N
1 2 = | - = - ==
| All Access Objects & « |jRestionshipay m X
| Seqrch, [F=d =
sl ot | = Ord e
Tables b3 u.s S 1 L 1
e | ¥ CustomerdD A % o |
2 Cuskdmers FirstMame = CustamerID
EH Employees LastMame = EmployeelD
| street
B orders City
state
P |

The symbols at each end of the line indicate that each Customer ID value appears only once
in the Customers table but can appear many times in the Orders table.
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10.

11.

12.

13.

14.

15.

On the Design contextual tab, in the Relationships group, click the Show Table
button. Then in the Show Table dialog box, double-click the Employees table, and
click Close.

Access adds a box listing all the fields in the Employees table to the Relationships
page.

On the page, drag the title bars of the three field lists to arrange them so that
they are side by side and equidistant.

In the Employees field list, click the EmployeelD field, and drag it down and over
the EmployeelD field in the Orders field list. Then in the Edit Relationships dialog
box, select the Enforce Referential Integrity check box, and click Create.

After Access draws the relationship line between the primary key and the foreign
key, close the Relationships page, clicking Yes to save its layout.

Open the Orders table. Then in the CustomerID field of the first record, type 11,
and click below the record to complete it.

Access displays a message box telling you that you cannot add the new record to
the table.

Microsoft Ace ess -'

I'.\ “ou cannot add or change a record because a related record is required in table 'Customers',

[ o | [ hHep |

Was this information heloful?

The value in the CustomerlD field in the Orders table must match a value in the primary key
CustomerlD field in the Customer table.

Click OK. Then change the value to 1, and click below the record to complete it.

This time, Access accepts the value because there is a record with the value 1 in the
primary key CustomerlD field of the Customers table.

x CLEAN UP Close the Orders table, and then close the My Tables database.
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Key Points

Access 2010 includes templates to help you create databases and application parts
to help you add related tables and other database objects.

Rather than storing all information in one table, you can create different tables for
each type of information, such as customers, orders, and suppliers.

You can create a simple table structure by entering data and naming fields in
Datasheet view. You can also set the data type and certain properties.

You can manipulate or hide columns and rows without affecting the data.

In Design view, you can modify any table, whether you created it manually or as
part of a template.

Data types and properties determine what data can be entered in a field, and how
the data will look on the screen. Caution: changing some properties might affect
the data.

You can create a relationship between the primary key field of one table and the
foreign key field of another so that you can combine information from both tables.
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5 Create Simple
Reports

In this chapter, you will learn how to
v/ Create reports by using a wizard.
v Modify report design.

v/ Preview and print reports.

Like forms, reports give people easy access to the information stored in a database.
However, there are several differences between forms and reports, including the following:

® Forms are used to enter, view, and edit information. Reports are used only to view
information.

® Forms are usually displayed on-screen. Reports can be previewed on the screen,
but they are usually printed.

® Forms generally provide a detailed look at records and are usually for the people who
actually work with the database. Reports are often used to group and summarize
data, and are often for people who don't work with the database but who use the
information stored in the database for other business tasks.

Reports usually present summaries of larger bodies of information. For example, your
database might hold detailed information about thousands of orders. If you want to edit
those orders or enter new ones, you can do so directly in the table or through a form.
If you want to summarize those orders to illustrate the rate of growth of the company’s
sales, you generate a report.

Like a book report or an annual report of a company’s activities, a report created in
Microsoft Access 2010 is typically used to summarize and organize information to
express a particular point of view to a specific audience. When you are designing a
report, it is important to consider the point you are trying to make, the intended
audience, and the level of information they will need.
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In this chapter, you'll create a report by using a wizard. After modifying the layout and
content of the report, you'll see how it will look when printed.

Practice Files Before you can complete the exercises in this chapter, you need to copy
the book’s practice files to your computer. The practice file you'll use to complete the
exercises in this chapter is in the Chapter05 practice file folder. A complete list of
practice files is provided in “Using the Practice Files” at the beginning of this book.

Creating Reports by Using a Wizard

You can divide the content of an Access report into two general categories: information
derived from records in one or more tables, and everything else. The everything else
category includes the title, page headers and footers, introductory and explanatory text,
and any logos and other graphics.

Just as you can create a form that includes all the fields in a table by using the Form
tool, you can create a report that includes all the fields by using the Report tool, which
is located in the Reports group on the Create tab. But such a report is merely a prettier
version of the table, and it does not summarize the data in any meaningful way. You are
more likely to want to create a report based on only some of the fields, and that is a job
for the Report wizard.

Tip In addition to basing a report on a table, you can base it on the datasheet created when
you run a query. For information about queries, see Chapter 8, “Create Queries.”

The Report wizard leads you through a series of questions and then creates a report based
on your answers. So the first step in creating a report is to consider the end result you want
and what information you need to include in the report to achieve that result. After you
provide that information, the wizard creates a simple report layout and adds a text box
control and its associated label for each field you specify.

For example, you might want to use a Products table as the basis for a report that groups
products by category. When you give the grouping instruction to the wizard, it first sorts
the table based on the category, and then sorts the products in each category. In the
space at the top of each group (called the group header), the wizard inserts the name of
the category.

In this exercise, you'll use the Report wizard to create a simple report that displays an
alphabetical list of products.
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SET UP You need the GardenCompany05_start database located in your Chapter05
practice file folder to complete this exercise. Open the GardenCompany05_start
database, and save it as GardenCompany05. Then follow the steps.

1. With All Access Objects displayed in the Navigation pane, under Tables, click
(don't double-click) Categories.

2. On the Create tab, in the Reports group, click the Report button.

Access creates a report based on all the fields in the Categories table, displays the
report in Layout view, and adds four Report Layout Tools contextual tabs to the

ribbon.
@“ H 9= GardenCompanyls : Database (Access 20, 1-)'_;4::-'1}._-;._3’ out Tools = = 52
Home Create External Drata [ratabase Tools Design | Arrange Farmat Page Setup & 9
) Thermzsv = Group & Sort g‘?‘ j _Ej ﬁﬁlugu @a
BEacolors = X Totals - 1 B ibe
e — Controls Insert Page . Add Existing Property
- Fomtsv 165 Hide Details - Image~ | Mumbers @Date and Time Fields Sheet
Wiews | Themes Grouping & Totals Controls | Header / Footer Tools
All Access Objec..& « ‘sﬂm
Tables % i =
B customers COTegorles
x| Employees E@ ik i
Category ID Category Name Description
B order Details b
BEH Orders 1 [|| Bulbs ||Spriﬂg, summer and fall, forced
E products 2 |C0cﬁ || Incloor cactus plants
E shippers 3 |Ground covers Herbaceous perennials, evergreer
B suppliers and deciduous shrubs, ivy, vines, —
g 2 TS
Customers L
4 | Grasses Lawwn grasses for cool climates
| 5 | Flowers || A wide variety of flowers
& |Wetland plants Plants suitable for water gardens a
bogs
| il |Soi|sr‘scmd || Potting soils, peat moss, mulch, barl
| 8 | Fertilizers || A variety of ferfilizers A
T I ain - & — !
4] it . . ] [
.| E{H} %m l_o_c'_?_\“-im@ !

The default report created by the Report tool.

Troubleshooting The appearance of buttons and groups on the ribbon changes depending
on the width of the program window. For information about changing the appearance of
the ribbon to match our screen images, see “Modifying the Display of the Ribbon" at the
beginning of this book.
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. This is not the report we want, so close the Categories report, clicking No when

prompted to save it.
On the Create tab, in the Reports group, click the Report Wizard button.

The Report wizard starts. Because the Categories table is still selected in the
Navigation pane, that table is specified in the Tables/Queries box and its fields
are listed in the Available Fields box.

Display the Tables/Queries list, and then click Table: Products.
The Available Fields box now lists the fields in the Products table.

Report Wizard

Which fields do you want on your repert?

You can choose from more than one table or query.

Tables/Queries

Irable: Products| E

Available Fields: Selected Fields:

ProductMName
LatinMame
SupplierID
CategoryID
QuantityPerUnit
UnitPrice
UnitsInStock -

il

Cancel < Back '[ Mext = ] l Firiish

The first page of the Report wizard with the correct table selected.

In the Available Fields list, double-click ProductName, QuantityPerUnit, and
UnitsInStock to move them to the Selected Fields box.
Tip Fields appear in a report in the order in which they appear in the Selected Fields list.

You can save yourself the effort of rearranging the fields in the report by entering them
in the desired order in the wizard.
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7. At the bottom of the page, click Next.

The wizard asks whether you want to group the records. When you group by a

field, the report inserts a group header at the top of each group of records that
have the same value in that field.

8. In the field list on the left, double-click ProductName.

In the preview pane on the right, the wizard moves ProductName into the group
header area to show that records will be grouped by this field.

9. In the lower-left corner of the page, click Grouping Options.

The Grouping Intervals dialog box opens.

Report Wizard

Do you want to add any grouping

levels? Productiame
(

[QuantityPerUnit, UnitsInStock

Grouping Intersals

What grouping intervals do you want for groupdevel fields? E

Group-evel fields: Grouping intervals:
[Productiame I ol =

l Grouping Options ... ] [ Cancel ] l < Back ][ Mext = ” Finish

You can refine the grouping specification in this dialog box.

10. Display the Grouping intervals list, click 1st Letter, and then click OK.

The group header now indicates the grouping interval you have assigned to the
grouping field.
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Report Wizard
Da you want to add any grouping T
levels? |Pm|lucﬂlame by 1st Letter
Productilame, QuantityPerlnit,

Productiame E febicartilozc:
nitsInStock .

(=]

Priority

[*]
e

The types of grouping intervals available vary depending on the data type of the field by
which you are grouping records.

11. Click Next.

The wizard asks how you want to sort and summarize the records.

.
Report Wizard

What sort order and summary information do you want for detail records?

You can sort records by up to four fields, in either
ascending or descending order,

4 [ ascendng ]

= I | [=] L

= — =

- —_— . —— > | |'| | TR

== A

e

= rE= = .

E — 3 | [~] | Ascending i

= =

- —

- — 4

R — |

- —y

-

-

- Summary Options ...

[comcd J[ <ok [ Mew> ]| s |

You can sort by up to four fields, each in ascending or descending order.
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Tip For any field that contains numeric information, you can click Summary Options
near the bottom of the wizard page to display the Summary Options dialog box, where
you can instruct Access to insert a group footer in the report and to display the sum,
average, minimum, or maximum value for the field. The only numeric field in this report
is UnitsInStock, and it is not appropriate to summarize that field.

. Click the arrow to the right of the 1 box to display a list of fields, and click
ProductName. Then click Next.

The wizard asks which of three layouts and which orientation you want for this
report.

Report Wizard

How would you like to lay out your report?

Layout — Orientation —

@ Portrait

(7 Landscape

mmrrrrm

Adjust the field width so all figlds fit on
a page.

[ e H <Back ][ Next = ” Einish

The preview on the left shows the effect of the options on the right.

. In the Layout area, click each option in turn to see a preview in the report thumbnail
to the left.

. When you have finished exploring, click Outline.

. With Portrait selected in the Orientation area and the Adjust the field width so
all fields fit on a page check box selected, click Next.

The wizard prompts you to supply a title for the report.
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Report Wizard

What title do vou want for your report?

E [Products

That's all the information the wizard needs to create your
report.

Do you want to preview the report or modify the report's
design?

(@) Preview the report.
(7 Modify the report's design.

| .

For ease of use, you should make the title more specific.
16. In the title box, type Alphabetical List of Products, and then with Preview the
report selected, click Finish.

Access creates the report and displays it in Print Preview.

aptantic o rocucs )

-

Alphabetical List of Products

ProductName by 1s A

Product Name Quantity Per Unit Units In Stock
Ambrosia 6-2"pots 16
American Pitcher Plant 1 eaq. 4 L
Anachars 1ea. 4 h"n
Anemone One dozen 26
Animal repellent 1qt. 3
Animal trap 1 eq. 2 -
Page: 1 41 b Wb | o Fiter | |4 [ il | | »

The new report in Print Preview.

17. Page through the nine-page report, noticing how it is arranged. Then close it.

x CLEAN UP Retain the GardenCompany05 database for use in later exercises.
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Modifying Report Design

You can use the Report wizard to get a quick start on a report, but you will frequently want
to modify the report to get the result you need. As with forms, the report consists of text
box controls that are bound to the corresponding fields in the underlying table and their
associated labels. You can add labels, text boxes, images, and other controls, and you can
format them, either by using commands on the ribbon or by setting their properties in
the report’s Property Sheet.

Tip Property Sheets for reports work the same way as those for forms. For information, see
“Changing the Look of Forms” in Chapter 3, “Create Simple Forms.”

You can adjust the layout and content of reports in either Layout view or Design view.
For simple adjustments, it is easier to work in Layout view, where you can see the layout
with live data, making the process more intuitive.

See Also For information about creating and modifying reports in Design view, see Chapter 9,
“Create Custom Reports.”

Tip Automatic error checking identifies common errors in forms and reports and gives you a
chance to fix them. For example, Access informs you if a report is wider than the page it will
be printed on. Error checking is turned on by default. If you want to turn it off, display the
Backstage view, and click Options to open the Access Options dialog box. In the left pane,
click Object Designers, clear the error-checking check boxes at the bottom of the page, and
then click OK.

In this exercise, you'll modify the layout of a report. You'll then apply a theme, change
some of the colors, and dress up the text with character formatting. You will also apply
a simple rule that formats values differently if they meet a specific criterion.

q SET UP You need the GardenCompany05 database you worked with in the preceding
exercise to complete this exercise. Open the GardenCompany05 database, and then
follow the steps.

1. In the Navigation pane, under Reports, right-click the Alphabetical List of
Products report, and then click Print Preview.

2. Maximize the program window if it isn't already maximized, and then point to
the previewed report page.

The pointer changes to a magnifying glass with a plus sign in it.
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Alphaletical List of Products
Producihome by s A
Froduct Hanre —- et i Uit Ingiock
Arribrogia 4=Z pok 4
ArnercanPricher Pord lea, <
Anochas - 2
Armmone T dopen 24
Arirnal repeliend lgi 2
Ariral ton lma. 2
Arize: -7 pok 20
Ausisan Copper Per pland g
HAusrian Fne Ome gol comainer i
Avtorn croos Dre dozen ar
Broduciomeby 1z B
Poduc Narme Gty Per Lind Uitz IniSact
Baly's Breaih Tea. b
Batban | boxpert 2
Baoutylbuzh (- 2
Beebaim lea. 14
Begonias dperpog- 12
Bereficiainermnitdas 1pi “
Blocidharmes Sl Eper piog i
Biaddernord T ]
Blodderaord Ore 37 sarier 5
Sood meal 2bs. 14
Bowe oreal S 2
Twazday, Moy 25,2010 Page off

In Print Preview, the magnifying glass pointer indicates that you can zoom in on the page.

. Click the previewed page once to zoom in.

Tip You can also zoom in and out by dragging the Zoom slider in the lower-right corner
of the program window. The current zoom level appears to the left of the slider.

Notice that the report has the following design problem:s:
O Extraneous text
O Spacey arrangement
O Uninviting formatting

To fix these problems, we need to switch to Layout view.

. On the View Shortcuts toolbar, click the Layout View button.

Access adds four Report Layout Tools contextual tabs to the ribbon. First let's work
with the group header controls.
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5. On the Design contextual tab, in the Grouping & Totals group, click the Hide
Details button.

The controls that are bound to fields in the Products table are hidden so that you
can concentrate on the group header controls.

6. Below the title, click ProductName by 1s, and press the Delete key.
The label is removed from all the group headers.
7. Click the control containing A, and drag it to the left edge of the header.

When you release the mouse button, all the corresponding controls move to the
corresponding location in their own group headers.
Keyboard Shortcut Hold down the Alt key and press the Arrow keys to move the

selected control in small increments. When the shadow box is positioned where you
want it, click away from the control.

See Also For more information about keyboard shortcuts, see “Keyboard Shortcuts” at
the end of this book.

8. Point to the right border of the selected A control, and when the pointer changes
to a double-headed arrow, drag to the left until the control is just big enough to
hold its contents.

Again, all the corresponding controls assume the new size.

[Z] Alphabetical List of Products

Alphabetical List of Products

A

Product Name Guantit
B

Product Name Guantit
5

Product Name Guant

|

It is easier to work with the controls in the group header when the report details are hidden.
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11.

10.

With the A control still selected, hold down the Shift key, and in turn, click the
Product Name, Quantity Per Unit, and Units In Stock label controls to add
them to the selection.

On the Design tab, in the Tools group, click the Property Sheet button.
The Property Sheet opens.

Propery Sheet X
Selection type: Multiple selection

Format | pata | Event | Other | an |

Visible Yes -
Width |:|
Height

Top

Left

Eack Style

Back Colar Background 1
EBorder Style Transparent
Eorder Width Hairline

Eorder Colar

Special Effect Flat

Font Name Century Gothic |
Fant Size 11

Text Align

Font Weight MNormal

Font Underline Mo

Fant Italic Mo

Fare Color

Line Spacing o

Hyperlink Target

Gridline Style Top Transparent
Gridline Style Bottom

Gridline Stvle | eft Transnarent 2

Because more than one control is selected, the Selection Type of this Property Sheet is
Multiple Selection.

On the Format page of the Property Sheet, in the Top property box, type 0.25",
and press Enter. Then close the Property Sheet.

In the group header, the letter control and label controls are now aligned 0.25 inch
from the top of the header, and the height of the header has decreased because less
space is needed to accommodate the controls.



% Shape Fill~

Alternate
Ry Color =

12.

13.

15.

16.

17.

18.
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Now let's see how the group header looks with its data.

In the Grouping & Totals group, click the Hide Details button to turn it off and
display the data from the table.

The numbers in the Units In Stock column are right-aligned. Let's center them.

Click the first text box control under the Units In Stock label, and on the Format
contextual tab, in the Font group, click the Center button.

Now we'll add some color and format the text.

On the Design contextual tab, in the Themes group, click the Themes button, and
in the gallery, click the Austin thumbnail.

Although nothing much appears to change, the report takes on the color scheme
and font scheme assigned to the selected theme.

Inside the shaded area of the report header, but away from the title, click a blank
area. On the Format contextual tab, in the Control Formatting group, click the
Shape Fill button. Then under Theme Colors in the palette, click the third box
(Light Green, Background 2).

When you created this report, alternate group headers were shaded with the
same color as alternate data rows. This coloring confuses rather than clarifies the
report structure. Let's turn off this alternate group header color.

Click outside the dotted border to the left of the first group header. In the Back-
ground group, click the Alternate Row Color arrow, and at the bottom of the
palette, click No Color.

In the Control Formatting group, click the Shape Fill button, and in the palette,
click a light brown color.

The entire group header is shaded except the alphabet controls (A, B, C, and so on)
that you moved earlier. If you wanted to shade them as well, you could select one
of them and repeat step 17 to apply the light brown fill.

Click outside the dotted border to the left of the first row of data in the report, and
remove the alternate row color of the data rows. Then click the white space above
the report header to see the result.

Only the backgrounds of the report header and group headers are now colored.
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£

Conditional
Faormatting

21.

22.
23.

| mml.utnfm\

Alphabetical List of Products

A Product Name Quaniity Per Unit
Ambrosia 6-2"pots
American Pitcher Plant 1 ec.
Anacharis 1 eq.
Anemone One dozen
Animal repellent 1 qt.
Animal frap | eq.
Anise &6-2"pots
Austrian Copper Per plant
Austrian Pine Cne gal. container

Removing the alternate row color makes the structure of this report more obvious.

Tip Above the first object and below the last object of a report in Layout view are
the only places you can click that don’t select at least one object on the report.

. Click any control, and then in the Selection group, click the Select All button.

Keyboard Shortcut Press Ctrl+A to select all the controls.

. In the Font group, click the Font Size arrow, and then click 9.

Tip It is usually most efficient to change the character formatting of all the controls
and then adjust the ones you want to be different.

Click the report's title control, and then use the commands in the Font group
to make the text 24 points, bold, and dark green.

Select the controls in the group header, and make them bold and dark green.

Scroll down the report, noticing that a few of the values in the Units In Stock
column are 0.

We want these values to stand out in the report to remind buyers that it is time
to order more of these products.

. Click any control in the Units In Stock column. Then in the Control Formatting

group, click the Conditional Formatting button.
The Conditional Formatting Rules Manager dialog box opens.
Click New Rule.
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27.
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The New Formatting Rule dialog box opens.

Mew Farmatting Rule

Select & rule bvpe:

Check v in the current re
Compare to other records

Edit the rule description:

Format only cells where the:

Figld Yalue Is E‘ between E‘ [ [] and [ =)
Sy Mo Format Set B I U =

| Ok ]I Cancel ]

You can create rules that compare the current field value to a specific value or to other values
in the same field.

With Check values in the current record or use an expression selected as the
rule type, in the Format only cells where the area, click the arrow for the second
box, and click less than. Then in the third box, type 1.

In the bottom area, click the Bold button, and change the Font color setting to
red. Then click OK.

In the Conditional Formatting Rules Manager dialog box, the rule is listed in the

Rule column with the formatting that will be applied to values that meet the rule’s
criteria in the Format column.

‘Conditianal Formatting Rules Manager =

show Formatting rules For: | niesIrstock E‘

l =] Mew Ruls ] Ij’gdit Rule J [ 7 Delete Rule ‘ 2 .-1

Rule (applied in order shawn) Farmat

Walue < 1 AaBbCcyyzz

[ ook | [ uconcel ) [we Apphi

Values that are less than 1 will be bold and red.
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28. Click OK. Then scroll down the report again, noticing that all the 0 values are
now bold and red.

29. Close the report, clicking Yes to save your changes to its design.

x CLEAN UP Retain the GardenCompany05 database for use in the last exercise.

Previewing and Printing Reports

Using Print Preview to preview Access reports is very similar to using this view in other
Microsoft Office 2010 programs. If you preview your reports carefully, you won't have
any major surprises when you print them.

When previewing reports, you will want to pay special attention to how the pages break.
In a grouped report, you can control whether group headings are allowed to appear at the
bottom of a page with no data and whether groups are allowed to break across pages.

You can make changes to the setup of your report pages from the Page Setup contex-
tual tab in Layout view or from the tab displayed when you switch to Print Preview. For
example, you can specify the following:

® Paper size

® Margins

® Orientation

® Number of columns

® Whether Access should print the report's structural elements or only its data
You can also click the Page Setup button to display the Page Setup dialog box, where you
can change all these settings in one place, as well as make additional refinements.

When you are ready to print, you click the Print button on the Print Preview tab of the rib-
bon to display the Print dialog box. You can also display the Print page of the Backstage
view and then print one copy of the report with the default print settings by clicking the
Quick Print button.

In this exercise, you'll preview a report, and you'll specify that groups should not break
across pages. Then you'll explore the available page setup and printing options.

9 SET UP You need the GardenCompany05 database you worked with in the preceding
exercise to complete this exercise. Open the GardenCompany05 database, and then
follow the steps.

1. In the Navigation pane, right click the Alphabetical List of Products report, and
then click Print Preview.
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Only the Print Preview tab appears on the ribbon.

On the page navigation bar at the bottom of the window, click the Next Page
button repeatedly to view each page of this report.

Because of the changes you made to the report in the previous exercise, the report
is now six pages. Several of the groups start on one page and continue on the next
page. For readability, let's fix this layout problem.

The group at the top of this page is a continuation of one that started
on the previous page.

Switch to Layout view, and then on the Design tab, in the Grouping & Totals
group, click the Group & Sort button.

The Group, Sort, And Total pane opens at the bottom of the report page.

Group, Sort, and Total £3

E Group on ProductMame ™ with A ontop ™, Mare » + P
E Sart by ProductMame
E Sort by ProductMame

(= Add a group ”%1 Add a sort

You can use this pane to quickly add grouping and sorting levels and set related properties.

In the Group, Sort, and Total pane, in the Group on ProductName bar, click More.
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Access displays additional options.

Group, Sort, and Total )

Group on ProductMame ™ with & ontop ™ o by first character ™ with notokals ™ R

with title click ko add , with a header section ¥, without a fooker section ™

do not keep group together onone page ™ 5 Less 4
E Sott by ProductMame
Sart by ProductMame
-

These are the current grouping settings.

5. Click the do not keep group together on one page arrow, and in the list, click
keep whole group together on one page. Then close the Group, Sort, and
Total pane by clicking the Group & Sort button again.

6. Switch to Print Preview, and page through the report.

Now none of the groups is broken across pages. However, the report would look
better with wider top, left, and right margins.

7. On the Print Preview tab, in the Page Layout group, click the Page Setup button.
The Page Setup dialog box opens.

Page Setup @

Print Options | Page | Columns

Margins {inches)
Top: 0.25
Bottarm: 585
Left: 0.25
Right: 0.25

[T Print Data only
Split Form
Print Farm Only
Print Datasheet Only

(0] 4 ] [ Cancel

The Print Options page of the Page Setup dialog box.
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8. Click the Page tab, and verify that the paper size is Letter.

9. Return to the Print Options page, and change the Top, Left, and Right margins to
0.75. Then click OK.

10. Scroll through the report to see the results.

Although all the data in the report fits on the page, the page number in the footer
is set too far to the right and is producing extra pages.

11. Switch to Layout view, scroll down to the bottom of the report, and then scroll to
the right until you can see the page number.

12. Click the page number control, and move and resize it so that it aligns approximately
with the Units In Stock column heading.

13. Switch to Print Preview, and page through the report.
The report now fits neatly on seven pages.

14. If you want, print the report by using the same techniques you would use to print
any database object.

15. Close the report, clicking Yes to save your changes.

x CLEAN UP Close the GardenCompany05 database.

Key Points

® When designing a report, consider the point you are trying to make, the intended
audience, and the level of detail needed.

@® You can create a report that displays only some of the fields in a table by using the
Report wizard. The report can be sorted and grouped to summarize the data in a
table in a meaningful way.

® You can refine a report in Layout view by manipulating its controls and setting
its properties. You can also format the controls to structure and highlight data.

® In Print Preview, you can see how the report will look when printed and make
adjustments before you print.
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